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Automatic Speech Recognition (ASR)
Introduction
Automatic Speech Recognition (ASR) is a vital component of the UC system. ASR allows the system to recognize human 
speech, so that users to speak contact names and menu selections, instead of entering them through the telephone keypad.

Visual Guide

ASR provides the base for all speech recognition functions, such as Speech Contacts and Speech Commands. ASR interprets 
a user’s voice input as a number or a character (e.g. alphabet) based on the grammar settings on the server. This allows 
users to speak the name of the contact they want to dial, or to say a number instead of pressing the digit on the telephone 
keypad. By replacing traditional input with speech, users can efficiently find what they were looking for. It also give users 
easy access to the system without having to use their hands. 

For specific features such as Speech Commands, please refer to the appropriate chapters in this guide.

Requirements

Requirements Details

License ASR License

Software Officelinx version 8.x or higher
16 Officelinx Feature Description Guide



Automatic Speech Recognition (ASR)
Server Configuration
Server configuration for ASR is completed in several steps. 

First, verify the Officelinx license that you have. In order to use ASR, you must have the ASR license. 

Once the license is confirmed, make the necessary settings in the Officelinx Administrator and from the ASR Configurator.

License Confirmation
Setting up ASR begins by making sure that you have purchased and 
installed the license. ASR is provided under an add-on to the standard 
license and must be purchased separately. 

Check the UC License Upgrade Utility under Programs > Officelinx.

Ensure that the information in the ASR section of the license contains the 
appropriate details.

With the license confirmed, launch the Officelinx Administrator to 
configure the application.

OL Admin Configuration
1. Open OL Admin and go to Configuration > Advanced. In 

the right pane, set Voice recognition mode to Nuance 8.5.
2. Once this option has been set, go to Company Properties.
3. Right-click on the company that will use ASR. Choose 

Properties. 
4. Go to the Speech Options tab and enable Voice 

Recognition. 
Enable the other features as required. 

Confirm names in voice recognition: The system will confirm a 
recognized name no matter what 
Allow barge-in voice recognition: This allows you to say a name 
while the system is playing a greeting or a prompt.
Allow barge-in confirm names: The system will allow you to 
interrupt it to confirm that a name that it found is correct.
Allow Say Operator: For the systems with a default operator 
defined, it will recognize the word “Operator” as a dial request for the 
operator.
17Officelinx Feature Description Guide



Automatic Speech Recognition (ASR)
ASR Configurator
From the Voice Verification section of the interface, you can specify the 
sensitivity level for the feature via Security Level. The number of 
questions the voice server will ask during login can also be controlled 
through Number of Questions.

Security Level has 5 levels to choose between. These range from Very-
High to Medium Low. Refer to the chart below to see the difference 
between each level, along with the typical False Acceptance rate (the 
rate in which the system will log in a wrong person to the mailbox).

Since the FA rate for Very-High is the lowest, it may seem logical to 
always choose this option. However, while the number of FAs decreases, 
the number of FRs (False Rejection) increases. At the highest security 
setting, people may have problems logging into their mailbox if their voice 
changes even slightly. This might be caused by a sore throat, added 
environmental noise or using a different device. It is up to the site 
administrator to choose the setting which best fits the company’s 
requirements.

Number of Questions: Choose the number of random questions that the 
system will ask when verifying the user's voice print. The system can be 
set to ask between 1 and 3 questions. 

There are three types of questions that the system will ask at random.

 Full Name: The system will ask the user to speak out their full name 
associated with the mailbox.

 Recognition Keywords: The system will randomly choose a keyword from the database (defined by the administrator) 
and ask the user to repeat the word.

 Random 4 Digit Number: The system will generate a random 4 digit number and ask the user to repeat the numbers.

The default setting will ask a minimum of 1 and maximum of 3 questions. This means that if the answer to the first question 
was satisfactory, the user will be logged. If not, the system will ask a second question. If the answer to the second question 
was satisfactory, the user will be logged in. If not, the system will ask the final question. If the answer to the final question 
was satisfactory, the user will be logged in. If not, the verification process will fail and the user will either be disconnected 
from the system, or be asked to manually enter their password through DTMF keys depending on the security settings of the 
site.

Security Level:

Security Level Typical Usage Recommendation FA Rate

Very-High Access to mailbox accounts with critical information 0.1% to 0.2%

High Access to mailbox accounts with high privilege 0.2% to 1.5%

Medium-High Access to typical mailbox accounts 1.5% to 3%

Medium Access to typical mailbox accounts in open environment 3% to 5%

Medium-Low Generic access where Voice Verification is used for convenience 5% to 7%
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ASR Voice Verification
Introduction
Officelinx provides voice verification which allows users to log into their mailbox through speech recognition based on their 
voice prints. When combined with speech navigation, voice verification offers a seamless experience that is both convenient 
and secure.

Voice verification may be customized by the administrator to enforce the specific level of security required by the company. 
This ensures that the convenience of voice verification does not interfere with the company security policies.

Visual Guide
Voice Verification uses the concept of a “trusted phone” for segregation purposes. 
Through the Voice Verification security settings, the administrator can choose to allow 
Voice Verification only from trusted phones. These can be limited to internal lines, the 
user’s personal cell phone, or any other numbers that are frequently used. There is no 
limit to the number of trusted numbers that can be configured, which gives the users 
the freedom to use Voice Verification from any secure location.

A typical use of Voice Verification will be from outside the company or away 
from the desk. Since it may be difficult to enter DTMF keys while on the 
road, being able to log in through Voice Verification provides users with 
convenient access their mailbox without having to expose their password to 
anyone.

Voice Verification confirmation methods can be fully customized to meet the 
requirements of the user. Whether the user is logged in through a keyword 
or a randomly generated number, security is tied onto the user’s voice itself. 
This leaves less room for unauthorized access since passwords cannot be 
intercepted or guessed by a third party.

In some situations, the use of Voice Verification can be difficult. For 
example, if the user is in a location where he/she cannot talk, it would be 
impossible to use Voice Verification.

For these scenarios, the administrator can also accept the traditional DTMF 
login should Voice Verification fail. When DTMF keys are allowed under Voice 
Verification security settings, the system will follow the logic shown to the 
right when a user tries to log into the system.

When implementing Voice Verification, ensure that the users are trained and 
that their voice prints have been properly configured for maximum security.

Requirements

Requirements Details

License Voice Verification requires an ASR License
Voice Verification is only available on a “per 
user” term based license

Software Officelinx version 9.0 or higher
20 Officelinx Feature Description Guide



ASR Voice Verification
Server Configuration
Voice Verification is accessed through three different areas: Company, Feature Group and the individual Mailboxes. While the 
settings can be accessed from each of these areas, the settings are hierarchical. Enable and configure Voice Verification at 
the Company level before setting up a Feature Group. Afterward, you will have the option to individually turn on and off this 
feature at the Mailbox level. This means that the feature will be unavailable to the entire company if it is disabled at the 
company level.

To refine the Voice Verification logic to suit your requirements, refer to the Advanced Configuration.

Admin
In order to use Voice Verification, the ports that the feature will use 
must be defined. 

1. Go to Admin > Voice Server.
2. Change Number of Voice Verification Channels as 

necessary. 

Company Properties
1. Go to OL Admin > Company Properties. Open the Speech Options 

tab.
2. Enable Voice Recognition. When you do so, the Voice Verification 

checkbox will become available. 
3. After enabling Voice Verification, click on Settings button to configure 

Voice Verification.

From the Settings window, set the security rules for this feature. There are two 
sets of rules that you can define; High Security Level and Normal Security 
Level. Each individual mailbox can be configured to use either level when 
enrolled in voice verification. It is a good idea to set these security rules with a 
purpose. For example, high risk users should only be allowed to use Voice 
Verification through a trusted phone since the feature may be too risky for 
them when available on certain phone lines.

From the DTMF dropdown menu, choose one of:

 None: The user cannot use DTMF keys to input a password.

 Allow Numeric Password: The user may use either DTMF keys or voice verification to log.

 Allow Numeric Password after: The user may use DTMF keys to log in when their voice 
verification attempt fails X times. X is defined in the Retries field.

You may also enable any of the below checkboxes to customize security.

Verify only from Trusted Phone: Voice Verification is only available if the phone number is 
defined as a trusted number in mailbox settings.

Allow Identification Number: Users may log in by simply speaking their identification number 
to the auto attendant. Trusted external numbers can be set to use identification numbers.

Forced Enrollment: You may force enrollment at a company level so that users must finish 
configuring Voice Verification the next time they log into their mailbox. This can also be configured individually at the 
company level.

 Note: Even if you already have the license for Voice 
Verification, you must change this entry manually.
21Officelinx Feature Description Guide



ASR Voice Verification
Company Language, Compile Grammar and Keywords

From the Company Language tab you can edit the company’s language properties. From here 
you have the option to add/edit/remove Login Verification Keywords. Login Verification 
Keywords allow users to log into their mailbox directly from the auto attendant by speaking the 
Login Keyword. The system will verify the user’s voice print using the login keyword. If this 
match is only partial, the user may have to answer additional questions before being recognized.

Once the user is recognized, they will go through the voice verification process which will ask a 
series of questions which vary depending on the server settings and the percentage of voice match 
desired or obtained. During the verification process, the system will also utilize the Recognition 
Keywords to match the user's voice with the voice print. These keywords may be customized by 
the administrator according to requirements if the default list is not sufficient.

Login Verification Keywords

A Login Verification Keyword can be any word. For better security, it is best to choose 
uncommon or hard to guess words.

Once a new Login Verification Keyword is added to a language, the system will ask if you wish 
to compile grammar right away. You should always choose Yes unless you have a specific 
reason not to. If you wish to compile the grammar later, the Compile Grammar button is 
available on the Speech Options tab of Company properties.

You can check the status of grammar compilation by taking a look in the 
C:\UC\Packages\ folder. The file login_cX_lY.grammar will be created once 
grammar has been compiled.

Login Recognition Keywords

Login Recognition Keywords can be any word. It is best to choose words that are easy to 
pronounce, but still have enough mixture of vowels and consonants to create a distinct sound. 
Since the keyword is chosen at random from the list as required, more keywords means less 
repetition for end users. Less repetition can reduce the likelihood of unwanted access since the 
process becomes more random, making the process more difficult to predict.

 Note: C:\UC\ is the default installation path for Officelinx. This may differ 
for your installation. Change the path accordingly

 Note: X and Y in the file name “login_cX_lY.grammar” represents Company number (X) and language 
number (Y).
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ASR Voice Verification
Feature Group Properties
Once the Company settings are complete, go to 
OL Admin > Feature Group Properties and open the Speech Options 
tab.

Enable Allow Voice Verification Security Level. If enabled, all 
mailboxes that belong in this feature group will now have the ability to 
control the level of security on their own through the TUI or the Web 
Access. To enforce a certain level of security on individual users, leave this 
option disabled. This ensures that only system administrator can modify 
the security protocol.

When this option is disabled, you must manually set the security level on 
individual mailboxes through OL Admin as shown in the next section.

Mailbox Properties
Once configuration at the Company and Feature Group levels is 
complete, if the mailbox is associated with the Company and Feature 
Group configured, the mailbox will now have the ability to control options 
related to voice verification.

Go to Admin > Mailbox Properties, open the Speech Options tab.

When the voice verification feature is enabled, the Enrolled, Forced 
Enrollment, and the Security Level radio buttons will become 
accessible.

Typically, the only item to configure here is the level of security (if users 
are not allowed to choose for themselves) and whether to force enrollment 
or not (if you are not enforcing this at the Company level). Enabling the 
Forced Enrollment checkbox will require mailbox users to configure their 
Voice Verification password via telephone when they next log in.

If you are going to use the Allow Identification Number feature from 
security settings, you must ensure that each user has a trusted external number defined in 
their address. Only the external addresses that are defined as Trusted may be used as an 
Identification number as shown here.

I Caution: You can assign a security level manually even when 
Allow Voice Verification Security Level is enabled, but the 
users will be able to change the level themselves.

 Note: This external number may be configured by the user via Web Access.

 Note: If you define the Country and Area/City Code, the user must include 
them as a part of their identification number.

 Note: Setting the security level to None will disable Voice Verification for the 
selected mailbox.
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ASR Voice Verification
Advanced Configuration
Voice Verification provides a high level of security, but users may 
experience difficulties when logging in if the security setting is too strict. If 
the voice print is not an ideal match, the process may be too lengthy while 
the system asks more confirmation questions or fails. The level of 
difficulty will decrease as the user repeats the enrollment process to 
update their voice print using virtually any device and from any location 
that they will likely be calling from, but you may also change the advanced 
configuration through the ASR Configurator to manage the user 
experience.

The Voice Verification section controls the sensitivity level via Security 
Level and also defines how many questions the voice server will ask 
during the process through Number of Questions.

Security Level offers 5 settings to select between, ranging from Very-
High to Medium Low. The following chart explains the differences 
between the settings, along with the typical False Acceptance rate (the 
rate at which the system will log in to the wrong mailbox).

Since the FA rate for the Very-High setting is the lowest, it may seem logical to choose this option every time. But the higher 
security settings will also increase the FR (False Rejection) rate. This means that at the highest security setting, people 
may have problems logging into their own mailbox if their voice changes even slightly. The change of voice might be caused 
by sore throat, environmental noise or the change in the device used. It is up to the site administrator to choose the setting 
which best fits the requirements of their company.

Number of Questions refers to the number of random questions that the system will ask to verify the user's voice print. 
There are three types of questions that the system will ask at random.

Full Name: The system will ask the user to speak the full name associated with the mailbox.
Recognition Keywords: The system will randomly choose a keyword from the database (defined by the administrator) 
and ask the user to repeat the word.
Random 4 Digit Number: The system will generate a random 4 digit number and ask the user to repeat them.

The minimum number of questions that the system can ask is 1.

The maximum number of questions that the system can ask is 3.

The default is for a minimum of 1 and a maximum of 3 questions. This means that if the answer to the first question is 
satisfactory, the user will be logged in. If not, the system will ask a second question. 

If the answer to the second question is satisfactory, the user will be logged in. If not, the system will ask the final question.

If the answer to the final question was satisfactory, the user will be logged in. If not, the verification process will fail and the 
user will either be disconnected from the system or be asked to manually enter their password through DTMF keys depending 
on the security settings of the site.

 Note: ASR Configurator is available on the Windows Start 
menu, under Officelinx folder.

Security Level Typical Usage Recommendation FA Rate

Very-High Access to mailbox accounts with critical information 0.1% to 0.2%

High Access to mailbox accounts with high privilege 0.2% to 1.5%

Medium-High Access to typical mailbox accounts 1.5% to 3%

Medium Access to typical mailbox accounts in open environment 3% to 5%

Medium-Low Generic access where Voice Verification is used for convenience 5% to 7%
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User Guide
As a Voice Verification feature user, you must ensure that you properly configure your mailbox as soon as possible so that 
there are no issues caused by improperly configured accounts.

When the feature becomes active on your mailbox, you will be able to go through the setup tutorial the next time you log into 
your mailbox from a telephone.

Setting Up Voice Verification
Depending on the rules set by your administrator, you may be able to skip the setup process or be forced into setting up the 
account. In either case, it is best to setup your account as soon as possible so that you can take advantage of all the 
features.

You will automatically hear a prompt for Voice Verification configuration when you log into your mailbox from the telephone. 
When you start your enrollment process, you will first record your own name. Say both your First and Last names, and 
again to confirm it when prompted.

The next step is to configure your numeric voice print. You will have to clearly count from 0 to 9 then 9 to 0. After this step 
your voice verification will be fully configured and ready to use.

Setting Up an Identification Number

If your system administrator allows voice verification through an identification number, you will be able to configure your own 
identification number through the Web Access.

From the My Addresses section create a new external phone number entry. Make this new entry a Trusted number then 
activate Identification as well. This external number will now serve as your identification number for voice verification.

Training Your Voice Print
While your voice may not change significantly from day-to-day, the voice that the system hears may be different depending 
on location or equipment. Even if you are calling in from the same cell phone all the time, different variables (such as using a 
headset or being outdoors) may confuse the system since it will hear a different voice. To ensure that the system recognizes 
your voice right away, it is recommended that you train your voice print by going through the training (which is identical to 
the enrollment process) from the devices and locations that you will be logging in from frequently.

To train your voice print, log into your mailbox. At the prompt select Mailbox Option (DTMF key 4 by default) then Retrain 
Voice Print (DTMF key 6 by default). Choose to add to your current voice print (DTMF key 1 by default) and follow the 
prompts. Repeat this process from all devices and locations that you will be using voice verification from to ensure that 
your voice print is more accurately managed by the system.

 Note: Existing external phone numbers may be defined as an identification number.

 Note: If you define the Country and Area/City Code, you must include them as part of your identification 
number.

 Note: You may have more than 1 identification number.
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Logging in Through Voice Verification
With Voice Verification active, there may be additional methods of logging in available depending on the settings made by the 
system administrator.

Traditional Method + Voice Verification

Initiate the mailbox log in process as you would normally do (call auto attendant then press #mailbox_number or dial the 
hunt group from your extension). Instead of being asked to enter your numeric password, you will be asked a randomly 
generated question to verify your voice print. If the answer is correct and the voice matches you will be logged in 
automatically without any using the keypad.

Keyword

From the auto attendant, simply say the keyword (configured by the system administrator). The system will check your 
voice print and log you in directly to your mailbox if your voice is recognized.

If the verification fails, or if the match is not within acceptable limits, the system will ask you a randomly generated question 
to verify your voice print once again.

Identification Number

From the auto attendant, simply say the entire identification number (configured by the system administrator or yourself). 
The system will check your voice print and log you in to your mailbox.

If the verification fails or if the match is not within acceptable limits, the system will ask you a randomly generated question 
to verify your voice print once again.

Failure Scenarios and DTMF Log In

Depending on your system’s security settings the failure scenarios may differ. However, in most failure cases you will have 
one of these two options:

 Retry voice verification

 Switch to traditional DTMF key password input

Like all log in attempts, if you fail a certain number of times (3 by system default), you may be locked out of your mailbox 
account.

If the system administrator has enabled the feature, you may also be able to use both the Voice Verification feature and the 
traditional DTMF method. When prompted by the Voice Verification question simply enter your numeric password then 
press # to log in.

 Note: In some cases, Voice Verification may only be available when logging in from a trusted phone 
number. You may define any internal or external phone number as trusted in the Web Access.
26 Officelinx Feature Description Guide



Enhanced Call Control

C

H
A

P
TER 3

In This Chapter:

28 Introduction

29 Server Configuration

30 User Guide
Officelinx Feature Description Guide 27



Enhanced Call Control
Introduction
When a call is made through the auto attendant to your external number, or if you dialed a person from an external number 
through the auto attendant, you will now have the ability to perform basic call control actions right from your external 
number. This allows you to take advantage of the call control features without having to be tied down to your work station or 
a specific telephone system. Any telephone that is capable of DTMF input will be able to send commands to the Officelinx 
server as long as the call itself was connected through the Officelinx server. ECC (Enhanced Call Control) also includes the 
Call Handoff feature which will supplement the transfer features.

Visual Guide
Business is always on the move, so it is not always ideal 
to stay idle. This is true even when you’re on the phone. 
The important call you’re answering from your 
workstation phone may be preventing you from other 
tasks or being elsewhere. You could ask the caller to call 
you back on your cell phone or ask if it would be okay for 
you to call them back on the other line but this would 
usually break the flow of conversation and is not ideal for 
majority of situations.

The hand off feature was added to the Officelinx system 
to remedy such an issue. You can now seamlessly transfer 
your current ongoing phone call at your desk to another 
device (e.g. cell phone, another station, etc) without any 
interruption. The person you are talking to will most likely 
not even notice the transfer since the call is instantly 
connected to your second line the moment you confirm.

A call may be managed through Handoff no matter what 
device is being used as long as the call is managed 
through the Officelinx system (i.e. calls are made through 
auto attendant). As long as such a condition is met, and 
the user has the permission to transfer between devices, 
the user may initiate a Handoff through the iLink Pro 
Desktop.

As you can see from the flowchart, the calls are not 
interrupted in any way. While traditional call transfers put 
the second party on hold during the transfer, there is no 
“buffer” required during a Handoff. The call is seamlessly 
transferred between the devices, and the audio stream 
moves from one device to another without any pauses in 
between. The second party is unlikely to notice that the 
Handoff has occurred at all.

The server is able to establish a connection by recognizing 
the answered status on the second device, which means 
that the Handoff feature automatically moves the audio 
stream from first device to the second automatically right 
after the second device answers.

Since the call is still being monitored by the system, the 
user is free to perform a Handoff repeatedly as long as 
he/she has access to the iLink Pro Desktop call control or 
ECC.

Requirements

Requirements Details

License ---

Software Officelinx version 9.0 or higher
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Enhanced Call Control
Server Configuration
The server side configuration for enabling Enhanced Call Control is very simple. The administrator must enable the service on 
a Feature Group, then the mailboxes within that FG will have access to the feature. The administrator may also change the 
ECC trigger key from the Company settings as well.

Company
From Company> Call Options tab, modify the Enhanced Call CAontrol 
Trigger Key as desired. The trigger can consist of any DTMF keys. This key is 
set to ** by default.

Feature Group
From Feature Group > Transfer Options tab, enable either or both of 
Internal Extension or External or External/Internal (FindMe) 
Extension checkbox from the Enhanced Call Control section.

Internal Extension will enable the ECC for user's dedicated internal 
device only.

External or External/Internal (FindMe) Extension will enable the 
ECC for both internal and external device as long as the call is made to the 
user through auto attendant.

 Note: Users must log out and log back into iLink Pro Desktop to access Call Handoff from the client 
application after you have enabled the feature.

 Note: Please ensure that Enhanced Call Control Trigger Key does 
not overlap with any other keys.
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Enhanced Call Control
User Guide
Enhanced Call Control is meant for use on an external number. If you are at your typical location (i.e. your work station), 
using the telephone’s own call control or iLink Pro Desktop’s call control will be more efficient and easier. However, you will 
have access to this feature even on your desktop phone if the administrator has enabled it for you.

Keep in mind that pushing the right command keys is vital for Enhanced Call Control since there is no simple means to 
monitor the call’s status without iLink Pro Desktop. When the correct command key is pressed, you will hear the menu 
options available to you and the other person on the line will be on hold and will hear the hold music.

While ECC allows you to control the call from the phone itself, the Call Handoff feature can also be managed by iLink Pro 
Desktop's Call Manager feature. Please refer to the section at the end of this guide for more information.

When the ECC is available for your current call, you will hear an audio indicator at the beginning of the call. If you do not hear 
this at the beginning of the call, you will not have access to ECC.

ECC Command List
** - Default Access Code. Push ** to enter the ECC menu. The other party will automatically be put on hold. This access 
code may be changed by the system administrator.

1 - Retrieve the current call (stop the hold)

2 - Transfer the current call to another number

3 - Hand off the current call to another device

4 - Disconnect the other person on hold and return you to the Auto Attendant

# - Disconnect the current call for both parties

Initiating a Handoff to Predefined Numbers
By default, iLink Pro Desktop will allow you to hand off the calls to numbers assigned 
to your current location. Select the number you wish to hand off the call to by clicking 
on the appropriate entry.

Once you initiate the handoff, the selected number will ring. When the new extension 
is answered, the old connection will be terminated and the conversation will continue 
on the new device only. You will still retain the ability to control the call from iLink Pro Desktop, which means that you can 
freely handoff the phone call to any destination as many times as you wish.

Initiating a Handoff to Custom Numbers

When you wish to handoff to a number that isn’t defined under your current locations, 
you can choose the Handoff to... option then manually define the destination.

Select one of the following radio buttons, then either enter or select the destination.

 Mailbox: Use this option to handoff the call to another mailbox. You can use the 
Find button to search for a mailbox if you do not know the number.

 Phone: Use this option to handoff the call to an external phone number. Clicking 
on build will allow you to separately define country & area codes.

 Location: Use this option to handoff the call to a chosen location’s default 
number.

 Note: You cannot handoff a call to a custom number through ECC. You may only perform this action from 
iLink Pro Desktop.
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Accept Meeting Over the Telephone
Introduction
Officelinx allows users to accept meeting requests through the telephone. Through IMAP TSE synchronization, Officelinx 
users were always able to access their voicemail, email and fax messages from the phone by logging into their mailbox. 
Officelinx takes that functionality one step further by recognizing meeting requests as a unique message.

This allows users to accept meeting requests through their telephone, extending Unified Communications functionality by 
being able to manage virtually any type of messages from telephone. Even if the user is away from a computer, the user will 
still be able to accept or decline meeting requests with a simple phone call to the Officelinx server.

Visual Guide

When you’re on the road, being able to access all of your messages with a single phone call can be a lifesaver. There is 
nothing easier that will allow you to gain access to all of your messages at once. Sometimes finding a computer or an internet 
connection can be virtually impossible. But a telephone is always available almost anywhere in the world.

Officelinx allows users to access meeting requests as a unique message type, allowing them to accept or reject requests by 
pressing a key on their telephone.

Requirements

Requirements Details

License IMAP TSE License for each mail server

Software Officelinx version 9.0 or higher

Access to Messages
via UC Server

Accept Meeting Over Telephone
through UC Server recognizing
Meeting Request Message type

Traditional access to eMail and
Voice + Fax messages via UC Server
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Accept Meeting Over the Telephone
Server Configuration
Server side configuration required for this feature is to ensure that IMAP TSE synchronization is configured properly. When 
synchronization is confirmed, you must create the necessary actions within the user’s TUI so that meeting related commands 
can be accessed when called upon.

Managing TUI Actions
The first action to add or modify is the Listen to Messages TUI action. The action 
properties include fields which directly affect the functionality of Accept Meeting feature.

First is the Meeting Menu dropdown menu. From here, you can specify the sub menu 
that the users will have access to once they have finished listening to a meeting request. 
Meeting request sub menu is covered below.

You can also prioritize a Meeting Request by enabling the checkbox under Sort Order. 
This will move meeting requests to the top of the list, allowing the users to respond to 
meetings right away without having to listen to all of the newer messages first.

You can also allow the users to specifically access meeting request emails only by 
enabling Ask checkbox from the Message > Type section. With this turned on, you can 
enable Explicit Meeting Request, which allows the users to choose to hear either 
meeting requests or regular messages when they call in.

Once users are allowed to access meeting requests, you should also create a sub menu dedicated to meeting requests so that 
the users can easily accept or decline the requests. There are three actions that are related to meeting request management.

Accept Meeting action: From this action’s properties, you can enable the Ask checkbox to have 
the auto-attendant ask the users whether they want to change their availability to Available or 
Unavailable for the duration of the accepted meeting. 

If you choose not to use the Ask function, you can have the users’ availability set to either 
Available or Unavailable automatically by selecting the status from the dropdown menu. In 
this case, when users accept a meeting, their availability will be set to the value you selected.

Accept Meeting Tentatively action: This is virtually identical to the Accept Meeting action 
when it comes to action’s properties. The only difference between the two actions is that this 
action only accepts the meeting Tentatively, which will be reflected on the user’s calendar.

Decline Meeting: This action does not have any special properties and will simply decline the 
meeting when chosen by the user.

This is an example of a typical meeting request sub menu. A menu similar 
to this should be selected from the Meeting Menu dropdown list under 
the Listen to Messages action.

When this sub menu is available, the users will have access to all meeting 
related functions, along with other message related actions such as Skip/
Save, during or after a meeting message playback.

 Note: When there is no Meeting Menu defined with the actions mentioned 
below, the default meeting related actions available to the users will be:

Press 1 to accept meeting.
Press 2 to tentatively accept meeting.
Press 3 to decline meeting.
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Accept Meeting Over the Telephone
User Guide
To use the Accept Meeting over Telephone feature, log into your mailbox and check your messages as usual.

The way in which the menu is laid out may differ depending on the your site’s customized settings, but the TUI (Telephone 
User Interface) should tell you what you need to do.

Meeting Related Actions

Accept Meeting

This action will accept the meeting you are listening to or have listened to. Your calendar will be updated and your availability 
for that period will be set. An accepted meeting request will appear as a Meeting event in the UC Location Calendar by 
default. UC Availability during the meeting can either be a default which the administrator has set, or you can choose to be 
either Available or Unavailable for the duration of the meeting.

Accept Meeting Tentatively

This action is virtually identical to Accept Meeting. However, the meeting will be marked as tentative on your calendar.

Decline Meeting

This action will decline the meeting request. There will be no changes to your Mail Server Calendar, UC Location Calendar or 
UC Availability.
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Speech Commands
Introduction
Navigating through the Voice Menu or the TUI can sometimes be difficult when you cannot freely enter the DTMF keys. When 
you’re on a cellphone, for example, it is often difficult to navigate through DTMF input due to the ergonomics of cell phones. 
Officelinx now supports a Voice Navigation function where the users may speak the numerical choice rather than to enter it 
on their phone. This will allow the users to freely navigate through the entire system without having to enter a single key. 
When combined with the Voice Verification feature, the Voice Navigation will be able to offer a truly “hands-free” experience 
for the end users.

Visual Guide
The user will dial into the system as he/she would normally do. Once 
connected, the system will list all the menu options as usual. The user speaks 
the menu item number of his/her choice. The system accepts the Speech 
Command as a valid entry and performs the action associated with the number.

Requirements

Requirements Details

License ---

Software Officelinx version 9.0 or higher
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Speech Commands
Server Configuration
In order to enable Speech Commands for the users, Speech Recognition must be turned on at the Company level. This 
requires an ASR license. Then give permission to the FG and the Mailboxes as appropriate.

Company Properties
Go to OL Admin > Company, and on the Speech Options tab, ensure that 
Voice Recognition is enabled for the company. 

Feature Group Properties
From OL Admin > Feature Group, on the Speech Options tab, enable 
the Enable Speech Command checkbox. 

With this option enabled, individual mailboxes associated with this FG will 
be able to turn Speech Commands on and off.

 Note: All users that wish to use Speech Commands must be setup 
under a company that has ASR capabilities.
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Speech Commands
Mailbox Properties
From OL Admin > Mailbox, on the Speech Options tab, enable the 
Enable Speech Command checkbox to allow this particular mailbox user 
to use the Speech Command feature. You must repeat this step for all 
users that wish to use this feature.

Customize TUI Configuration
Users may occasionally need to turn off the Speech Command temporarily 
if they are in an environment with too much noise. Voice selection of menu 
items can be interrupted, or another person’s loud voice may be accepted 
as an entry instead.

To allow callers to temporarily disable this function, add the 
Disable Speech Command action to the TUI that the caller will be using. 
When a user selects this action from the TUI, the Speech Command 
feature will be disabled for that session. Users will be able to use Speech 
Command again the next time they log into the system. Using this action 
only temporarily disables the feature.

 Note: If a user doesn’t have access to Speech Command 
feature, this action will be a null action for them.
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Speech Commands
User Guide
When you log into the phone system, you may sometimes find it difficult to navigate through the menus using the telephone 
keypad. For example, if you are using a hands-free head set while driving, having to press the keys on your cell phone can be 
a dangerous distraction.

To avoid this situation, you can utilize the Speech Command feature which allows you to navigate through the phone system 
menus without having to press any keys. You speak the number of the commands you wish to send instead of pressing the 
corresponding button. This allows access to all of the options available on your phone system without having to press a single 
button, giving you a true hands-free telephone experience.

Basic TUI Navigation
When you are given a choice of menu items, simply say the number of the corresponding action.

It is vital that you clearly say the number. The system will automatically match the sound with a number without 
confirmation, so in order to properly navigate through the menus, you must pronounce the numbers as clearly as possible.

Temporarily Disable Speech Command
You may wish to disable Speech Command from time to time due to high amount of background noise. If you have the 
Disable Speech Command action in your TUI, you will be able to disable the Speech Command feature for a single session. 
When you select this action, Speech Command will become invalid right away, and the system will only accept telephone key 
input. The feature will remain disabled until you are disconnected from the system.

 Warning: Do not repeat the actual name of the action. You must say the number of the action instead.

 Note: Control keys can only be accessed through DTMF input. It is not compatible with speech commands.

 Note: When you log into the system again, the Speech Command feature will be available again.

 Note: Location of the disable action will vary depending on the TUI associated with your mailbox.
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Speech Contacts
Introduction
For many business users, their list of contacts can easily grow to such a length that finding any one person can be difficult. To 
make this easier, the contact list can be speech enabled to allow finding a person through voice alone.

In order for a user to use this feature, configuration changes must be made on both the server and the client applications. 
Please follow this guide exactly as explained to enable the speech contact function on your system.

Visual Guide

Having easy access to contacts is essential for people on the go. Spending a few minutes just to select someone to call or to 
send a message to is not very efficient. Speech Contacts makes it easy for users to locate a contact by enabling voice 
searches. Once the user sets a contact to be speech enabled, they will be able to find that person within the TUI.

Requirements

Requirements Details

License ASR

Software Officelinx version 8.1 or higher
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Speech Contacts
Server Configuration

For the following steps, launch the OL Admin program.

Procedure
1. Go to Company properties, and open the Speech Options tab. 

Specify the following:
Voice Recognition: Enable to activate the ASR engine in the 
automated attendant.
Confirm Names in Voice Recognition: Allows the confirmation of 
the name spoken by the caller.
Allow Barge-In in Voice Recognition: The caller can interrupt the 
system (e.g. say "Yes" or "No") during voice recognition.
Allow Barge-In in Name Confirmation: This allows the caller to 
interrupt the system (e.g say "Yes" or "No") as it performs name 
confirmation.
Allow Say Operator: The caller can say “Operator” to be transferred 
to the operator if one has been setup on the system.

2. From the Contact Priority dropdown list, select which of your contacts 
(Public, Private or None) are more important when doing speech 
recognition of contacts.
For example, if in a mailbox you choose to speech enable both Public and 
Private contacts (Mailbox > Mailbox Options screen) and the number of 
users (company mailboxes + private contacts + public contacts) exceeds 
the number of allowable users on the license, you must disable either the 
Enable ASR for Public Contacts or Enable ASR for Private Contacts according to the selection you have made in 
this dropdown list. 
For example, selecting Private in this dropdown list, and disabling Enable ASR for Private Contacts on the 
Mailbox > Mailbox Options screen will give priority to Public contacts.

3. Save any changes.
4. Open the Mailbox of the person who will use this feature. 

Go to the Speech Options tab and specify the following:
Enable ASR for Public Contacts: Enable to implement ASR 
capabilities for public contacts.
Enable ASR for Private Contacts: Enable to implement ASR 
capabilities for private contacts.
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5. Move onto the Advanced tab. Ensure that Unified Communications 
is selected under Desktop Capabilities.

6. Save the Mailbox settings.
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Speech Contacts
User Guide
Enabling Speech Contacts allows you to quickly and easily get in touch with your contacts through the TUI (Telephone User 
Interface). Instead of having to enter multiple keys to find a contact, you say the name instead.

Only speech enabled contacts may be accessed through speech. You must ensure that the contacts are enabled for speech 
before using the feature.

Enabling Speech Contacts
You can enable speech for your contacts individually from 
each contact’s properties. 

If you have a long list of contacts, it is quicker to use the batch function. 

1. Click on the Contacts icon, then click on the 
Speech Enable Contacts button.

2. Select the Enable Speech radio button.

If you wish to enable speech for all of your contacts, click on the 
Apply To All Contacts button.

If you wish to enable speech for only certain contacts:

1. Populate the uppermost listbox with contacts. Choose from the 
Select from: dropdown list, or in the Search field, enter the 
contact name that you want to add and click the Search 
button.

2. Add contacts from the upper listbox to the bottom by enabling 
the checkbox beside the contact, then clicking the Add button.

3. When all desired contacts have been added, click on the 
Apply to Selected Contacts button to apply the changes.

When you open a contact that has speech enabled, you will see that 
Speech enable this contact is checked. You may freely modify 
individual entries by enabling or disabling this checkbox.

 Note: If you wish to disable the speech contact feature 
for large number of contacts, repeat the above process 
but choose Disable Speech radio button instead.
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Google Integration
Introduction
The availability, security and efficiency of Google solutions are now accepted for both business and personal usage. Google 
Desktop, along with Google Talk, is a popular choice for computer desktop management and efficient communication with 
those located outside the company network. Officelinx integrates with these Google features:

 Message Integration: Officelinx is able to synchronize messages with Google Apps and Gmail servers, allowing users 
to access a single endpoint to manage all of their messages. All of the user’s email, voice and fax messages can be 
accessed through a single application through this integration. Users can listen to their Google email messages through 
the phone and to their voice messages from the web by logging into their Google account.

 Contact & Calendar Integration: Officelinx can synchronize contact entries and calendar events with Google Apps or 
GmailOfficelinx. Any entry that the user creates within Google will be automatically updated on the Web Access and vice 
versa, reducing repetition.

 UC Web Gadget for Google: iLink Pro is an essential part of the UC experience within Officelinx. However, it may be 
difficult to deploy the client software to all users. Being tied to a desktop application may further reduce portability and 
efficiency. As a solution, Officelinx supports a Web Gadget version of iLink Pro which can be integrated into the iGoogle 
start page or the Gmail interface, allowing the users to take advantage of iLink Pro’s features no matter where they are.

 UC Client Gadget for Google Desktop: For in office users, Google Desktop is widely used as a productivity 
enhancement tool. For such users, installing different types of client software may reduce workstation’s performance and 
may add clutter to the computer desktop. To help solve this problem, iLink Pro is available as a Google Desktop gadget, 
allowing users to take advantage of the advanced iLink Pro features through an easy to install gadget, eliminating the 
need to install the full iLink Pro application.

 Google Talk Plug-in for iLink Pro: For those users who frequently use Google Talk, all location and availability settings 
can now be synchronized between iLink Pro and Google Talk. The locations calendar will also affect Google Talk status, 
allowing users to automatically reflect their status to their contacts in Google Talk without having to manually change it 
twice every time.

By implementing these solutions, users gain access to many new features without substantially changing their work flow. 
This allows for an increase in productivity without the need for extensive retraining.

Officelinx can also forward incoming messages (voice, email, fax) to a Google Docs collection making all of your 
communications available from anywhere in the world through the internet.

 Note: Repeating events in Officelinx, such as a weekly meeting, will only be synchronized with the 
Google calendar out to 7 days ahead. Previewing beyond 7 days in advance will not show the recurring 
event in Google’s calendar.
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Implementation Example

ACME corporation utilizes Google Apps as their email solution. To increase productivity, employees at ACME also use Google 
Desktop applications to manage their email and use other productivity related gadgets. In order to provide a seamless 
telephony solution for the existing environment, ACME chooses Officelinx and connects every user’s extension to a UC 
mailbox, allowing users to manage voice, fax and email through the Google Apps Gmail interface. Depending on user 
preference, the following features were also introduced at individual workstations to provide additional functionality.

 Synchronize Calendar and Contact information between Officelinx and Google Apps. Recurring events are only 
synchronized out to 1 week in advance.

 Receive phone calls through Google Desktop.

 Initiate phone calls through Google Desktop.

 Change UC location and status through Google Desktop.

 View personal work group through Google Desktop.

 Share location and status information between iLink Pro and Google Talk.

Requirements

Requirements Details

License ---

Software Officelinx version 9.1+

Google Apps Server UC Server

Message, Contact and Calendar are
synchronized between the two

servers when integration is complete.

End user applications become
cross compatible through plug-ins

and gadgets.
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Server Configuration
Server configuration of Google Integration makes extensive use of IMAP TSE for message, contact and calendar 
synchronization. Web Gadget and other client application integration does not require a specific server configuration. As long 
as your web server is able communicate properly with the worldwide web, users will be able to configure all their gadgets and 
plug-ins on their own through the User Guide on page 72.

Client authentication and synchronization is handled by one of the following:

 Synchronization for a Single User
 Synchronization Through OAuth
 Synchronization Through OAuth 2.0

The chosen method will depend upon site specific preferences.

Synchronization for a Single User
In order to achieve IMAP synchronization between Google Apps and Officelinx, set the Google Apps mail mode to IMAP. All 
other configuration takes place in OL Admin where individual mailboxes hold the credentials for the corresponding Google 
Apps email account.

TSE IMAP Configuration

Before you can synchronize your mailboxes with a Gmail account you must first configure your OL Admin so that it can access 
the Gmail IMAP server.

1. Locate and run OL Admin console.

2. From the left hand menu locate the TSE IMAP Server.

3. Right click on the TSE IMAP Server and the following menu appears. 
Select New -> TSE IMAP Server.

4. The TSE IMAP Server creation window opens. Fill out the boxes as follows:
 IMAP Sever Name: Gmail (or Google Apps name for your company)
 IMAP Server Address: imap.gmail.com
 IMAP Server Port: 993
 Click OK.

5. Restart the TSE Cache Manager service from the Services panel.

The Officelinx UC platform is now ready to synchronize system mailboxes with Google Gmail 
IMAP accounts.
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Mailbox

In order for your mailboxes to be synchronized with a Google Apps IMAP account, you must individually setup each of the 
mailboxes accordingly. Ensure that the Google Apps/Gmail account that Officelinx will be synchronizing with is configured for 
IMAP connection.

1. Locate and run OL Admin console.

2. Locate the mailbox you wish to sync with a Google Apps IMAP account.
3. Double click on the mailbox to load the following configuration 

window. Select the Synchronization Options tab as shown here.

4. Fill out all the information as follows:
 User Name: Type in the email address of the Gmail account 

that you have created for this mailbox.
 User Password: Type in the password for the Gmail account.
 Confirm Password: Type in the password for the Gmail 

account again to verify.
 IMAP Server: From the dropdown menu select Gmail.
 IMAP Language: From the dropdown menu select the 

language you will be using.
 Storage Mode: From the dropdown menu select IMAP.

5. Close the configuration window and save your settings. Your 
messages to this mailbox will now be directly synchronized with the 
Gmail account that was configured.

Proceed to the next section to modify the Feature Group.

 Note: For details on contact and calendar sync, refer to 
Contact & Calendar Synchronization on page 63.
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Feature Group

In order to ensure that there are no conflicts between Officelinx and Gmail, please follow these steps to configure the Feature 
Group to synchronize the required information.

1. Locate and run OL Admin console.
2. From the left hand menu locate the Feature Group. Find the 

Feature Group that the mailboxes with Gmail synchronization 
are located in. Double click on the feature group to load the 
Feature Group configuration window.

3. From the Feature Group configuration window, open the 
Synchronization Options tab. 

4. Under Synchronization Settings, enable all of the checkboxes that 
apply. These are the data types that will be synchronized between 
Officelinx and Gmail.

5. Save and close the window after the changes are complete.

6. Your Officelinx mailbox is now fully synchronized with the Gmail IMAP 
account.

 Note: For details on contact and calendar sync, refer to 
Contact & Calendar Synchronization on page 63.

 Note: To make sure that your mailboxes are associated 
with the right Feature Group, check the Mailbox 
configuration window under the General tab.
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Synchronization Through OAuth
Google Apps supports OAuth authentication which makes the deployment of IMAP TSE synchronization 
easier. Rather than requiring the individual user’s username and password in order to synchronize data 
between the Officelinx and Google servers, you may use a single OAuth account which has the authority to 
oversee all of the Google accounts within an organization. This means that you no longer have to enter 
passwords for each individual user’s mailbox settings. Simply define the OAuth settings in the Feature Group, then all 
mailboxes within that Feature Group can enter their user name only and skip the password on their mailbox settings.

Another significant advantage of this authentication method is that users can change the password for their Google accounts 
without having to change any Officelinx settings. Since the OAuth account oversees authentication, users are free to change 
their Google passwords without affecting synchronization.

About OAuth

The OAuth API key is Google's recommended approach for third party application servers, such as Officelinx and Esna 
Cloudlink, which require access to domain data on the user's behalf. Other applications may only need info at the time of user 
access. Details can be found through the link below:

http://code.google.com/apis/accounts/docs/OAuth.html#GoogleAppsOAuth 

The scope of access can be controlled through the Google Apps Admin Panel > Manage API Client Access. Esna 
application servers require access to IMAP, Calendar and Contacts through the API scope. Calendar and Contact API access is 
read only; IMAP message status reflects changes (listen/delete) to Voicemail message status ONLY.

For more information:

OAuth: Managing the OAuth key and secret
https://support.google.com/a/bin/answer.py?hl=en&answer=162105

OAuth: Managing API client access
https://support.google.com/a/bin/answer.py?hl=en&answer=162106

The OAuth key does not give Officelinx any admin level privileges (add/delete/update user accounts). This is a different API 
implementation that requires separate authorization from the Google Apps domain admin panel.
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Configuring OAuth

First, ensure that the Google domain has not disabled POP and IMAP access.

1. On the Google Apps Administrator account, go to Settings > Gmail.
2. Scroll down to the End User Access section.
3. Verify that the POP and IMAP access > Disable POP and IMAP access for all users checkbox is NOT enabled.

Then, create an OAuth account from Google Apps. 

4. Log into your Google Apps account as the administrator, 
then go to Manage Domain > Advanced tools > 
Manage OAuth Domain Key.

5. From here, select both Enable this consumer key and 
Allow access to all APIs. ‡

6. Record the OAuth consumer key and the 
OAuth consumer secret.

7. The OAuth consumer key will act as the superuser 
account name while the OAuth consumer secret is the 
password for the account. 

8. Once all the changes have been made, click on 
Save Changes.

 Note: Your Google Apps must have its own domain name in order to utilize this feature.
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‡ - For sites where enabling all API’s is not possible, replace step 5 with the following procedure:

a. From the Google Apps Admin window, open the Advanced Tools tab.
b. Under Authentication, click the Manage third party OAuth Client access.

c. For Client Name, enter your corporate Gmail domain. In the space for One or More API Scopes, enter the following:
https://mail.google.com/, https://www.google.com/m8/feeds/, https://www.google.com/calendar/
feeds/

Finally, enter the OAuth information on the Feature Group. 

9. Launch OL Admin and go to the 
Feature Group > Synchronization Options tab.

10. Enter the OAuth consumer key for the IMAP Account.
11. Enter the OAuth consumer secret for the Account Password and 

Confirm Password fields.

All mailboxes which belong to this Feature Group will now take advantage 
of the convenience of OAuth. Users will no longer have to define their 
Google account password on through Officelinx.

 Note: This is three addresses, each separated by a comma:       https://mail.google.com/
https://www.google.com/m8/feeds/
https://www.google.com/calendar/feeds/
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Synchronization Through OAuth 2.0
OAuth 2.0 provides another option for administrators to manage user authentication and synchronization.

Acquiring the Client ID and Password

First, ensure that the Google domain has not disabled POP and IMAP access.

1. On the Google Apps Administrator account, go to Settings > Gmail.
2. Scroll down to the End User Access section.
3. Under POP and IMAP access, verify that Disable POP and IMAP access for all users is not checked.

A Client ID and Password for the Google OAuth connection is required.

4. Open a web browser and go to http://code.google.com/apis/console.

Click APIs & auth.
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5. Set the Status of Drive API to ON.

6. Click Return to original console.
7. Under API Project, select API Access. 


Click on Create an OAuth 2.0 client ID.....
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8. Enter a name into the Product name field. This name will be used to refer to this client.

The remaining fields can be left at their default values. Click Next.

9. Enable Service account and click Create client ID to continue.

10. The client ID and password will be generated by the system.

Make note of the Private Key password for use in later stages of this setup.

Click Download private key and save the key file to your computer. When prompted to enter the location to save the 
file, select C:\UC\UCCSE.
This file must also be copied to the C:\UC\IMAPTSE folder.

Change the drive letters accordingly if Officelinx installed to a different location.

Close the window  once the file has been copied to both locations.
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11. Rename the private key file to match the email address in the API Access screen. 

Record the Client ID for use in later stages of this setup.

OAuth2 and Officelinx High Availability (HA)

When using OAuth2 within an HA environment, the private key must be copied to both of the specified locations on the 
Consolidated server (C:\UC\IMAPTSE and C:\UC\UCCSE).

Additionally, if email is to be played back over a telephone connection using the Text-to-Speech engine, each of the other 
computers in the HA array must also have the private key installed in the C:\UC\IMAPTSE folder. The same file is saved in 
this location on all Master and Slave machines. This is necessary since each computer will request OAuth2 authentication 
independently of the other machines on the network when attempting email playback.

 Hint: The text can be copied directly from this window, and pasted to replace the existing name of the file.

Rename the key file

]
Client ID Number
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Configuring OAuth 2.0

12. Login to Google Apps as an administrator.

13. Click Settings  and choose Manage this domain.

14. If prompted, provide the necessary administrator account and password details to login.
15. Go to the Advanced tools tab, and scroll down until you find the section for Authentication.

Click Manage third party OAuth Client access.

16. Enter the complete Client ID value, both the user and domain portions, received in step 11, into the Client Name field.

In the space for One or More API Scopes, enter the paths for all required scopes from the list below the text entry 
field. When entering more than one scope, separate each by a comma. Use the following scopes:

https://mail.google.com/,https://www.google.com/calendar/feeds/,
https://www.google.com/m8/feeds/,https://www.googleapis.com/auth/drive,
https://www.googleapis.com/auth/drive.file

17. When ready, click the Authorize button.

 Hint: The first two scopes (Docs and Download PDF... are both required to synchronize with Google Drive. 
The others are required only to synchronize the specific data type.

[
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Configuring Officelinx

Once OAuth 2.0 has been configured, Officelinx must be setup to use it. 

The following procedure is conducted on the Officelinx Server.

18. Open OL Admin. 

19. Click on Feature Group, and double-click a group to modify in the right-hand pane.

20. Open the Synchronization Options tab. Enter values in the following fields:

IMAP Account: Enter your company domain, followed by the user portion of the client ID received in step 11. For 
example - companydomain/123456789012.
Password and Confirm Password: Type in the Private Key password for the client ID received in step 10.

21. Click Save  to preserve the changes.
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22. In OL Admin, open Mailbox Structure and double-click a client to modify. 

23. Open the Synchronization Options tab.

24. Enable the Use Feature Group settings for IMAP checkbox. For User Name, enter the Gmail address for this client. 

For example, davidi@erbmusic.com

janep@gmail.com
name@yourcompany.com

25. Click Save  to preserve the changes.
26. Repeat steps 22 through 25 for each client that requires OAuth 2.0 synchronization.

The setup is complete.
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Contact & Calendar Synchronization
Once you have configured the IMAP TSE server with your mail server, you will be able to assign the degree of synchronization 
from the Feature Group. While the server side configuration is simple, your must ensure that you verify that all of the 
information is correct so that your users do not lose any calendar, contact or message data during synchronization.

OL Admin

From OL Admin, configure the IMAP TSE server so that Officelinx 
can successfully communicate with the Gmail server.

Enter the following information:

IMAP Server Name: Enter the name of your mail server. This 
name is for reference only and will not have an impact on 
functionality.

IMAP Server Address: Enter imap.gmail.com. This is same 
for Gmail and Google Apps applications.

IMAP Server Port: Enter the port that your mail server uses during communication. For the Gmail server, this value is 
usually 993.

IMAP Server Voice Format: Select the voice file format to be used to synchronize voice messages with the Google server.

IMAP Server Domain: This field is not required for most Google Apps integration scenarios. This field is mainly used to 
define the domain name of the mail server to verify the Reply to address of each mailbox. This prevents message loops 
during synchronization.

Feature Group

Feature Group configuration must be done in two places: the 
Synchronization Options tab, and the Mailbox Options tab. You will be 
able to define exactly what data will be synchronized from these two 
sections.

From the Synchronization Options tab you can specify which messages 
are going to be synchronized between the servers. You may also define 
how the calendar and contacts are will be managed through the same 
connection.

1. From Calendar Mode dropdown menu, select Sync with Mail 
Server if you wish to enable calendar synchronization between the 
servers.

2. Enable the Contacts checkbox to synchronize the contacts between 
the two servers.

 Warning: As a precaution, please backup the calendar and/or contact events of your users before 
proceeding with the contact & calendar synchronization.
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The other fields, such as Inbox Folder, are used for message 
synchronization. Refer to Server Configuration on page 50 for details 
regarding this matter. 

From the Mailbox Options tab, enable Change Location to allow an 
event in your mail server calendar to automatically change the UC location 
of the user.

By customizing these settings you can easily segregate calendar and 
contact synchronization from message synchronization when enabling 
features for the users. This provides control over who has access to each 
feature.

 Note: Repeating events in Officelinx, such as a weekly meeting, 
will only be synchronized with the Google calendar out to 7 days 
ahead. Previewing beyond 7 days in advance will not show the 
recurring event in Google’s calendar.
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Synchronizing Contacts and/or Calendar Only
It is also possible to synchronize contacts and/or the calendar without synchronizing messages. Follow the configuration 
settings for a full synchronization, but disable message folders from the Feature Group.

TSE IMAP Configuration

Before you can synchronize your mailboxes with a Gmail account you must first configure OL Admin so that it can access the 
Gmail IMAP server.

1. Locate and run OL Admin console.

2. From the left hand menu locate the TSE IMAP Server.

3. Right click on the TSE IMAP Server and the following menu appears. 
Select New -> TSE IMAP Server.

4. The TSE IMAP Server creation window opens. Fill out the boxes as follows:
 IMAP Sever Name: Gmail (or Google Apps name for your company)
 IMAP Server Address: imap.gmail.com
 IMAP Server Port: 993
 Click OK.

5. Restart the TSE Cache Manager service from the Services panel.

The Officelinx UC platform is now ready to synchronize system mailboxes with Google Gmail 
IMAP accounts.
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Mailbox

In order for your mailboxes to be synchronized with a Google Apps IMAP account you must individually setup each of the 
mailboxes accordingly. You must also ensure that the Google Apps/Gmail account that Officelinx will be synchronizing with is 
configured for IMAP connection.

1. Locate and run OL Admin console.

2. Locate the mailbox you wish to sync with a Google Apps IMAP account.
3. Double click on the mailbox to load the following configuration 

window. Select the Synchronization Options tab as shown here.

4. Fill out all the information as follows:
 User Name: Type in the email address of the Gmail account 

that you have created for this mailbox.
 User Password: Type in the password for the Gmail account.
 Confirm Password: Type in the password for the Gmail 

account again to verify.
 IMAP Server: From the dropdown menu select Gmail.
 IMAP Language: From the dropdown menu select the language 

you will be using.
 Storage Mode: From the dropdown menu select IMAP.

5. Close the configuration window and save your settings. Your 
messages to this mailbox will now be directly synchronized with the 
Gmail account that was configured.

Proceed to the next section to modify the Feature Group.
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Feature Group

In order to ensure that there are no conflicts between Officelinx and Gmail, please follow these steps to configure the Feature 
Group to synchronize the required information.

1. Locate and run OL Admin console.
2. From the left hand menu locate the Feature Group. Find the 

Feature Group that the mailboxes with Gmail synchronization 
are located in. Double click on the feature group to load the 
Feature Group configuration window.

3. From the Feature Group configuration window, open the 
Synchronization Options tab. 

4. Under Synchronization Settings, enable all of the checkboxes that 
apply. These are the data types that will be synchronized between 
Officelinx and Gmail.

5. From Calendar Mode dropdown menu, select Sync with Mail 
Server if you wish to enable calendar synchronization between the 
two servers. 

6. Enable the Contacts checkbox at the bottom to synchronize the 
contact entries between the two servers.
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7. From the Mailbox Options tab, enable Change Location to allow an 
event on your mail server’s calendar to automatically change the UC 
location of the user. This setting is meant to work with the calendar 
synchronization feature. Save and close the window after the settings 
are complete.

8. Your Officelinx mailbox will now synchronize contacts and/or 
calendar information with the Gmail IMAP account.

 Note: To make sure that your mailboxes are associated 
with the right Feature Group check your Mailbox 
configuration window under the General tab.

 Note: Recurring events will only be synchronized within 1 
week of the current date.
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Google Desktop, Google Talk & Web Gadgets
Since Google Desktop and Google Talk integration occurs on the desktop, there is no need to configure the voice server. 
However, if you are pushing the iLink Pro software to users in a managed network, you should ensure that all the gadgets are 
properly installed and updated. Also keep in mind is that Google Desktop and Google Talk integration requires the correct 
internet access privileges to function properly. If your UC server is connected to the internet through a managed ISA server, 
you must ensure that there are custom policies configured to enable it to function.

The following installations are required at the client desktop for full integration:

 iLink Pro 2.5 or higher

 Google Desktop

 Google Talk

ISA Settings for Google Web Gadget Integration

If your UC server is managed by the ISA server, you must ensure that the policy that affects its web connection is configured 
properly. 

1. From the ISA control panel open the configuration for the policy in question.
2. Ensure that the following settings are disabled:

Verify normalization
Block high bit characters

3. Click OK to save the policy.

 Note: If you are deploying the Google Gadget file from Windows 2008 or Windows 7, you must have the 
.GG MIME type registered on the IIS server. Refer to Adding a MIME Type for .GG Files on page 70.
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Adding a MIME Type for .GG Files

In Windows 2008 and Windows 7, a MIME type has to be defined in order for end users to successfully download the Google 
Gadget file from the OL server. If the MIME type isn’t defined, users will see a following error when trying to download the 
gadget.

1. To add a MIME type, open your IIS Manager then open the MIME Type options from the upper most folder.
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2. From the Actions pane, click on Add....

3. For File name extension, enter .gg. 
For MIME type, enter application/octet-stream. 

Click OK to save your settings.

The MIME type will now be added to your IIS server. Since you have added this entry to 
the upper most folder, the settings will be pushed down to all Officelinx related folders.

Disable IMAP
Where necessary, site administrators can disable IMAP for clients while leaving the domain settings unaffected.

To disable IMAP for users, run the following script at the GAM (Google Apps Manager) command prompt:

gam user <username>|group <groupname>|ou <ouname>|all users imap on|off

For example, this script will turn IMAP off for all users in the current domain:

gam all users imap off
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User Guide
This user guide is divided in two sections. The first covers installing and using the various versions of iLink Pro. The other is 
configuring your message, contact and calendar synchronization between Officelinx (which can be directly accessed through 
the Web Access) and Google Apps. While the installation and configuration related to these features are straight forward, 
please backup important data before configuring any synchronization.

iLink Pro On Google Web Gadgets
The Google Web Gadgets may be accessed in three places. The first is on the Google Apps start pages (i.e. iGoogle). The 
second is through the menu section of your Google Apps mail (i.e. Gmail) interface. The third is from the Google Gadget web 
page on the UC server.

Google Web Gadget On Gmail

1. To add the iLink Pro Web Gadget to the Gmail interface, log into your Gmail account and open the Labs tab under 
Settings.

2. Scroll down to the last entry “Add any gadget by URL”. Enable this option. Click Save Changes.

3. A new tab called Gadgets will appear under settings. In the address space, enter the URL:
http://USER.YOUR_SERVER.COM/ucwebaccess/gadget.aspx.

Replace USER.YOUR_SERVER.COM with the address of your own UC server. When ready, click the Add button.

The iLink Pro gadget is now listed on the Gadgets tab.

 Note: To save your settings, your web browser must accept 3rd party cookies. Some browsers reject 3rd 
party cookies either as a default setting, or due to company policy.
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4. The iLink Pro gadget is now be available on the Gmail interface. 

Click Configure to enter the necessary login information.

5. Enter the company number (which is 1 in most cases), then your mailbox number and password. You 
can also choose to login using your Google account credentials.

Click Save when you’re done and the system will remember your details for next time.

You will now be logged into the UC server.
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Web Gadget From UC Server

Even without a Google Apps account, you can still take advantage of iLink Pro. To access the Web 
Gadget directly from your UC server, enter the following into the address bar of a web browser.

http://USER.YOUR_SERVER.COM/ucwebaccess/

Replace USER.YOUR_SERVER.COM with the address of your own UC server. When you visit the 
page, you will see the page shown here. The functionality of the web based iLink Pro is identical 
to the Google Web Gadget variations.

Using UC Web Gadgets

Logging In

When you first access the gadget, you will have to configure your credentials in order to log in.

1. Choose the login method to use: 
 Google Account: Login to the client using your Google credentials. 
 UC Account: Login using the UC Client credentials. 

2. Enter all necessary login information. Google credentials require no additional input.
Company: Enter the company number that your mailbox is associated with.
Mailbox: Enter your mailbox number.
Password: Enter the password for your mailbox.

3. Click Save and the program will automatically log in.

Messages 

When you log into web gadget, go to the Messages tab to receive a quick summary of 
messages available in your UC mailbox. The icons represent unread voicemail , email  
(text) and Fax  messages. Clicking an icon will send you to the Web Access where you will be 
able to access the messages.

 Note: To save your settings, your web browser must accept 3rd party cookies. 
Some browsers reject 3rd party cookies either as a default setting, or due to 
company policy.

 Hint: For a complete description of all of the features of the gadget, consult the Client Applications Guide, 
chapter 3, iLink Pro, starting on page 49.
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Locations, Availability and Extensions 

Location and availability can be modified using the gadget. To change a setting, click on the My 
Location icon and select a new location and availability setting. Once an item has been chosen, 
the location icon will change to match your selection.

 - Use this icon to set your location to In Office.

 - The At home icon will change your location accordingly.

 - Select this item to change your location to in a Meeting.

 - Click Follow Calendar to clear all manual settings and return to following your 
locations calendar. The calendar is setup and maintained through the Web Access. This icon 
will be absent if you are currently following the calendar.

 - Change your Availability status. This item toggles between set to available 

and unavailable.

 - Choose this icon to access the full range of Locations and options available, 
including custom locations. A check  is placed beside the current selections. The green/
red bar to the left of the icon shows your default availability for that location. 
This screen also provides access to change Availability and the Follow calendar option. The 
numbers where you can be reached is also shown.
The complete list is also available by clicking on your name at the top of the People page.

The locations, default availability, and the numbers where you can be reached at each location 
are automatically adjusted based upon the settings for each item established through the Web 
Access.

Work Groups & Directory Search 

Users can access their personal contacts, work groups and the company directory through the 
People page of the Gadget.

The green/red/yellow bar to the left of the contact’s picture indicates that person’s 
Availability (available, unavailable, on the phone). Their location is shown in the text below 

their name. All status indicators are updated in real-time.

Workgroups are collections of related contacts. These are created by the user as required. Use 
this option to create, rename and delete workgroups, or to modify the contacts included within 
them. From here, you can send an instant message (Chat) to all members of the group. 

Choosing this option from the People utility menu will open a list of all current groups. Click on 
a group to open the list of options.

The number of members in the group is shown at the top of the list.
Chat - Broadcast an instant message to all members of the current group.
Timeline - Show the tracked timeline events for all members of the current group.
Show on a map - Display the locations of all group members using Google Maps.
Rename - Change the name of the group.
Delete - Remove the group from the list. Contacts in the group are not deleted and 
continue to appear in the directory.
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Directory Search 

To search your personal contacts list or the company directory, type the mailbox number, extension, or the contact’s first or 
last name into the Search or dial field. The search function also supports lastname,firstname or initial (i.e. “smith,j” or 
“smith,john”). All matching contacts will be displayed.

Click the X to close the search window. 

Dialing & Call Control

The Calls window shows the status of active telephone calls. The progress of the call is displayed beneath the number.

Click on the progress window to open the Call Control menu.

 - The Hangup icon will terminate the call.

 - Put on hold will pause the call, muting the microphone and allowing another call to be 
placed.
 - When Transfer is selected, the call is put on hold and you will be prompted to enter 
the extension or telephone number to send the call to.
 - Remove will close the Call Control window without affecting the call.

After the call has finished, Call Control provides the following options.

 - Click Callback to initiate a new telephone call to this number.
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Google Talk Plug-in for iLink Pro

Configuration

Open the iLink Pro > Settings window. 

Go to the Plug-ins section. 

Select Google Talk plugin and click Configure.

From the configuration window, enter your Google Talk 
login credentials then click Test Connection to ensure that it authenticates properly.

Select one or more items to activate the corresponding features:

Use Google Talk status: Enable to reflect the availability from Google Talk on iLink 
Pro (e.g. Being Busy on Google Talk will toggle your availability to Unavailable in 
iLink Pro).
Use Client Manager availability: Enable to reflect availability from iLink Pro on 
Google Talk (e.g. Being Unavailable on iLink Pro will toggle your status to Busy in 
Google Talk).
Show Client Manager location: Enable to reflect the name of your iLink Pro 
location on Google Talk.
Show Client Manager extension: Enable to reflect the extension number from iLink Pro on Google Talk.
Show if Client Manager is on the phone: Enable to reflect the “on the phone” status from iLink Pro on Google Talk.

Click OK once all the settings are complete. 

Returning to iLink Pro settings, make sure that the 
Google Talk plugin entry is highlighted then click on 
On/Off to activate the feature. The status of the plugin 
will change to Logged in to reflect that everything is 
functioning.
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Using Google Talk with iLink Pro

Instant messaging is a convenient and efficient communications tool for business. This is why 
Officelinx includes the iLink Pro and supports Chat. However, while Chat serves as a convenient tool for 
internal communications, it is often necessary to communicate with those outside of the network 
through instant messaging. These situations require an internet based tool such as Google Talk.

To make the user experience as smooth as possible, and to reduce duplication, iLink Pro can 
synchronize its status with Google Talk, allowing the users of both programs to manage their location 
and presence from a single application.

Status updates in one program are instantly reflected in the other. Depending upon the settings chosen 
(see Google Talk Plug-in for iLink Pro on page 77), different types of information can be 
synchronized between Google Talk and iLink Pro.

While location and status are synchronized between iLink Pro and Google Talk, only availability is 
synchronized from Google Talk to iLink Pro. The details of iLink Pro’s location are carried over to Google Talk, but when you 
set your Google Talk status to “Busy”, only the status itself is reflected on iLink Pro. Thee is no option within Google Talk for 
“In Meeting” or “At Lunch” so it cannot be set from there, and the option to create a Custom Message is not synchronized.

All status changes are immediately pushed to the other program. This is most obvious when synchronizing phone status. 
When you lift your telephone’s receiver, iLink Pro will immediately change your UC status (this feature is dependent on your 
system setup). If you have the Google Talk plugin configured, the event will be pushed to Google Talk, then revert back to its 
previous status when the user is off the phone.

Message Synchronization
In order to consolidate all your messages (e.g. voice, text, fax, etc.) in a 
single email account, you can synchronize your Gmail or Google Apps 
email with the UC server’s Web Access mailbox. If your organization is 
utilizing OAuth, you will not have to enter any information yourself. 
However, if your organization opts for individual synchronization, you will 
have to do the following.

Log into your Web Access, click the Client icon and scroll down to 
Synchronization Options. Enter the following information:

User Name: Your full Google Apps email address (e.g. user@gmail.com)
Password: Your password for the above email address.
Confirm Password: Confirmation of the above password.

Afterwards, click on the Save button. Your messages in the main inbox folder between Google Apps and the UC server will be 
fully synchronized.

 Note: If the synchronization does not work even after entering the correct credentials, your server may not be 
configured properly for this feature. Please contact your system administrator.

 Warning: If you have a custom filters configured on your Google account, it will not apply to messages that are 
synchronized from the UC server (e.g. voicemail, fax, etc.).

From iLink Pro Desktop to Google Talk:
Location (Meeting) and Status 

(Unavailable) are both synchronized.

From Google Talk to iLink Pro Desktop:
Only Status (Unavailable) is synchronized.

iLink Pro Desktop

iLink Pro Desktop
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Contact & Calendar Synchronization
When your administrator has enabled calendar and contact synchronization for 
you, everything will be occurring on the server side in the background so you 
do not have to configure anything on your own. You can use your mail server 
as you normally would and your calendar and/or contact entries will be 
populated on your Officelinx mailbox as well. The following are typical 
behaviors that the synchronization will follow so that you can understand 
exactly how your calendar and contact entries are being handled by the 
servers.

Contact Sync

When you create a contact entry through Gmail, the same entry will be synchronized into your Officelinx contacts.

The contact information is automatically sent to the 
Officelinx contact list.

 

 Note: When creating a calendar event from Google, you must ensure that the reminder time it set to 1 minute 
or greater. Setting this value to 0 will cause synchronization issues. By default, the reminder time is 10 
minutes.

 Note: All your calendar events and contacts from your current mail server will be populated into your Officelinx 
mailbox right after your administrator finishes the configuration.

 Note: You should backup your calendar events and contacts periodically as a precaution.

 Note: Repeating events in Officelinx, such as a weekly meeting, will only be synchronized with the Google 
calendar out to 7 days ahead. Previewing beyond 7 days in advance will not show the recurring event in Google’s 
calendar.

 Warning: Keep in mind that deletions are also synchronized. If you delete an entry from Gmail, it will be 
deleted from Officelinx, and vice versa.
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Calendar Sync

When you create a calendar entry from Google Calendar, the same entry will appear in Officelinx. The time and date of the 
meeting is automatically sent to the Officelinx mailbox. By default, the location for these events is marked as Meeting, but 
this can be changed through the Web Access Calendar icon.

Manual Contact Importing
If synchronization is not an option for your site, you may manually copy contacts from one application to the other. Long lists 
of contacts can be difficult to transfer. To make this process easier, Web Access supports importing CSV (comma separated 
value) files that can be exported from Google Apps.

1. To export your contacts from Google Apps, log into your 
Google email account and open your Contacts list. 

2. Click on More, then Export...

This opens the Export contacts window.

3. You can choose to export selected contact, specific 
groups of contacts (e.g. My Contacts), or all contacts. 

Select All contacts.

4. For export format, choose Outlook CSV. 

Click on Export when ready.

5. When prompted, specify the location where the file will be saved. 

6. With the CSV file ready, open Web Access and click Contacts. 

Click the Import button.

7. Click Choose File and select the CSV file exported from 
Google.

8. Click Next to proceed after the file has been selected.
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Match the fields from the CSV file to the fields on the Web Access 
contact. You will only have to match the information you require. 
Leave all the unnecessary fields as (disregard this field).

Click Import when all of the required fields have been matched. 
The contacts will be imported from the CSV file into Web Access.
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Weblinks
Introduction
This feature allows you to increase the security level of Voicemail and Faxes that are transferred via email by storing all the 
files on the server itself. Instead of the attachments being sent and received, the sender’s attachment is stored on the server 
while the receiver gets a link to access the file.

The below process illustrates an example of how this can be implemented. Due to the variation between different sites, 
following these steps exactly as shown (especially with regards to the URL and folder paths) may prevent the feature from 
working properly on your own system. A professional technician with networking knowledge who understands the process 
would be able to configure the settings necessary for your own system setup.

Also, please keep in mind that the configuration procedure will differ depending on the version of your IIS. In general, 
Windows 2003 and XP will use IIS 6 while Windows 2008 and Windows 7 use IIS 7, which changes the interface you must 
configure the feature from.

Configuration Process
The exact procedure to setup Weblinks depends upon which version of IIS (Internet Information Services) is installed on the 
server. 

If the server has IIS 7 installed, begin the process on page 85.

If the server has IIS 6 installed, begin the process on page 86.

Regardless of which version of IIS is present, the Officelinx setup remains the same. Once the appropriate version of IIS has 
been configured, continue with the Officelinx setup on page 87.

 Note: Voice messages which are listened to through the telephone using the Weblinks action link within the 
email will not automatically change the read status of the voice message. Therefore, listening to message in 
this fashion will not extinguish the message light on integrated environments. The end users have the 
option of marking the message as read through the options available at the bottom of the Weblinks 
message. Performing such an action will extinguish the message light on integrated environments if the 
message is the last unread message.

 Warning: Only follow the procedure that is relevant to your system. Do Not perform both IIS setup 
procedures.
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Configuration with IIS 7

1. In order to utilize Weblinks, you must first 
confirm that you have the necessary Windows 
components installed for IIS. 

You will need HTTP Redirection and CGI 
enabled within IIS. 

This image shows adding the component from 
Windows Server 2008, which occurs under 
Role management.


If you are utilizing Windows 7, you will see this screen, available from 
Control Panel > Programs & Features > Windows Features.













 Warning: Use these instructions only if you have IIS 7 or later on your system. If you have IIS 6, use the 
section Configuration with IIS 6 on page 86.

 Important: Continue with the section Officelinx Configuration on page 87.
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Configuration with IIS 6

1. Open the Start menu. 

Right-click My Computer then choose Manage.

2. On the left-hand side, select 
Web Service Extensions.

3. On the right-hand side, select
All Unknown CGI Extensions.

Click on Allow. 

4. You will get the following warning. 

Click Yes to accept the changes and continue.

5. Repeat steps step 1- step 4 for All Unknown ISAPI Extensions.

 Warning: Use these instructions if have IIS 6 on your system. If you have IIS7, then use the section 
Configuration with IIS 7 on page 85.

 Important: Continue with the section Officelinx Configuration on page 87.
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Officelinx Configuration
Once the appropriate version of IIS has been setup, continue with the Officelinx configuration.

1. From OL Admin > Configuration > VPIM/
SMTP, change the value of HTML Content to 
True.









2. In order to utilize the Weblinks function, the 
mailbox has to be associated with the Feature Group that has 
the function enabled. 

From OL Admin > PBX > Company > Feature Group, go to the 
Synchronization Options tab and select the type of messages you 
wish to use Weblinks with from the dropdown menu.

3. If a user does not utilize IMAP TSE Synchronization between their 
Officelinx mailbox and the mail server account, you may opt for the 
forwarding method. 

From OL Admin > PBX > Company > Mailbox, open the 
properties of the mailbox you wish to enable Weblinks for, then go to 
the Message Options tab. Create an entry to forward the emails. 
When the mailbox is associated with the Feature Group that has 
the Weblinks enabled, as shown in previous step, you can enable 
the HTML Content checkbox. Be sure to leave the Attachment 
checkbox disabled if you wish to send the URL only.

4. When all your server side configuration has been completed, restart 
the server computer.

 Warning: Please keep in mind that this step is only for 
users who will be using email forwarding instead of 
IMAP TSE Synchronization. If you configure forwarding for 
users who are using IMAP TSE Synchronization, there will be 
an infinite loop of messages. You should either use IMAP 
sync or forwarding but never both for the same mailbox.
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5. Locate the webmailconfig.exe file in the Officelinx folder (by default, this is 
C:\UC). 

From Windows, go to Start > Run and enter the full path and file name in the 
space provided. Add the /i parameter, and the URL of the server where the files 
will be kept. 
For example:

C:\UC\webmailconfig.exe /i user.erb.com

Click OK and the program will automatically configure the remaining settings.

6. Stop and restart the World Wide Web Publishing Service on the computer to complete the setup.
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Weblinks Example
The following is an example of how the attachments are handled using this function. The email itself only contains the text of 
the message. The attachment is left on the server. If you were to forward this email to someone with no permission to access 
the mail server, they would not be able to listen to the message. While the email is forwarded, the attachment itself remains 
secure on the server.

By using the Playback buttons, the voice message can be played through the current device, or the telephone associated 
with the user’s default extension. Additional buttons allow the message to be Mark Read or Deleted from the voice server. 
A call to the sender can also be initiated by clicking the UC Dial (dial through the Officelinx voice server) or Dial (dial 
through a configured device, such as a cell phone when out of the office) buttons.

The View button opens an new window in the browser. This window contains playback controls for the message.

Fax messages processed through Weblinks will behave in the same manner. The attachment remains on the server while only 
links to view the message are sent to the user. 

Forwarded messages will contain links which are only viewable by authorized users.
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Email Action Schema
Introduction
The Action Schema option causes tags to appear in the subject line of emails that contain voice messages, or those that 
denote missed calls. Users can click on these buttons to playback voice messages, or to immediately place a telephone call to 
the contact.

 Warning: This feature is only compatible with email programs that support DKIM verification.

 Warning: Actions Schema is not supported on systems using IMAP Synchronization.
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Enable Action Schema
Turn on the Action Schema option through the OL Admin program.

1. Start OL Admin and open the Mailbox folder.

2. Double-click one of the listed mailboxes, and open the Message Options tab.

3. Click Add to create a new Address, or select an existing address and choose Edit.
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4. Select which Message Types (voice and missed calls) will add a tag to the message in the email subject line. 
Configure the remaining settings as required, and enable the Action Schema checkbox.


Click OK when finished.

5. Save the changes to the mailbox.

 Hint: For a complete details for all of the items in the Addresses window, refer to the Add / Edit Message 
Options section, page 118, in the Server Configuration Guide.
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Email Buttons
Once the feature has been enabled, incoming calls that are not answered will cause a button to be added to the subject line 
in the email header of your client.

For calls where the contact leaves a voice message in the mailbox, a View button will appear beside the message. 

If the caller did not get an answer and chose not leave a message, then the Dial button will appear.

Dial 
The Dial button will start the iLink dialer and place a telephone call to the contact using the currently selected device.

View 
Clicking the View button will open a window where the voice message in the inbox can be played back over any audio 
enabled device. If licensed, the transcription of the message will also be included in the playback window.

Play 

Choose Play to have the voice message converted to MP3 format and played through the browser.

<Back to View>

 Note: In the examples that follow, when initiating a telephone call to the contact, the device currently 
selected is used. The current device is defined within your location setup. For example, if your current 
location is Mobile, the call will ring on the device configured for that location (i.e. a cell phone). If you are 
In Office, your desktop phone may be used instead.

Transcription license required
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Stream 

Choose Stream when the browser player does not support the MP3 format, or if a different format is preferred. 

The audio file will be played using an appropriate viewer, using the Voice Format specified in OL Admin on the 
Mailbox > Message Options tab under Add/Edit.

Phone 

Select this option to playback the message on the current default telephone device. The device will ring, and playback will 
begin through the handset/speaker.

Google+ Hangout 

Click on Google+ Hangout to create a video call in the default browser. Enter the contact’s name or number into the space 
provided to start the event. Click Invite to send an invitation to join the hangout to the contact’s Google+ account. The 
contact must be logged in to their account to receive the invitation.
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Google+ Share 

Choosing Google+ Share allows the user to share the message with others through their Google+ account.

Enter a comment and the contacts to share the file with. Click Share when ready.

Twitter 

The Tweet button allows the user to share the audio file with their Twitter followers.
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iLink Dialer 

iLink Dialer opens a log displaying all calls made to and from the mailbox. Details include the caller’s extension or phone 
number, the caller’s name, and the time, date and length of the call. 

Click on a contact or their number to open their popup card. In window, click the contact’s number to place a call. Your 
default telephone device will ring, and you will be connected to the contact.

iLink Messages 

iLink Messages opens a list of voice messages left in the mailbox. Details include the name of the contact who left the 
message, their number or extension, and the date and time the message was received. 

Click on an item to playback the message.
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Contact Location

In various places through the window, moving the mouser over the contact’s name will open a new window which shows their 
current location in Google Maps, if they have the Geo Location option enabled. There are also icons to contact them through 
email or telephone.

Mail: Opens an email client program to compose and send an email message to the contact.
Call: Places a telephone call to the contact. Your desktop telephone will ring, and you will be connected with the contact 
once they answer.
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Office Communication Server Integration
Introduction
Officelinx is able to seamlessly integrate with Office Communication Server environments to offer full telephony functionality 
alongside the other features available within Officelinx such as Unified Messaging.

Instead of connecting the OCS directly to your PBX, you will be able to connect to the Officelinx server, allowing you to take 
advantage of features such as auto attendant or the comprehensive voicemail system without having to change your 
organization’s end-user application experience.

Visual Guide

Requirements

 Note: Setting DND is not supported both ways with OCS 2007 R2. Setting forwarding works only from OCS to 
telephone, not vice versa.

Requirements Details

License OCS License for Officelinx

Software Officelinx version 8.x or higher
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Server Configuration
Server side configuration for OCS integration involves both OCS and Officelinx. After you have configured the servers, you 
must also enable the functionality for each user.

Configuring OCS
1. To start the configuration for OCS integration, open the OCS admin program.

2. Open the Front End Properties of the OCS server.

3. From the Routing tab, add a new entry to specify the route. 

Click on the Add... button.
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4. Enter the following information:

Domain: Enter uc.test.
Enable IP address. Enter the IP address of your voice server.
Transport: Select TCP from the dropdown menu.
Port: Enter 5065 as the port used by the voice server.

Click OK to save your settings.

5. The entry will appear on the list. 

Go to the Host Authorization tab.

6. Click on Add... to create a new entry.

7. Enter the following information:

Enable IP address. Enter the IP address of the voice server.
Enable Throttle As Server and Treat As Authenticated.

Click OK when finished.
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8. Click OK to accept your changes and close the window.

Adding Permissions for Users
In order for users to access the OCS client software, each must have permissions assigned. 

1. In OCS Administrator, open the list of users. Right-click on the desired user then click Properties.

2. From the properties window, enable
Enable user for Office Communications Server. 

Click on the Configure button under Additional options.
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3. From User Options, select Enable Remote call control. Enter the 
following information:

Server URI: sip:rcc@uc.test
Line URI: tel:xxx    (this user’s extension number)

4. Ensure that all checkboxes under Federation are enabled. 

5. Click OK to save the settings.

Repeat this process for all users who will be utilizing OCS.

Configuring Officelinx
Ensure that you have the necessary license for OCS integration.

1. Open the OL Admin console and go to 
Configuration > Device Management Settings > CTI Settings. 

2. Enable the SIP CSTA checkbox then enter the port which will be used for 
communications between Officelinx and OCS. 
By default, this port value is 5065 but may be changed depending on the OCS 
configuration.

Click OK.

3. Restart both the Officelinx and OCS servers for the new settings to take 
effect.
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User Guide
Officelinx integration with OCS allows you to utilize Unified Messaging without having to change your client end software. You 
will be able to access all of your call related features from the OCS client application so that no transition to a new 
environment is necessary.

Call Control Through OCS
When you log into the OCS client, you will see the telephone icon in the top right corner 
of the user interface. This indicates that you have call related capabilities through the 
OCS client.

Initiating a Call

To call a contact through the OCS client, double-click on a contact within the application, 
then click on the telephone icon located on the top left corner of the conversation screen. 
OCS will automatically initiate a call to the contact you have chosen through your 
integrated workstation telephone.

When the contact answers the call, your call status will change to connected. 
From here, you can control the call from the conversation window. 
The following call related commands are available:

Hangup Call: Terminate the current ongoing call.

Hold Call: Put the caller on hold.

Transfer Call: Transfer the current call to another extension or number.

Hold Call

When a call is placed on hold, the call control icons change to Resume call. This also 
displays how long the call has been on hold. 
To resume the call, click the Resume call bar.

Transfer Call

To transfer a call, click the Transfer call icon. Then select Another Person... to choose the 
destination.

From the selection window you have two options:

 You can manually enter the number to transfer to. On the text field provided at the top, enter 
the number you wish to transfer the call to then click on the telephone icon to the right.

 Select a contact from your group. If you find yourself transferring a call frequently to 
someone, add them to one of your personal groups and you will be able to select them as the 
transfer destination with a click of a button.

Incoming Calls

When you receive an incoming call, you will see a popup window in the right-hand bottom corner of the computer screen. To 
answer the call, click on the telephone icon to the left. The call controls are identical for both outgoing and incoming calls.
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Nuance Transcription Service
Introduction
The Transcription feature allows users to receive text output from voice messages. The transcribed voice message is 
delivered to the user in the body of an email.

Transcription is not part of the standard Officelinx license. It must be purchased separately. Licenses for the Nuance 
Transcription Service are available through Esna. 

Visual Guide

When a voice message arrives on the voice server, the message is sent to the Nuance transcription server. The message is 
then returned to the voice server once the transcription has been completed. The voice and text messages are combined and 
delivered to the user’s mailbox.

Requirements

 A Nuance transcription service subscription.

 Must have Enabled SSL on the IIS using a Secure Certificate Key. Please refer to the IIS/SSL document located in 
Officelinx Server Configuration Guide’s Security chapter.

 Internet access for Officelinx server. This can be an external IP address, or a Domain Name providing access directly or 
through proxy to the Officelinx server.

 Hint: Transcribing a voice message will take some time depending upon the length of the message and the amount 
of traffic on the servers. If receiving a voice message immediately is critical for a user, it is recommended either 
that transcription is turned off for that user, or that time out settings are configured to ensure messages are 
delivered within an acceptable time limit.

Requirements Details

License Nuance Subscription available from Esna

Software Officelinx version 8.1 or higher

A voice message is 
left on the 

Officelinx server.

The voice message is 
converted into text by 

the Nuance 
Transcription Service.

Message is uploaded to 
the Nuance server 
via the internet.

Transcribed message is downloaded 
to the Officelinx server 

via the internet.Text transcription of the 
voice message is delivered 
as an email with the voice 
message included as an 
audio file attachment.
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Licensing
The transcription feature is not included with the standard Officelinx license but is available as an option from Esna. These 
instructions are only required if a Nuance transcription license is purchased after Officelinx is installed and configured.

Once you have purchased a license, it must be activated through the UC License Upgrade Utility. The service must then be 
configured through the Transcription Configuration Tool.

Upgrading the License
If Officelinx has already been installed and setup on a server, add a transcription license by following these steps.

1. On the Officelinx server, go to Start > All Programs > Officelinx > UCLicenseUpgrade.
2. The License Upgrade Utility screen appears. Click Upgrade.

3. The Serial Number and Site ID will already be entered. If not, enter the data manually:
Serial Number: Enter the serial number for your Officelinx license.
Site ID: Enter the site ID for your location.
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Both of these items are provided by Esna as part of the initial Officelinx license package.

4. Click Request Online Activation.
5. The license will be updated from Esna’s online license server to include the latest features. 


Click Set as Active License. 

6. Your Nuance transcription license is activated.

Click OK to continue and configure of the service.
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Officelinx Server Configuration
Once you have added the transcription license, you must configure Officelinx to communicate with the Nuance servers over 
the internet.

Transcription Configuration Tool
1. On the Officelinx server, go to Start > All Programs > Officelinx > UCTranscriptionConfig.
2. Enter all required information. 













3. Click Language Options. Specify the regional variation for each required language.

4. Click OK when finished.

 Note: The settings made here are system wide, applying to all accounts on all companies.

 Note: Step 3 applies only to installations using the Nuance Multilingual Transcription Service.
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Save Voice Messages as Text

Enable this checkbox to have the system mark voice messages as text messages after transcription. Leaving this unchecked 
will have the messages marked as voicemail in your mailbox once transcribed.

Transcribe Urgent Messages

Disable this checkbox to exclude messages flagged as Urgent from the transcription service. Transcribing a message can take 
several minutes so this option allows urgent messages to be delivered immediately without transcription.

Call Back URL

This is the externally accessible URL of your Officelinx Voicemail server to which Nuance will send completed transcriptions. 
You can configure your DNS and change “YourCompanyUrl” only (i.e. from “https://YourCompanyUrl/uc/webtranscribe/
WebTranscribeclass.asp” you only need to change “YourCompnayUrl”) since the virtual folders and the transcription receiver 
applications are automatically setup.

Number of Minutes to Hold Voice Messages for Transcription

Voice messages for selected mailboxes are put on hold until the transcription is returned from Nuance. This value (in 
minutes) tells the system when to give up waiting for a transcription and deliver the message as voice only. The default value 
is 15 minutes.

Language Options / Map Languages

Nuance supports many regional variations within a language. Differences due to accent, pacing and word selection can be 
compensated for by choosing the appropriate variation from the dropdown lists.
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Nuance Server Configuration Requirements
In order for the Nuance servers to properly receive and reply to transcription requests, the customer must provide certain 
information regarding the setup of their computer network. This information must be provided before the transcription 
service can be used. Your sales associate will collect this information when the license is purchased.

The information required is listed in the following table.

The customer’s network administrator must ensure that all of the necessary changes have been made to network security 
systems (i.e. firewall, antivirus) to permit this communication. The stated ports and addresses must be opened for both 
outbound and inbound traffic.

Item Details Description

Customer request 
source IP address

(e.g. 11.22.33.44) This is the IP address from which (source) the 
customer will send transcription requests to 
Nuance.

Nuance request 
target IP address:Port

(e.g. 98.765.432.100:8621) This is the IP address and port to which (target) the 
customer will send transcription requests to 
Nuance.

Customer 
Result URL 
(Call Back URL):Port
(default Nuance port is 
80 or 443)

(e.g. http://12.34.56.789:80/
NuanceResult)

This is the customer URL (Call Back URL) and port 
to which Nuance will send the completed 
transcription requests. 
 
Note: If the customer wants to use ports other 
than 80 and 443, Esna must be informed so that the 
corresponding changes can be applied to the 
transcription server.

Nuance 
Result IP address:Port
(not required for  Nuance 
Multi-Lingual install)

(e.g. 99.888.777.100:80) This is the URL and port from which Nuance will 
send the completed transcription requests back to 
the customer.

Special requests (e.g. https using self-signed 
certificates from IP:port)

Include any special requests from the customer 
such as the use of https, self-signed certificates, 
ssl, etc.   Otherwise, Nuance will use default port 
8X21 to create inbound URL into Nuance .

Type of Service (e.g. Fully Automated) Specify the type of transcription service desired: 
fully automated (computer based), semi-automated 
(with some human assistance), other.

Nuance Operator ID (e.g. CUST-VM2T) Customer ID to be used for the new tenant or type 
of service.

Customer prefix for 
session ID's

(e.g. CUST-xxxxx-yyyyy-zzzz) Customer should use a unique string like 
“Customer-XXXX” for session ID’s.
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Verification
Once all of the information has been collected and the network adjustments made, the connection between the customer’s 
network and the Nuance transcription server should be tested by sending a service request through Officelinx and waiting for 
the response. Any issues or unusual delays must be reported immediately so that the situation can be resolved.

User Guide
When a new voice message is received:

1. The system checks if the mailbox has transcription enabled.
2. If so, it uses the UCTranscribeUploader service to submit the voice file for transcription. The Callback URL is also sent 

to allow the Nuance server to reply with the results.

3. Once the transcription is complete, the Nuance server will use the Callback URL to return the results to the UC system. 
The transcribed text will be the body of an email with the original voice message included as an audio attachment.

4. The combined message is delivered to the user’s mailbox.

 Note: The original message is put on hold for an amount of time defined by your administrator. The 
default value is 15 minutes. This means that the UC system will send the message to the transcription 
service and then wait for a maximum of 15 minutes for a response. If the message has not been 
returned in that time, the process will time out and a regular voice message will be sent to the mailbox. 
You should be aware of the delay so that no problems arise from it.
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Exchange 2013 Integration
Introduction
Officelinx and an Exchange server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. Once the configuration is complete the servers communicate and synchronize all data among themselves, 
eliminating the need for you to constantly manage multiple locations.

Each user’s Exchange credentials are stored within the Officelinx mailbox, allowing the server to synchronize messages to 
and from the Exchange server. End users can manage their credentials through the Web Access. Administrators may also 
manage credentials from the admin console.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

Administrators can also customize what will be synchronized. A full synch includes contact and calendar entries along with 
messages. If the system has telephone and message light integration, MWI (message waiting lights) will also remain 
accurate since the status of messages are synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 9.0 or higher
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Server Configuration
Server configuration requires the creation of a superuser account from the active directory that has the necessary 
permissions within the Exchange console. Once the account has been made, it must be added to the voice server 
configuration, and the channel of communication between the two servers must be established.

Exchange server must also have IMAP enabled in order for Officelinx to communicate properly. Once the superuser account is 
ready, enable IMAP for your Exchange server through the command shell.

Exchange 2013 superuser Creation/Configuration
Once the superuser account is ready on Active Directory, create a mailbox for that user in the Exchange 2013 environment.

1. Open a web browser and go to the Exchange 2013 Admin Center.

Under recipients > mailboxes, click the + symbol to add a new user.

2. At the new user mailbox page, on the general tab, fill in the account details in the spaces provided. 

Remember the Alias for the account (Superuser in this example) as that will be used later in the setup.
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3. On the mailbox features tab, ensure that IMAP and MAPI are both Enabled.

4. At the Command Prompt, run the following command line to attach the necessary permissions to the Superuser account. 
Include the alias recorded earlier as a part of the command:

Get-Mailbox | Add-MailboxPermission -User Superuser -AccessRights FullAccess -InheritanceType All

5. To verify the correct setup for the Superuser account, open any other account and go to the mailbox delegation tab.

Ensure that the alias for the Superuser account is included beneath the listing for Full Access.
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6. From the Exchange 2013 Admin Center, go to Servers and open Exchange 2013.

7. Choose IMAP 4. Click More Options, and scroll down to find Maximum connections from a single user.
Set this value to 2000.
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8. Open the Windows Server Manager MMC to view the system Services. 

Set both of the IMAP4 services to use Automatic Startup.

If these services are still running, shut them down and restart them for the changes to take affect. Otherwise, Restart 
both services.

9. The UC CSE PIM Synchronization Engine service must login and run with the Superuser credentials.

Open the Computer Management console and select Services.

10. Stop the UC CSE PIM Synchronization Engine service. 
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11. Right-click the service and select Properties. 
Go to the Log On tab, and enable This Account.
Enter the username and password for the superuser account in the spaces provided.

Click Apply and OK when finished.
12. Restart the service.
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OL Admin Configuration
For Officelinx and Exchange to be able to synchronize data, Officelinx must be able to communicate with the Exchange server 
using the correct credentials. The superuser account streamlines this process while still enforcing individual password 
security protocols on each mailbox.

Adding the TSE Endpoint

In order for the Officelinx server to recognize the Exchange server, you must add a new TSE 
Endpoint entry in the OL Admin > TSE IMAP Server section.

IMAP Server Name: This name is for your reference and does impact system performance.

IMAP Server Address: Enter the server address of the Exchange server.

IMAP Server Port: The port number of the Exchange server. By default, IMAP uses port 143.

Voice Format: From the dropdown menu, select the voice format used when sending voice 
messages to external voice servers.

IMAP Server Domain: Enter the Domain address of the IMAP server. Since it is possible to 
define the IMAP Server Address using an IP address, the Domain address entered here is used to 
verify the Reply to address of a mailbox using IMAP TSE synchronization, preventing typical message looping scenarios.

Individual Mailbox Configuration

With the superuser account, you do not have to fully enter the individual 
mailbox credentials for IMAPTSE synchronization. 

Enable Use Feature Group settings for IMAP then enter the 
User Name (this will be the alias for the Exchange account that the 
current mailbox will be synchronized with).

Assign the mailbox to the Feature Group that is going to have the 
superuser account credentials.

Save all changes and move onto Feature Group Configuration.

 Note: The user must be a Unified Communications or 
Advanced Unified Messaging user to utilize synchronization. 
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Feature Group Configuration

The Feature Group plays a key role in IMAPTSE synchronization by 
providing the necessary credentials. From the Synchronization Options 
tab, configure the settings as follows:

IMAP Account: Enter the account name for the superuser. The typical 
format will be domain\super_user_name.

Account Password: Enter the password of the superuser account.

Confirm Password: Re-enter the password.

IMAP Server: Select the TSE Endpoint created in the previous steps.

Save all changes and proceed to Registry Settings.

13. Test the connection to verify the work this far. Launch the IMAP Tester utility from Start > Officelinx.
Double-click on the Superuser account to open the IMAP Settings window.

14. Click Verify to run the test.
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15. If successful, the result will include the entry for OK LOGIN completed.

Registry Settings

In order for Officelinx to manage communications with the Exchange server, you must 
manually add a registry value on the Officelinx server. Run the registry editor by typing 
regedit from the Run command.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Generic\UMS\IMAPTSE\Cache. 
Create a new DWORD Value entry in this location.

Name the entry DefaultExchangeVersion and assign it a value of 8.

The new registry entry will appear in the Registry. 

Proceed with Certificate Configuration.
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Certificate Configuration

In order to ensure that the communication between Officelinx and the Exchange server is not interrupted by security 
measures, install the certificate from the Exchange server computer on the Officelinx server.

The simplest way to achieve this is to access the OWA (Outlook Web Access) web page of the Exchange server.

1. Open the Internet Explorer web browser, then navigate to the OWA page 
(e.g. https://exchange_2013/owa). 

You will see the following security warning popup. 

Click on View Certificate.

2. Click on Install Certificate to launch to certificate wizard.

3. Click Next.

 Note: This procedure may vary depending on the way in which you have the domain servers configured. The 
goal of this process is to add the Exchange server as a trusted PC on the Officelinx server computer, 
which can be accomplished manually by the system administrator.

I Caution: For all certificates, always ensure that you are on the 
proper web page, and confirm the issuer of the certificate for 
security purposes before proceeding with the installation.
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4. Enable Automatically select the certificate store based on the 
type of certificate then click Next.

5. Confirm that the information is correct, then click Finish.

6. The following popup confirms the import was successful. 

Click OK.

7. You will be able to confirm the status of the certificate through this window.

8. Depending on the security settings on the system, you may 
also see the following warning popup. 

Click Yes to accept the certificate in this case.

The certificate configuration is now complete. Restart the servers 
to ensure that the services are properly initialized.

 Note: Ensure that the domain server is also certified, not just the 
Exchange server.
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Contact and Calendar Sync
Once you have configured the IMAP TSE server with your mail server, you will be able to select the degree of synchronization 
from the Feature Group. Ensure that you verify all of the information so that users do not lose any calendar, contact or 
message data during synchronization.

Windows Configuration

The Superuser account must be configured as a local administrator on the voice server computer. It must also be set to run 
the UC TSE Cache Manager service. 

1. Ensure that the Superuser account created has the proper permissions on the Windows environment.

2. From Windows Server Manager > Services, double-click on the UC TSE Cache Manager service in the right-hand 
pane.

On the Log On tab, enable the This account button and enter the credentials for the superuser account in the spaces 
provided. 

The typical format will be domain\super_user_name.

 Warning: As a precaution, backup the calendar and/or contact events of your users before proceeding with 
the contact and calendar synchronization.

 Note: If you did not install the Exchange MAPI component during the initial Officelinx installation, you must do 
so manually now by running the ExchangeMapiCdo.msi file from MSExchange folder on Officelinx installation 
DVD. This is a required component for contact and calendar synchronization.
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Officelinx Configuration - Feature Group

Feature Group configuration requires changes on two tabs; Synchronization Options and Mailbox Option. You can define 
exactly what is going to be synchronized for the users from these two sections.

From the Synchronization Options tab, you can specify which messages 
are going to be synchronized between the servers. 

Enable Contacts if you wish to enable contact synchronization between 
the two servers.

To enable calendar synchronization, select Mail Server from the 
Calendar Mode dropdown menu.

The other fields, such as Inbox Folder, are used for message 
synchronization between the servers. Refer to the message integration 
section for details.

From the Mailbox Options tab, enable Change Location to allow an 
event on the mail server calendar to automatically change the UC location 
of the user.

By customizing these settings you can easily segregate calendar and 
contact synchronization along with message synchronization when enabling features for your users, allowing you to control 
exactly who has access to certain features.

Mail Server
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User Guide
Once calendar and contact synchronization has been enabled, all transactions occur on the server in the background, so you 
do not have to configure anything on your own. Use your mail server as you normally would, and any calendar or contact 
entries will now be mirrored in your Officelinx mailbox as well. 

The following is typical behavior for synchronization so that you can understand exactly how your calendar and contact 
entries are being handled by the servers.

Calendar Synchronization
When you create a calendar entry in Outlook, or most other email 
programs, the same entry will appear in your Officelinx mailbox.

The time and date of the meeting is automatically sent to the 
Officelinx mailbox. By default, the location for these events will be 
marked as Meeting. You may change this manually through Web 
Access, or in the case of Outlook, you may utilize the iLink Pro 
Desktop tool bar to assign a specific location to the event.

Contact Synchronization
When you create a contact entry from Outlook, the entry will be copied into your 
Officelinx mailbox.

Contact information is automatically sent to the Officelinx mailbox.

MS Exchange Performance Considerations
Microsoft (http://support.microsoft.com/kb/905803) advises that a large numbers of items in folders can decrease the 
speed of operations in Exchange. This table shows the maximum number of files recommended per folder for optimum server 
performance.

 Note: All of the calendar events and contacts from your mail server will be copied into your Officelinx mailbox as 
soon as the administrator finishes configuring the systems.

 Note: Backup your calendar events and contacts periodically as a precaution.

I Caution: Deleting contacts is also synchronized. If you delete an entry from Outlook, it will also be deleted 
from Officelinx, and vice versa.

Items in Folder Exchange 2003 Exchange 2007 Exchange 2003

Messages
<5000 combined

<20000 <100000

Contact and Calendar Entries <5000 <10000
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Exchange 2010 Integration
Introduction
Officelinx and an Exchange server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. Once the configuration is complete the servers communicate and synchronize all data among themselves, 
eliminating the need for you to constantly manage multiple locations.

Each user’s Exchange credentials are stored within the Officelinx mailbox, allowing the server to synchronize messages to 
and from the Exchange server. End users can manage their credentials through the Web Access. Administrators may also 
manage credentials from the admin console.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

Administrators can also customize what will be synchronized. A full synch includes contact and calendar entries along with 
messages. If the system has telephone and message light integration, MWI (message waiting lights) will also remain 
accurate since the status of messages are synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
Server configuration requires the creation of a superuser account from the active directory that has the necessary 
permissions within the Exchange console. Once the account has been made, it must be added to the voice server 
configuration, and the channel of communication between the two servers must be established.

Exchange server must also have IMAP enabled in order for Officelinx to communicate properly. Once the superuser account is 
ready, enable IMAP for your Exchange server through the command shell.

Creating a superuser from Active Directory
A new user account must be created before it can be setup as a superuser with the necessary access privileges.

1. From the active directory, create a new user. 
The user name can be anything. 
For this guide, we will be using “super_user” as the user name and “perf.local” 
as the domain within which Exchange 2010 is installed. 

2. Ensure that Password never expires is enabled. 

Since this password is applied to the Feature Group, an expired password 
means that all mailbox accounts associated with that Feature Group will not 
be synchronized until the password is reset.

3. Confirm the information then click Finish to add the user.

 Note: Change the domain and user name to match your 
network’s requirements.
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4. After the user is created, ensure that it is a member of a group with the 
necessary access. 

The correct group to join may vary from system to system, but the key is to 
ensure that this user has full administrative access to the Exchange server.

Proceed to the Exchange 2010 configuration after the superuser account is ready.
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Exchange 2010 superuser Creation/Configuration
Once the superuser account is ready on Active Directory, create a mailbox for that user in the Exchange 2010 environment.

1. Create a new User Mailbox mailbox from the 
Exchange 2010 Management Console.

2. When prompted, choose Existing User.
3. Click on the Add button. 


In the popup window, select the superuser account that was 
previously in the Active Directory. 

Click OK to add that account to the list of new mailboxes.

4. Click Next to continue.
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5. Select the correct database and change any other settings 
that are required by your system configuration.

6. Confirm the information then click New to create the 
mailbox.

7. The superuser account has been created. 

Click Finish to exit the wizard.
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8. In order for a superuser account to properly 
manage all messages, you must allow a 
higher number of connections than there 
are by default.

Open the IMAP4 Properties from the 
Client Access section.

9. From the Connection tab, set 
Maximum connections from a single user to 1000.

10. From the Retrieval Settings tab, set Message MIME format to Text. 

Click OK to save your changes.

Now that the superuser account is ready, prepare the Exchange 2010 server for 
integration and apply the correct administrative rights to the superuser account.
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11. The UC CSE PIM Synchronization Engine service must login and run with the Superuser credentials.

Open the Computer Management console and select Services.

12. Stop the UC CSE PIM Synchronization Engine service. 
13. Right-click the service and select Properties. 

Go to the Log On tab, and enable This Account.
Enter the username and password for the superuser account in the spaces provided.

Click Apply and OK when finished.
14. Restart the service.
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Exchange 2010 Shell Configuration
Since only simple actions are available through the GUI, continue the configuration through the Exchange Management Shell.

Configuring the IMAP server

All IMAP server settings may be viewed by typing the command:

Get-imapsettings

For integration with the IMAPTSE, you must execute this command to change the way in which logins are handled by IMAP.

Set-imapsettings<>–logintype<>PlaintextLogin

By default, the IMAP server daemon is disabled in Exchange 2010, so you must turn it on manually. You must configure the 
server so that the IMAP services are always started automatically for server restarts.

Set-service<>msExchangeIMAP4<>–startuptype<>automatic

Start the IMAP Service

Start–service<>msExchangeIMAP4

At this stage, the IMAP service will be running, and it will start each time the computer restarts.

To test this, open a command prompt (Windows prompt not Exchange Shell) and enter telnet<>serverIP<>143. You 
should see the banner reply. You may also verify the procedure by checking the status of the service.

 Note: <> represents a single space in the command.
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IMAP Enabling All Existing Mailboxes in a Store

If the mailboxes within your Exchange server do not have IMAP enabled, you can 
use the following commands to enable the feature for the mailboxes. You may 
confirm the status of the feature by opening the mailbox properties, then going to 
the Mailbox Features tab as shown here.

IMAP Enabling All Users

Get-mailbox<>|<>Set-CASMailbox<>–ImapEnabled:$true

This command gets each mailbox and pipes it into the Set-CASMailbox command 
sequentially.

IMAP Enabling a Single User

Use this command to individually enable IMAP on each user.

Set-CASMailbox<>%mailbox%<>–ImapEnabled:$true

The %mailbox% variable represents the mailbox account name for which you want to enable IMAP.

Configuring Permissions for the superuser Account

The following commands will give the superuser account permission to logon to all user’s mailboxes. There are two separate 
commands needed; type the first, hit enter, and then type the second.

In both cases, the %superuser% variable represents the domain and superuser account you have created in the previous 
steps. For example, if the superuser’s user name is SUPER_USER, and the domain is COMAPNY.COM, enter 
COMPANY\SUPER_USER in place of %superuser%.

Command 1

Get-Mailbox<>|<>Add-ADPermission<>-User<>'%superuser%'<>-ExtendedRights<>'Send-as'<>-
InheritanceType<>All

Command 2

Get-Mailbox<>|<>Add-MailboxPermission<>-User '%superuser%'<>-AccessRights<>'FullAccess'<>-
InheritanceType<>All

This is the last configuration step required on the Exchange 2010 server and you are ready to move on to the Officelinx 
configuration. 

 Note: All mailbox accounts that require IMAPTSE synchronization must 
have IMAP enabled under Exchange.
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IMAP Enable a New Mailbox

Set-CASMailbox<>%mailbox%<>–ImapEnabled:$true

Run a Modified Version of Command 2 Without the Pipeswitch

add-mailboxpermission<>-identity%mailbox%<>-User '%superuser%'<>-
AccessRights<>'FullAccess'<>-InheritanceType<>All

You can confirm the access rights for the superuser account by 
opening the Manage Full Access Permission panel. The 
superuser account name should be listed.

A More Secure Solution

Command 1 and 2 (above) provide full access for the superuser to the entire store drive. Instead, you can use these 
commands to limit access to just the MSExchange stores:

Get-MailboxDatabase | Add-ADPermission -User '%superuser%' -AccessRights ExtendedRight -ExtendedRights 
Receive-As, ms-Exch-Store-Admin

 Note: If you add new mailbox accounts to the Exchange server after this point, you must enable those accounts 
for IMAP manually as well. To do this, use the following commands.

 Note: If a new mailbox database is created for Microsoft Exchange, you must re-enter this command so that the 
new file is given the correct user access rights.
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OL Admin Configuration
For Officelinx and Exchange to be able to synchronize data, Officelinx must be able to communicate with the Exchange server 
using the correct credentials. The superuser account streamlines this process while still enforcing individual password 
security protocols on each mailbox.

Adding the TSE Endpoint

In order for the Officelinx server to recognize the Exchange server, you must add a new TSE 
Endpoint entry in the OL Admin > TSE IMAP Server section.

IMAP Server Name: This name is for your reference and does impact system performance.

IMAP Server Address: Enter the server address of the Exchange server.

IMAP Server Port: The port number of the Exchange server. By default, IMAP uses port 143.

Voice Format: From the dropdown menu, select the voice format used when sending voice 
messages to external voice servers.

IMAP Server Domain: Enter the Domain address of the IMAP server. Since it is possible to 
define the IMAP Server Address using an IP address, the Domain address entered here is used to 
verify the Reply to address of a mailbox using IMAP TSE synchronization, preventing typical message looping scenarios.

Individual Mailbox Configuration

With the superuser account, you do not have to fully enter the individual 
mailbox credentials for IMAPTSE synchronization. 

Enable Use Feature Group settings for IMAP then enter the 
User Name (this will be the alias for the Exchange account that the 
current mailbox will be synchronized with) and leave the User Password 
and IMAP Server fields empty.

Assign the mailbox to the Feature Group that is going to have the 
superuser account credentials.

Save all changes and move onto Feature Group Configuration.

 Note: The user must be a Unified Communications or 
Advanced Unified Messaging user to utilize synchronization. 



144 Officelinx Feature Description Guide



Exchange 2010 Integration
Feature Group Configuration

The Feature Group plays a key role in IMAPTSE synchronization by 
providing the necessary credentials. From the Synchronization Options 
tab, configure the settings as follows:

IMAP Account: Enter the account name for the superuser. The typical 
format will be domain/super_user_name.

Account Password: Enter the password of the superuser account.

Confirm Password: Re-enter the password.

IMAP Server: Select the TSE Endpoint created in the previous steps.

Save all changes and proceed to Registry Settings.

Registry Settings

In order for Officelinx to manage communications with the Exchange server, you must 
manually add a registry value on the Officelinx server. Run the registry editor by typing 
regedit from the Run command.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Generic\UMS\IMAPTSE\Cache. 
Create a new DWORD Value entry in this location.

Name the entry DefaultExchangeVersion and assign it a value of 8.

The new registry entry will appear in the Registry. 

Proceed with Certificate Configuration.

PERF/super_user

********

********

Exchange
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Certificate Configuration

In order to ensure that the communication between Officelinx and the Exchange server is not interrupted by security 
measures, install the certificate from the Exchange server computer on the Officelinx server.

The simplest way to achieve this is to access the OWA (Outlook Web Access) web page of the Exchange server.

1. Open the Internet Explorer web browser, then navigate to the OWA page 
(e.g. https://exchange_2010/owa). 

You will see the following security warning popup. 

Click on View Certificate.

2. Click on Install Certificate to launch to certificate wizard.

3. Click Next.

 Note: This procedure may vary depending on the way in which you have the domain servers configured. The 
goal of this process is to add the Exchange server as a trusted PC on the Officelinx server computer, 
which can be accomplished manually by the system administrator.

I Caution: For all certificates, always ensure that you are on the 
proper web page, and confirm the issuer of the certificate for 
security purposes before proceeding with the installation.
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4. Enable Automatically select the certificate store based on the 
type of certificate then click Next.

5. Confirm that the information is correct, then click Finish.

6. The following popup confirms the import was successful. 

Click OK.

7. You will be able to confirm the status of the certificate through this window.

8. Depending on the security settings on the system, you may 
also see the following warning popup. 

Click Yes to accept the certificate in this case.

The certificate configuration is now complete. Restart the servers 
to ensure that the services are properly initialized.

 Note: Ensure that the domain server is also certified, not just the 
Exchange server.
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Contact and Calendar Sync
Once you have configured the IMAP TSE server with your mail server, you will be able to select the degree of synchronization 
from the Feature Group. Ensure that you verify all of the information so that users do not lose any calendar, contact or 
message data during synchronization.

Feature Group

Feature Group configuration requires changes on two tabs; Synchronization Options and Mailbox Option. You can define 
exactly what is going to be synchronized for the users from these two sections.

From the Synchronization Options tab, you can specify which messages 
are going to be synchronized between the servers. 

Enable Contacts if you wish to enable contact synchronization between 
the two servers.

To enable calendar synchronization, select Mail Server from the 
Calendar Mode dropdown menu.

The other fields, such as Inbox Folder, are used for message 
synchronization between the servers. Refer to the message integration 
section for details.

From the Mailbox Options tab, enable Change Location to allow an 
event on the mail server calendar to automatically change the UC location 
of the user.

By customizing these settings you can easily segregate calendar and 
contact synchronization along with message synchronization when enabling features for your users, allowing you to control 
exactly who has access to certain features.

 Warning: As a precaution, backup the calendar and/or contact events of your users before proceeding with 
the contact and calendar synchronization.

 Note: If you did not install the Exchange MAPI component during the initial Officelinx installation, you must do 
so manually now by running the ExchangeMapiCdo.msi file from MSExchange folder on Officelinx installation 
DVD. This is a required component for contact and calendar synchronization.

Mail Server
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User Guide
Once calendar and contact synchronization has been enabled, all transactions occur on the server in the background, so you 
do not have to configure anything on your own. Use your mail server as you normally would, and any calendar or contact 
entries will now be mirrored in your Officelinx mailbox as well. 

The following is typical behavior for synchronization so that you can understand exactly how your calendar and contact 
entries are being handled by the servers.

Calendar Synchronization
When you create a calendar entry in Outlook, or most other email 
programs, the same entry will appear in your Officelinx mailbox.

The time and date of the meeting is automatically sent to the 
Officelinx mailbox. By default, the location for these events will be 
marked as Meeting. You may change this manually through Web 
Access, or in the case of Outlook, you may utilize the iLink Pro 
Desktop tool bar to assign a specific location to the event.

Contact Synchronization
When you create a contact entry from Outlook, the entry will be copied into your 
Officelinx mailbox.

Contact information is automatically sent to the Officelinx mailbox.

MS Exchange Performance Considerations
Microsoft (http://support.microsoft.com/kb/905803) advises that a large numbers of items in folders can decrease the 
speed of operations in Exchange. This table shows the maximum number of files recommended per folder for optimum server 
performance.

 Note: All of the calendar events and contacts from your mail server will be copied into your Officelinx mailbox as 
soon as the administrator finishes configuring the systems.

 Note: Backup your calendar events and contacts periodically as a precaution.

I Caution: Deleting contacts is also synchronized. If you delete an entry from Outlook, it will also be deleted 
from Officelinx, and vice versa.

Items in Folder Exchange 2003 Exchange 2007 Exchange 2003

Messages
<5000 combined

<20000 <100000

Contact and Calendar Entries <5000 <10000
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Exchange 2007 Integration
Introduction
Officelinx and an Exchange server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. Once the configuration is complete the servers communicate and synchronize all data among themselves, 
eliminating the need for you to constantly manage multiple locations.

Each user’s Exchange credentials are stored within the Officelinx mailbox, allowing the server to synchronize messages to 
and from the Exchange server. End users can manage their credentials through the Web Access. Administrators may also 
manage credentials from the admin console.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

Administrators can also customize what will be synchronized. A full synch includes contact and calendar entries along with 
messages. If the system has telephone and message light integration, MWI (message waiting lights) will also remain 
accurate since the status of messages are synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
Server configuration requires the creation of a superuser account from the active directory that has the necessary 
permissions within the Exchange console. Once the account has been made, it must be added to the voice server 
configuration, and the channel of communication between the two servers must be established.

Exchange server must also have IMAP enabled in order for Officelinx to communicate properly. Once the superuser account is 
ready, enable IMAP for your Exchange server through the command shell.

Creating a superuser from Active Directory
A new user account must be created before it can be setup as a superuser with the necessary access privileges.

1. From the active directory, create a new user. 
The user name can be anything. 
For this guide, we will be using “super_user” as the user name and “perf.local” 
as the domain within which Exchange 2007 is installed. 

2. Ensure that Password never expires is enabled. 

Since this password is applied to the Feature Group, an expired password 
means that all mailbox accounts associated with that Feature Group will not 
be synchronized until the password is reset.

3. Confirm the information then click Finish to add the user.

 Note: It is highly recommended that you upgrade Exchange Server 2007 to Service Pack 2.

 Note: Change the domain and user name to match your 
network’s requirements.
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4. After the user is created, ensure that it is a member of a group with the 
necessary access. 

The correct group to join may vary from system to system, but the key is to 
ensure that this user has full administrative access to the Exchange server.

Proceed to the Exchange 2007 configuration after the superuser account is ready.
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Exchange 2007 superuser Creation/Configuration
Once the superuser account is ready on Active Directory, create a mailbox for that user in the Exchange 2007 environment.

1. Create a new User Mailbox mailbox from the 
Exchange 2007 Management Console.

2. When prompted, choose Existing User.
3. Click on the Add button. 


In the popup window, select the superuser account that was 
previously in the Active Directory. 

Click OK to add that account to the list of new mailboxes.

4. Click Next to continue.
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5. Select the correct database and change any other settings 
that are required by your system configuration.

6. Confirm the information then click New to create the 
mailbox.

7. The superuser account has been created. 

Click Finish to exit the wizard.
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8. In order for a superuser account to properly 
manage all messages, you must allow a 
higher number of connections than there 
are by default.

Open the IMAP4 Properties from the 
Client Access section.

9. From the Connection tab, set 
Maximum connections from a single user to 1000.

10. From the Retrieval Settings tab, set Message MIME format to Text. 

Click OK to save your changes.

Now that the superuser account is ready, prepare the Exchange 2007 server for 
integration and apply the correct administrative rights to the superuser account.
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11. The UC CSE PIM Synchronization Engine service must login and run with the Superuser credentials.

Open the Computer Management console and select Services.

12. Stop the UC CSE PIM Synchronization Engine service. 
13. Right-click the service and select Properties. 

Go to the Log On tab, and enable This Account.
Enter the username and password for the superuser account in the spaces provided.

Click Apply and OK when finished.
14. Restart the service.
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Exchange 2007 Shell Configuration
Since only simple actions are available through the GUI, continue the configuration through the Exchange Management Shell.

Configuring the IMAP server

All IMAP server settings may be viewed by typing the command:

Get-imapsettings

For integration with the IMAPTSE, you must execute this command to change the way in which logins are handled by IMAP.

Set-imapsettings<>–logintype<>PlaintextLogin

By default, the IMAP server daemon is disabled in Exchange 2010, so you must turn it on manually. You must configure the 
server so that the IMAP services are always started automatically for server restarts.

Set-service<>msExchangeIMAP4<>–startuptype<>automatic

Start the IMAP Service

Start–service<>msExchangeIMAP4

At this stage, the IMAP service will be running, and it will start each time the computer restarts.

To test this, open a command prompt (Windows prompt not Exchange Shell) and enter telnet<>serverIP<>143. You 
should see the banner reply. You may also verify the procedure by checking the status of the service.

 Note: <> represents a single space in the command.
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IMAP Enabling All Existing Mailboxes in a Store

If the mailboxes within your Exchange server do not have IMAP enabled, you can 
use the following commands to enable the feature for the mailboxes. You may 
confirm the status of the feature by opening the mailbox properties, then going to 
the Mailbox Features tab as shown here.

IMAP Enabling All Users

Get-mailbox<>|<>Set-CASMailbox<>–ImapEnabled:$true

This command gets each mailbox and pipes it into the Set-CASMailbox command 
sequentially.

IMAP Enabling a Single User

Use this command to individually enable IMAP on each user.

Set-CASMailbox<>%mailbox%<>–ImapEnabled:$true

The %mailbox% variable represents the mailbox account name for which you want to enable IMAP.

Configuring Permissions for the superuser Account

The following commands will give the superuser account permission to logon to all user’s mailboxes. There are two separate 
commands needed; type the first, hit enter, and then type the second.

In both cases, the %superuser% variable represents the domain and superuser account you have created in the previous 
steps. For example, if the superuser’s user name is SUPER_USER, and the domain is COMAPNY.COM, enter 
COMPANY\SUPER_USER in place of %superuser%.

Command 1

Get-Mailbox<>|<>Add-ADPermission<>-User<>'%superuser%'<>-ExtendedRights<>'Send-as'<>-
InheritanceType<>All

Command 2

Get-Mailbox<>|<>Add-MailboxPermission<>-User '%superuser%'<>-AccessRights<>'FullAccess'<>-
InheritanceType<>All

This is the last configuration step required on the Exchange 2007 server and you are ready to move on to the Officelinx 
configuration. 

 Note: All mailbox accounts that require IMAPTSE synchronization must 
have IMAP enabled under Exchange.
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IMAP Enable a New Mailbox

Set-CASMailbox<>%mailbox%<>–ImapEnabled:$true

Run a Modified Version of Command 2 Without the Pipeswitch

add-mailboxpermission<>-identity%mailbox%<>-User '%superuser%'<>-
AccessRights<>'FullAccess'<>-InheritanceType<>All

You can confirm the access rights for the superuser account by 
opening the Manage Full Access Permission panel. The 
superuser account name should be listed.

A More Secure Solution

Command 1 and 2 (above) provide full access for the superuser to the entire store drive. Instead, you can use these 
commands to limit access to just the MSExchange stores:

Get-MailboxDatabase | Add-ADPermission -User '%superuser%' -AccessRights ExtendedRight -ExtendedRights 
Receive-As, ms-Exch-Store-Admin

 Note: If you add new mailbox accounts to the Exchange server after this point, you must enable those accounts 
for IMAP manually as well. To do this, use the following commands.

 Note: If a new mailbox database is created for Microsoft Exchange, you must re-enter this command so that the 
new file is given the correct user access rights.
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OL Admin Configuration
For Officelinx and Exchange to be able to synchronize data, Officelinx must be able to communicate with the Exchange server 
using the correct credentials. The superuser account streamlines this process while still enforcing individual password 
security protocols on each mailbox.

Adding the TSE Endpoint

In order for the Officelinx server to recognize the Exchange server, you must add a new TSE 
Endpoint entry in the OL Admin > TSE IMAP Server section.

IMAP Server Name: This name is for your reference and does impact system performance.

IMAP Server Address: Enter the server address of the Exchange server.

IMAP Server Port: The port number of the Exchange server. By default, IMAP uses port 143.

Voice Format: From the dropdown menu, select the voice format used when sending voice 
messages to external voice servers.

IMAP Server Domain: Enter the Domain address of the IMAP server. Since it is possible to 
define the IMAP Server Address using an IP address, the Domain address entered here is used to 
verify the Reply to address of a mailbox using IMAP TSE synchronization, preventing typical message looping scenarios.

Individual Mailbox Configuration

With the superuser account, you do not have to fully enter the individual 
mailbox credentials for IMAPTSE synchronization. 

Enable Use Feature Group settings for IMAP then enter the 
User Name (this will be the alias for the Exchange account that the 
current mailbox will be synchronized with) and leave the User Password 
and IMAP Server fields empty.

Assign the mailbox to the Feature Group that is going to have the 
superuser account credentials.

Save all changes and move onto Feature Group Configuration.

 Note: The user must be a Unified Communications or 
Advanced Unified Messaging user to utilize synchronization. 
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Feature Group Configuration

The Feature Group plays a key role in IMAPTSE synchronization by 
providing the necessary credentials. From the Synchronization Options 
tab, configure the settings as follows:

IMAP Account: Enter the account name for the superuser. The typical 
format will be domain/super_user_name.

Account Password: Enter the password of the superuser account.

Confirm Password: Re-enter the password.

IMAP Server: Select the TSE Endpoint created in the previous steps.

Save all changes and proceed to Registry Settings.

Registry Settings

In order for Officelinx to manage communications with the Exchange server, you must 
manually add a registry value on the Officelinx server. Run the registry editor by typing 
regedit from the Run command.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Generic\UMS\IMAPTSE\Cache. 
Create a new DWORD Value entry in this location.

Name the entry DefaultExchangeVersion and assign it a value of 8.

The new registry entry will appear in the Registry. 

Proceed with Certificate Configuration.

PERF/super_user

********

********

Exchange
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Certificate Configuration

In order to ensure that the communication between Officelinx and the Exchange server is not interrupted by security 
measures, install the certificate from the Exchange server computer on the Officelinx server.

The simplest way to achieve this is to access the OWA (Outlook Web Access) web page of the Exchange server.

1. Open the Internet Explorer web browser, then navigate to the OWA page 
(e.g. https://exchange_2007/owa). 

You will see the following security warning popup. 

Click on View Certificate.

2. Click on Install Certificate to launch to certificate wizard.

3. Click Next.

 Note: This procedure may vary depending on the way in which you have the domain servers configured. The 
goal of this process is to add the Exchange server as a trusted PC on the Officelinx server computer, 
which can be accomplished manually by the system administrator.

I Caution: For all certificates, always ensure that you are on the 
proper web page, and confirm the issuer of the certificate for 
security purposes before proceeding with the installation.
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4. Enable Automatically select the certificate store based on the 
type of certificate then click Next.

5. Confirm that the information is correct, then click Finish.

6. The following popup confirms the import was successful. 

Click OK.

7. You will be able to confirm the status of the certificate through this window.

8. Depending on the security settings on the system, you may 
also see the following warning popup. 

Click Yes to accept the certificate in this case.

9. The certificate configuration is now complete. Restart the 
servers to ensure that the services are properly initialized.



 Note: Ensure that the domain server is also certified, not just the 
Exchange server.
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UC TSE .Net Service

1. As a final step you must allow the UC TSE .Net Service to run with 
administrative privilege. From Control Panel > Administrative Tools > 
Services find the UC TSE .Net entry and open the properties. From the Log On 
tab, select the This account radio button then enter the credentials that has 
administrative rights to the UC server. Click OK to save the changes.









2. Your configuration is now complete. You should restart the servers to ensure that 
the services are properly initialized.

 Warning: This procedure is only necessary if you have not updated your Exchange server to Service Pack 2. If you 
are using Exchange 2007 with SP2, it is recommended that you disable this service.
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Contact and Calendar Sync
Once you have configured the IMAP TSE server with your mail server, you will be able to select the degree of synchronization 
from the Feature Group. Ensure that you verify all of the information so that users do not lose any calendar, contact or 
message data during synchronization.

Feature Group

Feature Group configuration requires changes on two tabs; Synchronization Options and Mailbox Option. You can define 
exactly what is going to be synchronized for the users from these two sections.

From the Synchronization Options tab, you can specify which messages 
are going to be synchronized between the servers. 

Enable Contacts if you wish to enable contact synchronization between 
the two servers.

To enable calendar synchronization, select Mail Server from the 
Calendar Mode dropdown menu.

The other fields, such as Inbox Folder, are used for message 
synchronization between the servers. Refer to the message integration 
section for details.

From the Mailbox Options tab, enable Change Location to allow an 
event on the mail server calendar to automatically change the UC location 
of the user.

By customizing these settings you can easily segregate calendar and 
contact synchronization along with message synchronization when enabling features for your users, allowing you to control 
exactly who has access to certain features.

 Warning: As a precaution, backup the calendar and/or contact events of your users before proceeding with 
the contact and calendar synchronization.

 Note: If you did not install the Exchange MAPI component during the initial Officelinx installation, you must do 
so manually now by running the ExchangeMapiCdo.msi file from MSExchange folder on Officelinx installation 
DVD. This is a required component for contact and calendar synchronization.

Mail Server
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User Guide
Once calendar and contact synchronization has been enabled, all transactions occur on the server in the background, so you 
do not have to configure anything on your own. Use your mail server as you normally would, and any calendar or contact 
entries will now be mirrored in your Officelinx mailbox as well. 

The following is typical behavior for synchronization so that you can understand exactly how your calendar and contact 
entries are being handled by the servers.

Calendar Synchronization
When you create a calendar entry in Outlook, or most other email 
programs, the same entry will appear in your Officelinx mailbox.

The time and date of the meeting is automatically sent to the 
Officelinx mailbox. By default, the location for these events will be 
marked as Meeting. You may change this manually through Web 
Access, or in the case of Outlook, you may utilize the iLink Pro 
Desktop tool bar to assign a specific location to the event.

Contact Synchronization
When you create a contact entry from Outlook, the entry will be copied into your 
Officelinx mailbox.

Contact information is automatically sent to the Officelinx mailbox.

MS Exchange Performance Considerations

Microsoft (http://support.microsoft.com/kb/905803) advises that a large numbers of items in folders can decrease the 
speed of operations in Exchange. This table shows the maximum number of files recommended per folder for optimum server 
performance.

 Note: All of the calendar events and contacts from your mail server will be copied into your Officelinx mailbox as 
soon as the administrator finishes configuring the systems.

 Note: Backup your calendar events and contacts periodically as a precaution.

I Caution: Deleting contacts is also synchronized. If you delete an entry from Outlook, it will also be deleted 
from Officelinx, and vice versa.

Items in Folder Exchange 2003 Exchange 2007 Exchange 2003

Messages
<5000 combined

<20000 <100000

Contact and Calendar Entries <5000 <10000
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Exchange 2003 Integration
Introduction
Officelinx and an Exchange server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. Once the configuration is complete the servers communicate and synchronize all data among themselves, 
eliminating the need for you to constantly manage multiple locations.

Each user’s Exchange credentials are stored within the Officelinx mailbox, allowing the server to synchronize messages to 
and from the Exchange server. End users can manage their credentials through the Web Access. Administrators may also 
manage credentials from the admin console.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

Administrators can also customize what will be synchronized. A full synch includes contact and calendar entries along with 
messages. If the system has telephone and message light integration, MWI (message waiting lights) will also remain 
accurate since the status of messages are synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
Server configuration requires the creation of a superuser account from the active directory that has the necessary 
permissions within the Exchange console. Once the account has been made, it must be added to the voice server 
configuration, and the channel of communication between the two servers must be established.

Exchange server must also have IMAP enabled in order for Officelinx to communicate properly. Once the superuser account is 
ready, enable IMAP for your Exchange server through the command shell.

Things to Prepare:
Obtain a list of the users that you are going to integrate. Verify that your System Administrator has created a main user on 
the IMAP server that has:

  Full Control permission enabled for the Mailbox Store

  A permanent password

Creating a superuser account (Active Directory - Exchange 2003)
To use IMAP TSE Gateway with Feature Groups, you must first define users in the Active Directory. After creating these 
individual users, you must create an ‘Administrator’ IMAP user that will be used to control each feature group. The following 
steps illustrate how to create this user for a feature group.

To create an Admin IMAP account (Active Directory - Exchange 2003):

1. From your Active Directory PC’s Windows toolbar, go to
Start > All Programs > Administrative Tools > Active Directory Users and Computers. 
The Active Directory and Users window appears.

2. Click Create User. The New Object - User window appears.
3. Specify the following:

 In the First name field, enter IMAP.
 In the Last name field, enter CONTAINER.
 In the User logon name field enter IMAPC.
Click Next.

4. Enter a password for the user, then re-enter to confirm it. 
5. Enable Password never expires.


Click Next.

6. Disable Create an Exchange mailbox. 

Click Next.

7. Click Next.
8. Click Next. The Create In dialog box appears.
9. Click Finish. 

The new account has been created.

 Hint: It is advised that you contact your system administrator to verify that the usernames and passwords are 
correct before proceeding.
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10. In the Active Directory, select and right-click the IMAP CONTAINER user. 

Choose Properties.

11. Ensure that the first and last name for the user are correct. 

12. Click on the Account tab:
13. Ensure that the User logon name is correct and that the 

Password never expires checkbox is enabled.
14. Click OK.

15. On the Microsoft Exchange Server PC, open the 
Exchange System Manager.

16. Expand First Storage Group.
17. Right-click on Mailbox Store and select Properties.

 Note: Although you may also specify an email address, it is not 
recommended.
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18. Click on the Security tab:

19. Click the Add button. The Select Users, Computers, or Groups dialog 
box appears.

20. Verify that the local domain appears in the From this location field. If not, 
click Locations and select the correct domain.

21. In the Enter the object names to select field, enter the first few letters of 
the user name of the superuser account.

Click Check Names.

22. Select the superuser from the list of matches and click OK.

23. Make sure the IMAPCONTAINER account has full control 
(i.e. all Allow Permissions checkboxes are enabled).

24. Click Apply, then OK. 

You have successfully created an IMAP superuser account.

 Note: It is very important that you make sure the full control 
checkboxes are not grayed out. This means that permissions are being 
inherited from the parent object and may have explicit deny permissions 
associated with them. Contact your administrator for further assistance.
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25. The UC CSE PIM Synchronization Engine service must login and run with the Superuser credentials.

Open the Computer Management console and select Services.

26. Stop the UC CSE PIM Synchronization Engine service. 
27. Right-click the service and select Properties. 

Go to the Log On tab, and enable This Account.
Enter the username and password for the superuser account in the spaces provided.

Click Apply and OK when finished.
28. Restart the service.
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Prior to UM Setup

To begin the setup of unified messaging you need to create a TSE IMAP connection. This tells the voicemail server the IP 
address of the Exchange 2003 server it will connect to. 

To create TSE IMAP connections:

1. Launch OL Admin. Locate TSE IMAP Server in the left-hand pane. Right-click and select 
New > TSE IMAP Server. 

2. Complete the following fields:
 IMAP Server Name: Enter the name of the IMAP server. This is for reference and does 

not impact performance. This label will be seen when you are associating Feature 
Groups or Mailboxes with a specific IMAP server for integration/synchronization.

 IMAP Server Address: Enter the Exchange 2003 server’s IP address or Domain 
address.

 IMAP Server Port: Enter the port which will be used to communicate with the IMAP 
server. Accept the default value or enter the server port provided to you by your 
network Admin.

 Voice Format: From the dropdown menu, select the voice format which will be used when sending voice messages 
to external voice servers.

 IMAP Server Domain: Enter the Domain address of the IMAP server. Since it is possible to define the IMAP Server 
Address field with an IP address, the Domain address entered here will be used to verify the Reply to address of a 
mailbox using IMAP TSE synchronization to circumvent typical message looping scenarios. 

Repeat as often as required to create additional servers. You may create only as many servers as you have licenses.

 Warning: It is necessary to establish TSE IMAP connections before setting up Unified Messaging.

 Note: If you are using an SSL connection, you should use the server’s domain name (DNS) instead 
of the IP address so that the certificate can be authenticated properly. 
SSL connections should always use port 993 as well.
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Setting Up Unified Messaging (UM) 
Mailbox integration requires each user on Exchange 2003 to have a mailbox on the Officelinx system.

1. Obtain a list of the users you are going to integrate. 

2. On your voice server, open the OL Admin console.
3. Open the Mailbox properties.
4. Click on the Advanced tab:
5. From the Desktop Capabilities dropdown list, select 

Unified Communications or Advanced Unified Messaging.
6. Click Save.

7. From the Admin console open the Feature Group Properties.
8. Select the Synchronization Options tab.
9. In the IMAP Account field, enter the domain /user id (e.g., "PERF/

super_user"). This is the superuser account created previously.
10. In Account Password, enter the password for the superuser.
11. In the Confirm Password field, re-enter the password.
12. In the IMAP Server field, select the IMAP server from the list.
13. For Max No. of Connections, enter the maximum number of failed 

connections allowed before the user is locked out. This could happen 
when the IMAP server or email server itself goes down and a 
connection cannot be re-established.

14. Under Max No. Of Logons, enter the maximum allowable number of 
failed logons to the IMAP server before the user is locked out.

15. In Synchronization Settings, enable the following as required:

 Inbox folder to synchronize messages between the Exchange and voicemail inbox folders.
 Call History to synchronize the call history between the Exchange and voicemail system folders.
 System folders to synchronize messages in the Exchange and voicemail system folders (e.g. Deleted Items, Draft).
 Custom folders to synchronize messages in any custom Exchange and voicemail folders (e.g. new folders created 

by User).
16. From the Sync Priority dropdown list, select the level of priority for synchronization. Select Maximum if only one 

Feature Group is in use. 

 Note: It is advisable to contact the system administrator to verify that the usernames and passwords 
are correct before proceeding.

 Hint: If you are using basic Inbox to Inbox synchronization, 
there is no need to enable the options below. Carefully 
consider your system configuration prior to enabling higher 
levels of synchronization.

 Note: Assign the highest priority to groups with the most need, and lower priority to those who can 
wait. If too many groups are set to Max, it will impact performance for those who need it the most.
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17. In the Msgs Per Sync Cycle field, enter the number of messages the system should attempt to synchronize during each 
synchronization cycle. The recommended value is between 10 and 25. Never leave this field as 0.

18. Leave the TSE Location field blank unless you are using a High Availability system.
19. Diable Update Message Status From.
20. Click the Save Feature Group toolbar button. 

21. Return to the Admin Console. 
Go to the Mailbox > Synchronization Options tab:

22. In the User Name field, enter the Alias from the Exchange server. 

23. The User Password and Confirm Password fields must be blank.
24. The IMAP Server field must be empty.
25. In the IMAP Language field, choose the language of the mailbox. 

You must make a choice in this field.
26. From the Storage Mode dropdown list, select IMAP. 
27. Disable the Update Message Status From checkbox.
28. Click the Save Mailbox toolbar button.

 Note: The feature group is now configured for the superuser to integrate IMAP TSE. The superuser can 
assign individual user mailboxes to this feature group to enable full IMAP TSE integration. Before UM 
setup can be complete, each mailbox in the system must be assigned an alias.

 Note: This username must match the name used on the 
IMAP server. This User Name should also be the same as 
your Windows logon name. Confirm with your System 
Administrator if you are unsure.

Alias

IMAP
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User Guide
Once calendar and contact synchronization has been enabled, all transactions occur on the server in the background, so you 
do not have to configure anything on your own. Use your mail server as you normally would, and any calendar or contact 
entries will now be mirrored in your Officelinx mailbox as well. 

The following is typical behavior for synchronization so that you can understand exactly how your calendar and contact 
entries are being handled by the servers.

Calendar Synchronization
When you create a calendar entry in Outlook, or most other email 
programs, the same entry will appear in your Officelinx mailbox.

The time and date of the meeting is automatically sent to the 
Officelinx mailbox. By default, the location for these events will be 
marked as Meeting. You may change this manually through Web 
Access, or in the case of Outlook, you may utilize the iLink Pro 
Desktop tool bar to assign a specific location to the event.

Contact Synchronization
When you create a contact entry from Outlook, the entry will be copied into your 
Officelinx mailbox.

Contact information is automatically sent to the Officelinx 
mailbox.

MS Exchange Performance Considerations
Microsoft (http://support.microsoft.com/kb/905803) advises that a large numbers of items in folders can decrease the 
speed of operations in Exchange. This table shows the maximum number of files recommended per folder for optimum server 
performance.

 Note: All of the calendar events and contacts from your mail server will be copied into your Officelinx mailbox as 
soon as the administrator finishes configuring the systems.

 Note: Backup your calendar events and contacts periodically as a precaution.

I Caution: Deleting contacts is also synchronized. If you delete an entry from Outlook, it will also be deleted 
from Officelinx, and vice versa.

Items in Folder Exchange 2003 Exchange 2007 Exchange 2003

Messages
<5000 combined

<20000 <100000

Contact and Calendar Entries <5000 <10000
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Introduction
This configuration note describes the implementation of unified messaging between Office 365 and Esna’s Officelinx.

Pre-requisites
The following preliminary steps must be completed before the integration can begin:

 The Office 365 domain has been setup and deployed (requires Midsize Business and Enterprise plan minimum, E1 or E3).

 Administrative access to the Office 365 domain. Web and PowerShell access is required.

 Officelinx Server installed and running (refer to Esna’s documentation web site).

 Warning: The instructions found in this guide cannot be guaranteed to work for all installations since each 
site is unique. Some problems may arise even if you follow these instructions precisely. Therefore, use this 
document as a reference for your own configuration, making the changes appropriate to your site's specific 
requirements.
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Office 365 Configuration

Web Interface Configuration (Part 1)
1. Log into the Office 365 Administration interface through a web browser at https://login.microsoftonline.com/ or similar 

as setup by your administrator. 

Go to Management > Users and create a new user (New > User).

2. Enter the required details and user name for the superuser (service) account. No Additional Details are required.

Click Next.
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3. Set the user’s geographic location.


Click Next.

4. Assign the appropriate licenses. For Office-LinX Unified Messaging, only the Exchange Online (Plan 2) license is 
required.

Click Next.

 Note: This account does not require administrator permissions. Specific roles and security access will 
be assigned later using PowerShell.
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5. Choose whether or not you wish to receive account creation results by e-mail.

Click Create.

6. Verify that the account was created successfully. 

Record the Temporary Password and click Finish.
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Windows PowerShell configuration

On your Windows desktop, start a PowerShell session. Initiate the connection to the Office 365 domain with the following 
commands:

$LiveCred = Get-Credential

At the prompt, enter the full username (e.g. account@here.yourdomain.com) and password of the Administrator 
account.

Initiate the connection using:

PS > $Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri https://ps.outlook.com/
powershell/ -Credential $LiveCred -Authentication Basic -AllowRedirection

PS > Import-PSSession $Session

Enter the following command. Replace the -User parameters (in red) with the superuser account details created above:

PS > Get-Mailbox | Add-MailboxPermission -User superuser@here.yourdomain.com -AccessRights FullAccess -
InheritanceType All

Verify that it runs successfully. Enter:

PS > New-ManagementRoleAssignment -Name "OLSUAcct" -Role "ApplicationImpersonation" –User 
superuser@here.yourdomain.com

 Note: If running the following command causes an error, it is necessary to run this command first:
PS > Enable-OrganizationCustomization
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Web Interface Configuration (Part 2)
Log on to the service account to change the temporary password before it can be used with Office-LinX. 

1. In a browser, log in to the account at http://login.microsoftonline.com/. Set the password for the service account 
and record it for later use.

2. After logging in (specifying a time zone if required), select Outlook Options.

3. Go to Outlook Web App > Account > My Account. Click Settings for POP, IMAP, and SMTP access….
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4. In the pop-up window, note the server address for the IMAP connection 
(e.g. under IMAP setting, record Server name: pod#####.outlook.com).
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Office-LinX Server Configuration
1. In Office-LinX Admin, add a new TSE IMAP server, and include the Office 365 server information.

 IMAP Server Name: Enter a name for this connection (e.g. Office 365).
 IMAP Server Address: Type in the IMAP server name setting from previous section 

(e.g. pod#####.outlook.com).
 IMAP Server Port: Set to 993 to enable SSL connectivity.
 Voice Format: Select MPEG-1 Audio Layer 3 (MP3) for client playback.
 IMAP Server Domain: Enter the Office 365 domain name (e.g. here.yourdomain.com).

2. Once the TSE IMAP Server entry has been created, go to Feature Group > Synchronization Settings and modify the 
Office 365 user mailboxes as follows:
 IMAP Account: Enter the super user/service account created previously. Include the complete 

user@domain.com (e.g. superuser@here.yourdomain.com).
 Account / Confirm Password: Enter the super user/service account password.
 IMAP Server: Type in the name of the IMAP TSE Server (e.g. Office 365).
 Calendar Mode: Select None.

 Synchronization Settings: Set these options to specify which information will be synchronize

 Note: Calendar synchronization is not supported with Office 365. If both Outlook and the UC Client 
desktop software are being used, Outlook Client Calendar push mode can be enabled. Select this option 
from the Calendar Mode drop down menu.

 Note: Contact integration is not supported with Office 365.
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3. Ensure that individual mailboxes are configured under Mailbox > Synchronization Settings with their User Name 
(e.g. test1@here.yourdomain.com), and that Use Feature Group settings for IMAP is enabled.

4. From the Windows desktop, go to Start > Officelinx > IMAPTSE - Diagnostics and Configuration Tool.
Login using the Administrator credentials.

5. Select the Office 365 group from the list.


Click the IMAP Synchronization Settings button .
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6. In the IMAP Synchronization Settings window, open the Performance / Tuning tab.

In the High Performance Pack section, set the HPP Threads to 16. Click Apply.

7. Close the IMAP utility and restart the Officelinx server.
8. Test the setup by leaving several voice messages. Verify message synchronization with the Office 365 mailbox.
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Lotus Domino Integration
Introduction
Officelinx and a Lotus Domino server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. Once the configuration is complete the servers communicate and synchronize all data among themselves, 
eliminating the need for you to constantly manage multiple locations.

The use of the administrator account from Lotus Domino allows you to streamline the sign on process while still maintaining 
individual password security protocols on each mailbox. The Lotus administrator account credentials are entered through the 
OL Admin console.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

Administrators can also customize what will be synchronized. A full synch includes contact and calendar entries along with 
messages. If the system has telephone and message light integration, MWI (message waiting lights) will also remain 
accurate since the status of messages are synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
Lotus Domino configuration is largely divided into two parts. First is the configuration of both the Domino server and the 
Officelinx server to synchronize messages between the mailboxes on both systems. Second is configuring UC forms for Lotus 
Notes so that end users will have the ability to record and playback voice messages from their Lotus Notes client. While 
specific variables regarding settings will differ from site to site, this guide provides a general guideline for integrating Lotus 
Domino with Officelinx.

Setting up IMAP TSE Synchronization

To configure Lotus Notes for Officelinx users:

1. Access the Lotus Notes Administrator.
2. Under the Domain/People directory, double click User and enter a nickname, a user name and an internet password.
3. On the Lotus Domino Console, run the following command:

Load Convert –m mail\username.nsf * ucmail.ntf.

The following procedure is optional:

To prevent the Lotus Window from scrolling while logging in and out under IMAP: 

1. On the Lotus Notes Server, open the notes.ini file.
2. Set the Log_Session=1 to 0.
3. Click Save, then click Close. 

 Note: In the above command, "username" is the Lotus mail file, and "ucmail.ntf" is the template into 
which the forms were installed.

 Note: Once the forms have been installed and distributed to the users, their inbox will need to be 
closed and reopened in order for the templates to be refreshed. This needs to be done every time the 
Master Template is updated.
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Officelinx Configuration: Single User

With this option, Officelinx connects to the Lotus Domino server on a mailbox-by-mailbox basis, using each individual client’s 
account credentials for each connection.

It is necessary to establish IMAP TSE connections before setting up Unified Messaging.

To begin the setup of your unified messaging you need to create a TSE IMAP connection. The purpose of this connection is to 
tell the voicemail what IP address it is supposed to connect to in order to connect to your Lotus Domino server.

To create TSE IMAP connections

1. Login to OL Admin. The following screen appears:

2. Locate TSE IMAP Server in the left-hand pane. Right-click and select New > TSE IMAP 
Server. The following screen appears:

3. Complete the following fields:
 In the IMAP Server Name text field, enter a descriptive name of the server.
 In the IMAP Server Address text field, enter the Domino server’s IP address.

 Accept the default value in the IMAP Server Port field or enter the server port field provided to you by your 
network Admin.

 Select the Voice Format that your servers will use to handle voice messages.
 In the IMAP Server Domain field, enter the domain name of the mail server to avoid looping messages during 

synchronization. This server address will be cross referenced with the Reply To address of each mailbox.

 Note: Configuring Officelinx for use with Superuser credentials is no longer supported.

 Note: If you are using an SSL connection, you should use the server’s domain 
name (DNS) instead of the IP address so that the certificate can be 
authenticated properly. SSL connections should always use port 993.
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Setting Up Unified Messaging (UM) 

Mailbox integration is a configuration where each individual user on your Domino server is given their own mailbox on the 
Officelinx system.

1. Obtain the list of the users you are going to integrate. It is advised 
that you contact your system administrator to verify that the 
usernames and passwords are correct before proceeding.

2. On the voice server machine, open OL Admin.
3. Open the Mailbox properties.
4. On the Addresses tab, verify that the Reply To email address is the 

address of the user’s Lotus Domino account. If you made any 
changes, click Save.

5. Click on the Advanced tab.
6. From the Desktop Capabilities dropdown list, select Unified 

Communications.
7. Click the Save Mailbox toolbar button.

8. Click on the Synchronization Options tab.
9. In the User Name field, enter the details of the user’s Lotus Domino 

email account. Change all forward slashes / to pipes |, such as:
Firstname Lastname|Organizationname

10. From the Storage Mode dropdown list, select IMAP. 
11. Enter the mailbox internet password in the User Password and 

Confirm Password fields.
12. For IMAP Server, select the Domino server.
13. Disable the Use Feature Group setting for IMAP checkbox.
14. In the IMAP Language field, choose the language of the mailbox. You must make a choice in this field.
15. Do not use the Message Status feature. Make sure that the Update Message Status From checkbox is not checked.
16. Click on the Save Mailbox toolbar button.
17. On the voice server machine, open IMAP Tester.

18. Click on IMAP Synchronization Settings. 

 Warning: The following steps must be completed in the 
specified order.

 Note: Organizationname may include the domain and other 
information. Separate all fields by a pipe instead of a slash.
       any body|ERB|Music|Sales
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19. Click on the Performance/Tuning tab.
20. Disable the High Performance Pack checkbox.
21. Click Apply to save the changes. Exit the utility.
22. Restart the UC TSE Cache Manager service.
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Installing UC Forms for Lotus Notes
This section describes the installation and configuration of UC forms for Lotus clients. UC forms components are packaged in 
the UCMail.ntf Lotus template database, which can be found on the installation DVD. The UCMail template contains the 
following:

 UC Player subform that can be used to extend other forms with an audio player/recorder.

 A subform to indicate the location of iLink Pro Desktop installation file.

 Modified versions of Memo, Reply, and Reply with History forms with UC Player subform added to each.

There are two methods for installing UC forms onto the server: 

 A - Use a provided template as the basis for all UC users.

 B - Copy design elements from a provided templates into another, and modify standard forms to include the UC Player 
subform. This method allows you to add UC player to existing custom templates.

Regardless of which method is used, the design is made available to the Lotus Notes client through a manual design refresh 
initiated by the client, or by running the designer task on the server. Once the design elements are propagated to the target 
database, each user is provided with an install button within Lotus Notes that allows the installation of binary components on 
the client PC. 

Using the Provided Template as Design (Method A)

1. Insert the Officelinx Installation DVD.
2. Copy the ucmail.ntf from the DVD (located inside Lotus folder) and paste it into the Domino Data folder 

(e.g. C:\Program Files\IBM\Lotus\Domino\Data).
3. When you open Domino Administrator, you will notice UC Mail in the list of available templates. Select the template then 

open it in the Domino Designer.
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4. Expand Shared Elements > Subforms in the left pane of the Designer window. From the main pane locate UCPlayer 
and double click to open.

5. The fields associated with the UC Player subform appear. Open the UCLotusSRV variable and enter the Officelinx 
server’s domain name or IP address. This is where end users download the iLink Pro Desktop application. When ready, 
Save and Close the subform. This will update the design element signer.

 Hint: Use the UCLotusVer field to manage version control with UC form.
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6. From the Forms section, double click on Memo. Save and close the Memo form to update the design element signer.

7. Repeat the process for Reply form. Open the form then Save and close to update the design element signer.

8. Repeat the process for Reply with history form. Open the form then Save and close to update the design element 
signer.

9. Repeat the process for any other forms you wish to add the UC Player to, and then exit Domino Designer.
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ECL Configuration

Lotus Domino uses an Execution Control List (ECL) to set up workstation data security. An ECL limits the actions of 
formulae, scripts, forms and other objects run on a workstation. For example, an ECL can prevent another person's code 
from running on a PC and damaging or erasing data.

Domino administrators have the power to allow users to modify their ECLs or to control all changes to their ECLs across an 
organization. In order to limit workstation access, an ECL will look for a database, template and item signature before 
opening on the workstation. The ECL will then check this signature against its settings to determine what level of access can 
be granted.

Groupware forms are subject to an ECL check as well, since they contain scripts and COM objects. Thus, on the first 
installation of Groupware forms within an organization, you are advised to:

 Modify the Administrative ECL on the Domino Server.

 Propagate the changes to all clients.
1. Open Domino Administrator. Locate the People & Groups tab. From Actions menu, select Edit Administration 

ECL.

2. From the Workstation Security: Execution Control List window, click on the Add button.

3. In the People, Servers, or Groups field, enter the name of the person/server/group to be added to the ECL. This 
should be the person that performed the installation, most likely the Domino Administrator. 

Once you have selected a user, click OK.
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4. Now select the user or object added in the previous step (Administrator in this example). Enable Allow user to modify, 
then select the Workstation security radio button. Enable all checkboxes under Allow then click OK.

5. Repeat for both the Java applet security and JavaScript security radio buttons.

6. For each mailbox database that will include UC forms, configure them to inherit the design from the UCMail template. 
This can be done using the load convert command, or manually through mailbox database properties.

7. Now that the forms are ready, you must append the new design. From Status > Server Tasks, click Start... in the list 
of tasks on the right pane.
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8. Select Designer from the list then click Start Task. The design will be updated for all 
Users. Users can now take advantage of the forms packaged with iLink Pro Desktop in 
Lotus Notes.

Adding UC Forms to Existing Design (Method B)

1. This procedure is similar to Method A, but you will be importing the UC form into an existing database template so that 
you can utilize UC form within an existing custom form design. Please refer to the details within Method A to familiarize 
with yourself with the procedure before proceeding.

2. Insert the Installation DVD.
3. Copy the ucmail.ntf from the DVD and paste into the Domino Data folder 

(e.g. C:\Program Files\IBM\Lotus\Domino\Data). 
4. Navigate to File > Database > Open. Select the ucmail.ntf file from Step 3 and open it in Domino Designer. 
5. Open the copied template. This template should contain the UC forms. As a rule, all users in an organization will inherit 

design elements from a single template. Should it be necessary to provide UC functionality to a select group of users, it 
is recommended that a copy of the default template be created and all UC elements placed there. Design elements for 
UC user databases can then be inherited from the created template.

6. Edit the UCLotusSRV variable to point to your Web Access for iLink Pro Desktop download.
7. Copy the UCPlayer subform and paste it into the target template. If the UCPlayer subform is already present in the 

target template (upgrade scenario), then remove it prior to upgrading.
8. Open the Memo form in the target template and select Create > Resource > Insert Subform. 

9. Click OK. The UCPlayer subform will be inserted into the Message form.

10. Click Save and close the form.
11. Repeat Steps 7-10 for each form that is to include the UCPlayer subform.
12. Create three copies of the modified Memo form and give them the following names: TelNTVoice, TelNTFax, and 

TelNTText.
13. Follow the procedures on ECL Configuration on page 200 to complete the process.

 Note: Once the design elements have been propagated to the client database, 
the forms are almost complete. A few additional components must be installed to 
fully enable forms on the client.
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User Guide

Installing UC Forms in Lotus Notes
To use UC forms within Lotus Notes, you must install iLink Pro Desktop. Obtain iPD from Lotus Notes.

Installing UC Bar and iLink Pro Desktop

1. Run Lotus Notes.
2. Open the mail database.
3. Create or open a document that uses a form with the UC Player subform (e.g. Memo).
4. In the Actions pane click on the Install UC bar button.

5. Lotus Notes will open a web page to download the iLink Pro Desktop software. iPD must be installed for UC forms to 
work.

6. Download the installation package then install the application.
7. Once iLink Pro Desktop is installed, the button will change to Show UC bar. Click on this button to open the UC form.

 Note: Subforms must be inserted in all areas which require voice message playback function.

 Note: You may have to restart Lotus Notes or reopen a form in order to see the new button. You must 
also be logged into iLink Pro Desktop to use the UC forms.
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8. You will now have access to Record and Playback actions through the form.

Verifying the Lotus Notes client ECL setup
1. Open Lotus Notes.
2. Select File > Security > User Security > What Others Do > Using Workstation. The User Security dialog box 

appears.

3. The ECL should contain all of the entries that were defined in the Administration ECL.
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Using UC Forms in Lotus Notes

Composing a Voice Message

1. Create a new message.
2. Fill out the To, Subject and any other fields as you would normally do.
3. Use the UC bar provided to record a message.

 Click  to begin recording the voice message with your microphone.

 Click  to begin recording the voice message with your phone.

 Click  to pause recording or playback.

 Click  to stop recording or playback.

 Click  to playback recorded message.

4. When you finish recording a message, you will see an attachment automatically created as shown. 
Click Send to transmit your message.

 Note: Some actions may not be available depending on site settings.
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Listening to a Voice Message

1. Open a voice message from Lotus Notes. UC forms will detect voice messages and provide options for message playback.

 Click  to begin playing the voice message on your PC speaker.

 Click  to begin playing the voice message on your phone.

 Click  to pause playback.               Click  to stop playback.

2. If you choose to play the message on your phone, you will be given an option to choose which number to listen from. The 
list depends on your current UC location and the extensions defined through iLink Pro Desktop. When you select a 
number to listen from, UC server will dial that number, then playback the message once the call is answered.

Configuring UC Mailbox to Synchronize with Lotus Notes

1. Log into Web Access.
2. Click on the Account icon.
3. If the Locked checkbox is selected, deselect this checkbox.
4. Provide the following information:

 User Name: Enter your mail server user name.

 Password: Enter the password for your mail account.

 Confirm Password: Confirm the above password.
 Voice Format: From the dropdown menu, select the voice format which will be used for voice messages. You should 

leave this field as default in most cases.
5. Click on Save and Close button at the top.

 Note: Some actions may not be available depending on site settings.

 Note: If you do not have access to Web Access, this configuration can be performed by your administrator.

 Note: The user name you enter in this field will be the same user name for the 
email account as it exists on the mail server.

 Note: The password you enter in this field will be the same password for the email account as it exists 
on the mail server.
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Zimbra Integration
Introduction
Officelinx and a Zimbra server are able to integrate through the IMAPTSE services, providing a truly unified messaging 
experience. This is possible as long as the Zimbra server has been configured to support IMAP. Once the configuration is 
complete the servers communicate and synchronize all data among themselves, eliminating the need for you to constantly 
manage multiple locations.

Each individual users mail server credentials must be entered on the UC mailbox account in order to synchronize an Officelinx 
mailbox with a Zimbra account. This is done through the Admin console, or by the end users employing the Web Access.

Since Zimbra is able to accept web based plug-ins through Zimlets, Officelinx’s UC Client can also be deployed conveniently 
through the Zimbra server, allowing users to access all their messages and UC Client capabilities from a single application. 
Both the web based and desktop versions of the Zimbra client are compatible with UC Client Zimlet.

Visual Guide

When a voice server integrates with an email server, the data between the two is synchronized, allowing for accurate 
information regardless of the point of access. Receiving messages, and any actions performed by the users is synchronized 
between the two servers constantly, ensuring that your content is always up-to-date.

If the system has telephone and message light integration, MWI (message waiting lights) will also remain accurate since the 
status of messages are synchronized between the servers.

Requirements

 Note: Zimbra integration is on a controlled introduction phase.

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
This guide assumes that IMAP services are already enabled on your mail server. To achieve synchronization, configure an 
IMAPTSE end point from the Officelinx Admin, then allow Feature Groups and Mailboxes to utilize that end point. Once the 
configuration is complete, all messages (including voicemail) from Officelinx will be synchronized with the inbox of the mail 
server account, allowing users to access all their messages through a single application.

Configuration for Mail Synchronization
It is necessary to establish IMAP TSE connections before setting up Unified Messaging.

To begin the setup of your unified messaging you need to create a TSE IMAP connection. The purpose of this connection is to 
tell the voicemail what IP address it is supposed to connect to in order to connect to your Zimbra server.

To create TSE IMAP connections

1. Login to OL Admin. The following screen appears:

2. Locate TSE IMAP Server in the left-hand pane. Right-click and select 
New > TSE IMAP Server. The following screen appears:

3. Complete the following fields:
 In the IMAP Server Name text field, enter a descriptive name of the server.
 In the IMAP Server Address text field, enter the Zimbra server’s IP address.

 Accept the default value in the IMAP Server Port field or enter the server port field provided to you by your 
network Admin.

 Select the Voice Format that your servers will use to handle voice messages.

 In the IMAP Server Domain field, enter the domain name of the mail server to avoid looping messages during 
synchronization. This server address will be cross referenced with the Reply To address of each mailbox.

 Note: If you are using an SSL connection, you should use the server’s domain 
name (DNS) instead of the IP address so that the certificate can be 
authenticated properly. SSL connections should always use port 993 as well.
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Feature Group Configuration for IMAP

Define the degree of synchronization between Officelinx and Zimbra through the Feature Group settings. Rather than 
managing these settings individually for all your users, you may simply associate users with feature groups to easily apply 
different types or settings to multiple users.

1. From your voice server computer, launch the OL Admin console.
2. Open Feature Group properties. 
3. Go to the Synchronization Options tab. Set the following:

 IMAP Account: Leave this field blank.
 Account Password: Leave this field blank.
 Confirm Password: Leave this field blank.
 IMAP Server: Leave this field blank.
 Max No. of Connections: Enter the maximum number of failed 

connections allowed before a user is locked out. This could 
happen when the IMAP or eMail server goes down and no 
connection can be re-established. The default value is 3.

 Max No. of Logons: Enter the maximum allowable number of 
failed login attempts to the mail server before a user is locked 
out. The default value is 3.

4. In the Synchronization Options feature box, select the following:

 Inbox folder checkbox if you want to synchronize messages between the IMAP and VM inbox folders.
 Call History checkbox if you want to synchronize call history between the IMAP and VM system folders. In order to 

use this feature you must enable the System folders and Custom folders first.
 System folders checkbox if you want to synchronize messages in the IMAP and VM system folders (e.g. Deleted 

Items, Draft, etc).
 Custom folders checkbox if you want to synchronize messages in the custom IMAP and VM folders (e.g. Any new 

folders created by User).
5. From the Sync Priority dropdown list, select the level of priority to use for synchronization. Select Maximum if only one 

Feature Group is in use. 

6. In the Msgs Per Sync Cycle field, enter the number of messages the system should attempt to synchronize during each 
synchronization cycle. The recommended value is between 10 and 25. Never leave this field as 0.

7. You must leave the TSE Location field blank unless you are using a High Availability system.
8. Make sure that the Update Message Status From checkbox is not checked.
9. Click on the Save Feature Group toolbar button.

 Note: You cannot synchronize Contacts or Calendar when 
integrating with Zimbra server.

 Hint: If you are working on basic Inbox to Inbox 
synchronization, there is no need to enable these options. 
Careful consideration of your system configuration should 
occur prior to enabling higher levels of synchronization.

 Note: For two or more Feature Groups, ensure that each is assigned a unique synchronization priority.
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Setting Up Unified Messaging (UM) 

Mailbox integration is a configuration where each individual user on your Zimbra server is given their own mailbox on the 
Officelinx system.

1. Obtain the list of the users you are going to integrate. It is advised 
that you contact your system administrator to verify that the 
usernames and passwords are correct before proceeding.

2. On the voice server machine, launch OL Admin.
3. Open the Mailbox properties.
4. Click on the Advanced tab:
5. From the Desktop Capabilities dropdown list, 

select Unified Communications or Mobility.
6. Click the Save Mailbox toolbar button.

7. Click on the Synchronization Options tab.
8. In the User Name field, enter the username. This must match the 

username of the Zimbra account.
9. In the User Password field, enter the password for the mail 

account.
10. In the Confirm Password field, re-enter the password.

11. In the IMAP Server field, choose the entry for the Zimbra server 
that you have previously created.

12. In the IMAP Language field, choose the language of the mailbox. 
You must make a choice in this field.

13. From the Storage Mode dropdown list, select IMAP. 
14. Do not use the Message Status feature. Make sure that the Update 

Message Status From checkbox is not checked.
15. Click on the Save Mailbox toolbar button.

The mailbox is now ready for synchronization.

 Hint: The user name and password may also be entered by 
end users through Web Access. test@domain.co

*******

*******

Zimbra

IMAP
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Configuration for Mail Synchronization with superuser
With individual account setup, end users must manually update their Zimbra account password on Officelinx. Since most 
organizations enforce a periodic password change for security, changing for both applications can become a nuisance.

Using a superuser account for synchronization eliminates the need for users to continually update their password. The 
superuser credentials are managed by the system administrator. The only thing required is to ensure that the Zimbra account 
name is correctly entered in the Officelinx mailbox settings.

To create TSE IMAP connections:

1. Login to Admin. The following screen appears:

2. Locate TSE IMAP Server in the left-hand pane. Right-click and select New > TSE IMAP 
Server. The following screen appears:

3. Complete the following fields:
 In the IMAP Server Name text field, enter a descriptive name of the server. Since 

you’re integrating with a Zimbra server, naming it accordingly will make identification 
easier.

 In the IMAP Server Address text field, enter Zimbra server’s IP address.

 Accept the default value in the IMAP Server Port field or enter the server port field provided to you by your 
network Admin.

 Select the Voice Format that your servers will use to handle voice messages.
 In the IMAP Server Domain field, enter the domain name of the mail server to avoid looping of messages during 

synchronization. This server address will be cross referenced with the Reply To address of each mailbox.

 Note: If you are using SSL connection, you should use the server’s domain 
name(DNS) instead of the IP address so that the certificate can be 
authenticated properly. SSL connections should always use port 993 as well.
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Feature Group Configuration for IMAP

You must define the settings under the Synchronization Options tab in the Feature Group properties in order to define the 
nature of synchronization to the mail server. Rather than managing these settings individuallt for all your users, you may 
simply associate certain users with certain feature groups to easily apply different types or settings to multiple users. Also, 
by entering the superuser information here, passwords for individual users can be managed by the administrator alone, 
rather than requiring each individual to update their passwords on the Officelinx side whenever Zimbra account password is 
changed.

1. From your voice server computer open the Administration console.
2. Open the Feature Group properties.
3. Select the Synchronization Options tab:
4. In the IMAP Account field, enter the superuser account name.

5. In the Account Password field, enter the superuser’s password.
6. In the Confirm Password field, confirm the above password.
7. Select the entry you have created for Zimbra server in the IMAP 

Server field.
8. In the Max No. of Connections field, enter the maximum number of 

failed connections allowed before the user is locked out. This could 
happen when, for example, the IMAP server or email server itself goes 
down and no connection can be re-established. The default value for 
the parameter is 3 and it may be increased.

9. In the Max No. of Logons field, enter the maximum allowable 
number of failed logons to the mail server before the user is locked 
out. The default value for the parameter is 3 and it may be increased.

10. In the Synchronization Options feature box, select the following:

 Inbox folder checkbox if you want to synchronize messages between the IMAP and VM inbox folders.
 Call History checkbox if you want to synchronize call history between the IMAP and VM system folders. In order to 

use this feature you must enable the System folders and Custom folders first.
 System folders checkbox if you want to synchronize messages in the IMAP and VM system folders (e.g. Deleted 

Items, Draft, etc).
 Custom folders checkbox if you want to synchronize messages in the custom IMAP and VM folders (e.g. Any new 

folders created by User).
11. From the Sync Priority dropdown list, select the level of priority to use for synchronization. Select Maximum if only one 

Feature Group is in use. 

12. In the Msgs Per Sync Cycle field, enter the number of messages the system should attempt to synchronize during each 
synchronization cycle. The recommended value is between 10 and 25. Never leave this field as 0.

13. You must leave the TSE Location field blank unless you are using a High Availability system.
14. Make sure that the Update Message Status From checkbox is not checked.
15. Click on the Save Feature Group toolbar button.

 Note: Account name is case sensitive.

 Warning: If you are working on basic Inbox to Inbox synchronization, there is no need to enable the 
options below. Careful consideration of your system configuration needs to occur prior to enabling higher 
levels of synchronization.

 Note: You cannot synchronize Contacts or Calendar when integrating with Zimbra server.

 Note: For two or more Feature Groups, ensure that each is assigned an unique synchronization priority.

super_user@em

*****

*****

Zimbra

None
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Setting Up Unified Messaging (UM) 

Mailbox integration is a configuration where each individual user on your Zimbra server is designated a separate mailbox on 
the Officelinx system.

1. Obtain a list of the users you are going to integrate. It is advised that you contact your system administrator to verify 
that the usernames and passwords are correct before proceeding.

2. Open the Officelinx Administration console.
3. Open the Mailbox properties.
4. Click on the Advanced tab:
5. From the Desktop Capabilities dropdown listbox, select Unified 

Communications or Mobility.
6. Click the Save Mailbox toolbar button.

7. Click on the Synchronization Options tab:
8. Enable the Use Feature Group settings for IMAP checkbox.
9. In the User Name field, enter the user name. This username must 

match the username of the Zimbra account.

10. In the IMAP Language field, choose the language of the mailbox. 
You must make a choice in this field.

11. From the Storage Mode dropdown list, select IMAP. 
12. Do not use the Message Status feature. Make sure that the Update 

Message Status From checkbox is not checked.
13. Click on the Save Mailbox toolbar button. The mailbox is now ready 

for synchronization through superuser.

 Note: Account name is case sensitive.

john@email.com

IMAP
214 Officelinx Feature Description Guide



Zimbra Integration
Configuration for UC Client Zimlet
You can deploy a Zimlet dedicated to UC Web Gadget so that your Zimbra users will have convenient access to UC Client 
functionality right from their email interface. iLink Pro Desktop Zimlet can be deployed for both web and desktop Zimbra 
clients. While the desktop configuration takes place in each user’s own computer, the web configuration takes place on the 
server side.

Zimlet for Web Based Zimbra Client

To begin Zimlet deployment for Zimbra web users, obtain the com_esna_ucclient.zip file from the Zimbra folder on your 
Officelinx installation DVD and load it onto your Zimbra server. You may copy this file into any folder within the Zimbra server.

Once the file is copied, you will have to run the following command line. This must be done from the folder where you copied 
com_esna_ucclient.zip to.

/opt/zimbra/bin/zmzimletctl deploy com_esna_ucclient.zip

The next command you have to run is the following.

/opt/zimbra/bin/zmzimletctl getConfigTemplate com_esna_ucclient.zip >config_template.xml

You should now have a config_template.xml file created. Open this file with an editor and set below values to your 
Officelinx server’s web address (e.g. user.server.com).

<property name="allowedDomains">user.server.com</property>
<property name="uc-server">http://user.server.com</property>

Once this is complete, run the below command to apply the changes.

/opt/zimbra/bin/zmzimletctl configure config_template.xml

At this point UC Client Zimlet should appear for your end users when they log into their Zimbra account through the web 
interface.

Zimlet for Desktop Zimbra Client

To begin Zimlet deployment for desktop Zimbra users, you will have to obtain the com_esna_ucclient.zip file from the 
Zimbra folder on your Officelinx installation DVD and modify the settings to match your server settings. Open the 
config_template.xml from an editor and edit the below two lines with your Officelinx server’s web address (e.g. 
user.server.com)

<property name="allowedDomains">user.server.com</property>
<property name="uc-server">http://user.server.com</property>

Save the config_template.xml from file and ensure that it is included in the new com_esna_ucclient.zip file which you’ll 
be using to deploy Zimlets to desktop users. The procedure required to add UC Client Zimlet on a desktop environment is 
explained on the User Guide section of this chapter.
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User Guide
End users will be able to access messages from their Zimbra client or through the Web Access. User experience within these 
application will not change during synchronization. Users will simply have access to all their messages from a single point.

The only configuration required from the end user is to ensure that their mail server credentials are always up to date on 
their Officelinx mailbox account. If the end user wishes to use UC Client Zimlet from their desktop Zimbra client, they must 
also configure it manually for their workstation.

Adding UC Client Zimlet
1. Obtain com_esna_ucclient.zip file from your system administrator and save it on your computer.
2. Launch the Zimbra Desktop then click on the Preferences 

tab.

3. Click Zimlets from the left pane.

4. You will see Install A Zimlet section at the bottom of 
the Zimlet page. Click on the Browse... button to select 
com_esna_ucclient.zip which you have copied to your 
computer previously. 
Click Upload File.

5. You will see the following window if the installation was 
successful. Click Yes to restart Zimbra Desktop.

6. The UC Client Zimlet home screen 
appears. Click Configure to setup the 
credentials for your account.
216 Officelinx Feature Description Guide



Zimbra Integration
7. In the UC Client Preferences window, enter:
 The IP address or DNS name of the server has been automatically filled in.
 Enter the company number. The default is 1. Leave this unchanged unless there are 

several companies setup on the server.
 Your mailbox number.
 Your mailbox password.
Click OK when finished.

8. The Zimbra UC Client is ready to be 
used. For information regarding UC 
Client, please refer to the Client 
Applications Guide which 
comprehensively covers various types of 
UC Clients.





















 Note: The phone and modem settings on the voice server computer should be configured. Under Phone and 
Modem Settings on the Windows CONTROL PANEL, enter the country and area code settings for 
My Location. Stop and restart the World Wide Web Publishing Service when finished.
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IMAP Server Integration
Introduction
Officelinx server is able to synchronize messages with virtually any mail server through the IMAPTSE services, allowing for a 
truly unified messaging experience. This is possible as long as the mail server is able to support IMAP. Once the configuration 
is complete the servers will communicate and synchronize all the data among themselves, eliminating the need for you to 
constantly manage the sync status.

You must individually enter the mail server credentials of each user on the UC mailbox account in order to synchronize an 
Officelinx mailbox to a mail server account. This can be accomplished through the Admin console or by the end users through 
Web Access.

Visual Guide

When a voice server integrates with an email server the data between the two are synchronized, allowing a unified access 
regardless of the point of access. Receiving messages and actions performed by the users will be synchronized between the 
two servers constantly, ensuring that the user experience is consistent regardless of point of access.

If the system has telephone and message light integration, MWI (message waiting lights) will also remain accurate since the 
status of messages are also synchronized between the servers.

Requirements

Requirements Details

License IMAPTSE License

Software Officelinx version 8.5 or higher
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Server Configuration
This guide assumes that you already enabled the IMAP services on your mail server. To achieve synchronization, all you have 
to do is configure an IMAPTSE end point from the OL Admin then allow Feature Groups and Mailboxes to utilize that end 
point. Once the configuration is complete, all messages (including voicemail) from Officelinx will be synchronized with the 
inbox of the mail server account, allowing users to access all their messages from a single point.

Configuration
It is necessary to establish TSE IMAP connections before setting up Unified Messaging.

To begin the setup of your unified messaging you need to create a TSE IMAP connection. The purpose of this connection is to 
tell the voicemail what IP address it is supposed to connect to in order to connect to your mail server.

To create TSE IMAP connections:

1. Login to Admin. The following screen appears:

2. Locate TSE IMAP Server in the left-hand pane. Right-click and select New > TSE IMAP 
Server. The following screen appears:

3. Complete the following fields:
 In the IMAP Server Name text field, enter a descriptive name of the server.
 In the IMAP Server Address text field, enter the mail server’s IP address.

 Accept the default value in the IMAP Server Port field or enter the server port field provided to you by your 
network Admin.

 Select the Voice Format that your servers will use to handle voice messages.
 In the IMAP Server Domain field, enter the domain name of the mail server to avoid looping of messages during 

synchronization. This server address will be cross referenced with the Reply To address of each mailbox.

You may now proceed to the next section.

 Note: If you are using SSL connection, you should use the server’s domain 
name (DNS) instead of the IP address so that the certificate can be 
authenticated properly. SSL connections should always use port 993 as well.
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Setting Up Unified Messaging (UM) 

Mailbox integration is a configuration where each individual user on your mail server is designated a separate mailbox on the 
Officelinx system.

1. Obtain a list of the users you are going to integrate. It is advised that you contact your system administrator to verify 
that the usernames and passwords are correct before proceeding.

2. On your voice server machine, open the Administration console.
3. Open the Mailbox properties.
4. Click on the Advanced tab:
5. From the Desktop Capabilities dropdown list, select Unified 

Communications or Advanced Unified Messaging.
6. Click the Save Mailbox toolbar button.

7. Click on the Synchronization Options tab:
8. In the User Name field, enter the user name. This must match the 

username used in the mail server.
9. In the User Password field, enter the user password. This password 

must match the password used by the user in the network for mail 
server users.

10. In the Confirm Password field, re-enter the password for 
confirmation.

11. In the IMAP Server field choose the IMAP server.
12. In the IMAP Language field, choose the language of the mailbox. 

You must make a choice in this field.
13. From the Storage Mode dropdown list, select IMAP. 
14. Do not use the Message Status feature. Make sure that the Update 

Message Status From checkbox is not checked.
15. Click on the Save Mailbox toolbar button.

 Note: The user name and password may also be entered 
by end users through Web Access.

username

*****

*****

IMAPServer

IMAP
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Feature Group Configuration for IMAP

You must define the settings under the Synchronization Options tab in the Feature Group properties in order to define the 
nature of synchronization to the mail server.

1. From your voice server computer open the Administration console.
2. Open the Feature Group properties.
3. Select the Synchronization Options tab:
4. The IMAP Account field must be blank.
5. The Account Password field must be blank.
6. The Confirm Password field must be blank.
7. The IMAP Server field must be blank.
8. In the Max No. of Connections field, enter the maximum number of 

failed connections allowed before the user is locked out. This could 
happen when, for example, the IMAP server or email server itself goes 
down and no connection can be re-established. The default value for 
the parameter is 3 and it may be increased.

9. In the Max No. of Logons field, enter the maximum allowable 
number of failed logons to the mail server before the user is locked 
out. The default value for the parameter is 3 and it may be increased.

10. In the Synchronization Options feature box, select the following:

 Inbox folder checkbox if you want to synchronize messages between the IMAP and VM inbox folders.
 Call History checkbox if you want to synchronize call history between the IMAP and VM system folders. In order to 

use this feature you must enable the System folders and Custom folders first.
 System folders checkbox if you want to synchronize messages in the IMAP and VM system folders (e.g. Deleted 

Items, Draft, etc).
 Custom folders checkbox if you want to synchronize messages in the custom IMAP and VM folders (e.g. Any new 

folders created by User).
11. If you select the Send URL checkbox the users will receive a hyperlink to their attachment instead of an actual file.
12. From the Sync Priority dropdown list, select the level of priority to use for synchronization. Select Maximum if only one 

Feature Group is in use. 

13. In the Msgs Per Sync Cycle field, enter the number of messages the system should attempt to synchronize during each 
synchronization cycle. The recommended value is between 10 and 25. Never leave this field as 0.

14. You must leave the TSE Location field blank unless you are using a High Availability system.
15. Make sure that the Update Message Status From checkbox is not checked.
16. Click on the Save Feature Group toolbar button.

 Note: You cannot synchronize Contacts or Calendar when 
using a standard IMAP server.

 Warning: If you are working on basic Inbox to Inbox 
synchronization, there is no need to enable the options 
below. Careful consideration of your system configuration 
needs to occur prior to enabling higher levels of 
synchronization.

 Note: For two or more Feature Groups, ensure that each is assigned an unique synchronization priority.
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User Guide
End users will be able to access messages from their typical email client or through the Web Access. User experience within 
these application will not change during synchronization. Users will simply have access to all their messages from a single 
point.

The only configuration required from the end user is to ensure that their mail server credentials are always up to date on 
their Officelinx mailbox account.

Configuring a mailbox

1. Log into Web Access.
2. Click on the Account icon.
3. If the Locked checkbox is selected, deselect this checkbox.
4. Provide the following information:

 User Name: Enter your mail server user name.

 Password: Enter the password for your mail account.

 Confirm Password: Confirm the above password.
 Voice Format: From the dropdown menu, select the voice format which will be used for voice messages. You should 

leave this field as default in most cases.
5. Click on Save and Close button at the top.

 Note: If you do not have access to Web Access, this configuration can be performed by your administrator.

 Note: The user name you enter in this field will be the same user name for the 
email account as it exists on the mail server.

 Note: The password you enter in this field will be the same password for the email account as it exists 
on the mail server.

 Note: Only the User name field will appear if this mailbox has been setup to employ a superuser login process 
(i.e. for Google). In OL Admin, go to the user Mailbox settings. Under Synchronization Options, remove the 
check in the Use Feature Group settings for IMAP box.
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BlackBerry Enterprise Server Integration
Introduction
Officelinx integrates with email systems using the Internet Message Access Protocol standard. IMAP is supported by most 
mail servers and provides a standards based approach to Unified Messaging.

The BlackBerry Enterprise Server (BES) supports Microsoft Exchange providing push email along with wireless calendar and 
contact synchronization. However, due its design, the BES server does not recognize messages that are added to a message 
store via IMAP. For this reason, Officelinx provides a workaround. The messages (i.e voice messages) received by Officelinx 
and added to a mail store are recognized as new messages by BES and pushed to the client’s device.

Visual Guide

When a voice message arrives on the voice server, the message is sent to the mail BES through an SMTP link. The message 
is recognized by BES as new and is immediately pushed to the user’s device.

If the BlackBerry device is synchronized with the mail server, any action from the device (e.g. read message, delete 
message) will be pushed back to BES, and then to the voice server. This allows for truly synchronized messaging.

Requirements

Requirements Details

License IMAP TSE Sever

It is recommended that you use your current TSE 
license so that you do not have to upgrade your license

Software Officelinx 8.5 or higher
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Server Configuration
Since BES does not recognize a message pushed to the IMAP store, Officelinx forwards the user’s messages through Simple 
Mail Transfer Protocol (SMTP). This allows BES to recognize the incoming message and treat it as new email. 

Most of the settings are made through the OL Admin console.

OL Admin
To configure the integration of Officelinx with BES, setup a TSE IMAP 
Server which has a server address that starts with the prefix “bes:” (you 
can add this prefix to your current TSE server or create a new entry). 
When the Transparent Synchronization Engine (TSE) server sees this 
prefix on the server address, it will implement the necessary BES related 
routing changes automatically.

If you have users that are using IMAP synchronization and are now 
moving over to BES, you can create a second TSE IMAP Server that has the same IP address as the first one but with the 
“bes:” prefix. However, this option requires a second license for a TSE server.

It is recommended that you rename your existing TSE IMAP Server for the workaround since it will not have any affect on 
existing clients whether they have a BlackBerry or not. The end user experience remains the same for everyone, so there is 
no reason not to make the switch if some users require BES.

If you are planning on switching over your current TSE server and all of 
your users, ensure that the correct email entries are added to the 
Address tab of the Mailbox for each user.

After the prefix settings are complete, go to 
Admin > Configuration > VPIM/SMTP and add the address of the 
Exchange server as a SMARTHOST. This instructs Officelinx where to 
forward messages so that the BES will properly recognize incoming 
messages.
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Feature Group

Once you configure the server addresses, go to the Feature Group and 
specify this as the server to use for message synchronization. 

If your users were already part of a Feature Group that had an IMAP TSE 
server, you can create another feature group and assign the newly created 
BES IMAP server to it, then make the BlackBerry users part of this new 
Feature Group.

Once you have specified the BES server, you will be warned about changes 
to the IMAP server if the FG already had an IMAP Server defined.

Click YES for both questions. This will delete any messages in the mailbox and 
synchronize them back from the Exchange server. If you click NO, it is possible 
that you may get duplicate messages in the mailbox.

When you finish configuring the Synchronization Options tab, move onto 
the Message Options tab and make sure that 
Automatic Message Forwarding - Webclient is enabled.

Mailbox

When the Feature Group settings are complete, check each mailbox to 
ensure that the correct corporate email address is entered in the Addresses 
tab. The E-mail and REPLY TO entries should be the same.

The mailbox settings must be changed for each user.

imaptse

*****

*****

BES
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Applying the Settings

Once the changes have been made, restart the following 
services:

 UC TSE Cache Manager

 UC VPIM

The BES configuration is complete.

BES Conflict Message
When using BES with unified messaging, conflict messages may appear in Outlook after receiving a new voice message.

Resolution

RIM recommends that a delay be added to the BES server in order to prevent these messages. This delay allows for other 
applications to properly handle the message before the BES server begins its synchronization. The recommended delay is 30 
seconds.

See the following link for instructions on how to set the delay on the BES server:

http://www.BlackBerry.com/btsc/
search.do?cmd=displayKC&docType=kc&externalId=KB00139&sliceId=SAL_Public&dialogID=146768272&stateId=1%200%
20146764857

 Note: Cut & paste the complete URL.
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User Guide
There are no new settings required by end users. Configure the BlackBerry client as normal and everything will function as 
expected.

Mail management from the mobile client (deleting, moving, etc.) will be properly managed by the TSE as long as the changes 
are implemented properly on the server.
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Find me Follow me on CTI Integration
Introduction
Find me Follow me allows calls to be forwarded to one or more addresses 
until the user is found. The addresses can be internal or external numbers. 
They can be dialed sequentially, or simultaneously. 

This document is intended for technicians who have some familiarity with 
the Officelinx v.9.1 SP1 and want a deeper understanding of what is 
expected of the functions and how to set up users.

The Find Me Follow Me features for DID and direct calls are only available 
for some PBX’s. In the case of Iwatsu ECS, the stations need to be 
monitored with the CTI Link, and the calls need to be forwarded to the UC 
Locations options in the feature group. 

Refer to the Technical Operating Guidelines for more details on supported 
PBX’s.

Visual Guide

If the user has configured Find Me Follow Me for their mailbox, Officelinx will try to locate the user through a broadcast rather 
than through a single phone number or device. Whenever a call comes in, Officelinx will try to locate the user through 
multiple devices simultaneously (or as configured). Once the user accepts the call on one device, Officelinx will connect the 
caller with the user and terminate the other calls.

Requirements

 Note: The Hunt Group field needs to be left bank.

Requirements Details

License ---

Software Officelinx version 8.5 or higher
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Find me Follow me on CTI Integration
User Guide
This guide goes over the configuration of Find me Follow using the Web Access. If you have access to the admin console, this 
process can be completed from there as well.

Find me Follow me with CTI Integration

When you log into the Web Access, the Main page will appear. Click Locations.

The locations page shows all the locations created for the user. From this page, the user can create a new location or edit an 
existing location. Click on the location to be configured, then open the Find Me Rules tab.

The Find Me Rules page displays all of the options available for that location. It is important to note that this section will 
configure how the Auto attendant will behave for incoming calls. However, it is necessary to set the current location as well as 
availability. Refer to page 135 of the Client Applications Guide for further details on these settings.

 Note: In order for users to have access to the Web Access, two settings need to be configured in OL Admin: 
1) Enable Web Access User under Mailbox > Advanced, and
2) Select Web Access under Feature Group > Mailbox Options. 
If you do not have access to the OL Admin console, please contact your System Administrator.
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Addresses

Addresses are an important part of the find me follow me feature, and are necessary when configuring the locations where 
the program will call the user. Addresses in this context refer to internal and external phone numbers where calls will be 
directed based on the rules and configuration selected.

It is important to first define the addresses or numbers where the user can be reached for various locations in order to 
configure the find me follow me features. 

Addresses can be added, edited and deleted on the Addresses page of the Web Access. Addresses can be internal (such as 
a desk phone extension) or external (such as a cell phone or phone number off site).

To set your current location using Web Access, click on the Current Location icon. 
Enable Override my locations calendar and set my current location. Set your location and availability from the 
dropdown menus.

In order for outside calls to be dialed by the voice server, configure outcalling through Windows Control Panel > Phone 
and Modem Options and make sure the local area code is selected. 

If the call will be forwarded to a long distance number, enable Long Distance under Feature Group > Notification 
Options for the group containing the member.
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Configuring Find me Follow me features

There are several pre-defined options for the Auto attendant to automatically find a user by forwarding calls to a range of 
numbers, either internal or external. Click on the Find me rules tab and select a rule and option:

Only call me at the first number assigned to this location

Select the option Only call me at the first number assigned to this location and then click on the General tab to go 
back to the list of numbers assigned to the location.

Using the up and down arrows , select the number you want calls to be forwarded to and move it to the top of the 
list.

Click on the Save and Close button
The Auto Attendant will call only the number on top of the list of numbers assigned to that specific location. If there is no 
answer at that extension, the Auto attendant will play the location greeting configured. We can expect this behavior 
when calls are made to a DID or through the Auto attendant.

 Note: In order for this feature to work, the user must be set up to be in that location and Available. If the user 
is Unavailable the find me follow me feature will be disabled and the Auto attendant will play the location 
greeting.
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Call me at each of the numbers assigned to this location sequentially 

This rule gives the user 2 options: Automatically find me and Ask the caller to find me.

Automatically find me: 

On the Find Me Rules tab, select the appropriate options and then go to the General tab to arrange the sequence of calls:

On the General tab, add the addresses to the Numbers assigned to this location column and using the up/down arrows 
select the sequence in which you want to be found (from top to bottom).

Click on the Save and Close button

When a call is transferred by the Auto attendant or when a call is made to a DID that rings the extension directly, the Auto 
attendant will dial all the addresses in the list of numbers assigned to the location sequentially from top to bottom until the 
call is answered, if there is no answer in any of the numbers the call will be forwarded to the user’s voicemail.

If the default internal address of that mailbox is in the list of numbers assigned to the location, calls made to a DID will 
always ring that extension first regardless of where it is in the list, and then the Auto attendant will dial the rest of the 
numbers in sequence from top to bottom (bypassing the default internal extension)

 Note: In order for this feature to work, it is necessary to have at least 2 addresses in this column, otherwise 
there is no sequence and the find me feature will not be in effect

 Note: In order for this feature to work, the user must be set up to be in that location and Available. If the user 
is Unavailable the find me follow me feature will be disabled and the Auto attendant will play the location 
greeting. Also, if the phone is in DND, the unavailable greeting will automatically play and the find me feature 
will not come in effect.
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Ask the caller to find me:

This feature will play the unavailable prompt and then give the caller the option to locate the user or just leave a message.

On the Find Me Rules tab, select the appropriate options and then go to the General tab to arrange the sequence of calls:

On the General tab, add the addresses to the Numbers assigned to this location column and using the up/down arrows 
select the sequence in which you want to be found (from top to bottom).

Click on the Save and Close button

When a call is transferred by the Auto attendant or when a call is made to a DID that rings the extension directly, the Auto 
attendant will automatically dial the first address in the list of numbers assigned to the location, if there is no answer it will 
play a “no answer” and give the caller the option to locate the user or to leave a message. If the caller selects to locate the 
user the Auto attendant will dial the next number in the list, if there is no answer in any of the numbers the call will be 
forwarded to the user’s voicemail.

If the default internal address of that mailbox is in the list of numbers assigned to the location, calls made to a DID will 
always ring that extension first regardless of where it is in the list, and then the Auto attendant will dial the rest of the 
numbers in sequence from top to bottom (bypassing the default internal extension)

 Note: In order for this feature to work, it is necessary to have at least 2 addresses in this column, otherwise 
there is no sequence and the find me feature will not be in effect

 Note: In order for this feature to work, the user must be set up to be in that location and Available. If the user 
is Unavailable the find me follow me feature will be disabled and the Auto attendant will play the location 
greeting. Also, if the phone is in DND, the unavailable greeting will automatically play and the find me feature 
will not be in effect.
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Call me at all the numbers assigned to this location 
at the same time

When using this Find me rule, the Auto attendant will try to find the user at all 
of the numbers assigned to the location at the same time, either automatically 
or by giving the caller the option to locate the user. The caller will also be given 
the option to leave a message.

When this feature is selected it is necessary to specify the channels used for 
the broadcast in Company Properties > C.O./Channel Assignment.

Automatically find me:

On the Find me rules tab, select the Call me at all the numbers assigned to 
this location at the same time and the Automatically find me options, and then go to the General tab to choose the 
numbers the Auto attendant will dial:

On the General tab, in the right-hand column add the numbers that the Auto attendant will dial when trying to find the user.

Click on the Save and Close button

When a call is transferred by the Auto attendant or when a call is made to a DID that rings the extension directly, the Auto 
attendant will automatically dial all the addresses in the list of numbers assigned to the location simultaneously. If the call is 
answered and accepted in one of those numbers the calls made to the other numbers in the list will be dropped. If there is no 
answer in any of the numbers the call will be transferred to voicemail.

When a call is made to a DID and the default internal extension is in the list of numbers assigned to the location, that internal 
extension will always ring first and if there is no answer then the Auto attendant will automatically dial the rest of the 
numbers in the list simultaneously.

 Note: In order for this feature to work, the user must be set up to be in that location and Available. If the user 
is Unavailable the find me follow me feature will be disabled and the Auto attendant will play the location 
greeting. Also, if the phone is in DND, the unavailable greeting will automatically play and the find me feature 
will not come in effect.

3-5 3-5
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Ask the caller to find me:
On the Find me rules tab, select the Call me at all the numbers assigned to this location at the same time and Ask 
the caller to find me options, and then go to the General tab to choose the numbers the Auto attendant will dial:

On the General tab, in the right hand column add the numbers that the Auto attendant will dial when trying to find the user:

Click on the Save and Close button.

When a call is transferred by the Auto attendant, the first number in the list will be dialed, and if there is no answer the caller 
will be given the option to locate the user or leave a message. If the caller decides to locate the user, the Auto attendant will 
dial the rest of the numbers in the list simultaneously until one of the numbers answers and accepts the call. If the call is 
answered and accepted in one of the rest of the numbers, the calls made to the other addresses in the list will be dropped. If 
there is no answer in any of the numbers the call will be transferred to voicemail.

When a call is made to a DID we should expect the same behavior as above as long as the default internal extension is not 
on the list of numbers assigned to the location. If the default internal extension is in the list of numbers assigned to the 
location, that internal extension will always ring first (regardless of the order in the list) and if there is no answer in the 
internal extension, the caller will be given the option to locate the user or leave a message.
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Property Management System
Introduction
This guide provides an overview of the Property Management System Interface for Officelinx 9.1 SP1.

The Property Management Systems (PMS) is an add-on module for the Officelinx platform. The PMS acts as a bridge between 
a hotel’s 3rd-party application and the Officelinx voice server.

A typical third-party PMS application gives hotel employees control over their guest database (check-in and check-out, for 
example). Any hotel that uses their third-party application with an Officelinx voice server uses PMS to enable communication 
between the two.

Check-in overview
The following steps detail a typical PMS check-in scenario:

1. User checks into hotel.
2. Hotel employee checks user into room and saves user info using PMS application.
3. The hotel’s PMS application sends “check-in” packet (room, guest name, etc.) to the Officelinx PMS service.
4. Using EEAM, Officelinx PMS creates new mailbox or updates an existing mailbox.

Supported Vendors
The following PMS vendors are supported by the Officelinx Property Management System:

 Warning: The Property Management System feature of Officelinx is not supported under a High Availability (HA) 
environment.

Hotel PMS 
application PMS Service EEAM/Voice 

Server
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PMS features
The Officelinx Property Management System provides the following features:

 When a Check-In function is performed on an extension, the mailbox is automatically logged in and the tutorial is 
activated. The first time a user calls into their mailbox, they are greeted with a welcoming tutorial.

 When a Check-Out function is performed, the mailbox logs out and automatically re-routes messages that have not 
been deleted to a phantom mailbox. Messages can still be retrieved from this storage mailbox.

 When a user accesses their mailbox, new messages will play automatically, and users can save or delete them. This 
option can be changed so that a default action, either save or delete, is performed once the message has been played. 

 When users access their mailbox, they have the option to save, delete or review their messages, or listen to the time 
and date the message was received. 

 Users can listen to voicemail commands and options in a language other than English

 Housekeeping can call from a room and report on the room’s status. Also can use the LAP 
module, in order to have housekeeping paged through the hotel over a wireless 
transmitter.

Connections
You establish a connection between a 3rd-party hotel application and the PMS service using a serial port or a TCP/IP 
connection.

If you are using TCP/IP, the hotel application acts as a server by listening for incoming connections on a particular port. The 
PMS server acts as a client by connecting to the specified port.

Supported functions
The interfaces listed in the following table may or may not be supported, depending on the PMS protocol being used. If a PMS 
can only partially support an interface, then only supported messaging can be used.

Function Description

Check-In A message is sent when a room changes from Vacant to Occupied. The voice 
mailbox is turned on. This message is not sent for Shares.

Check-Out A message is sent when the last account has checked out of the room. The voice 
mailbox is turned off.

Room Change A message sent on a room change.

Room Merge A message sent on merging a room.

Room Reset A message is sent to reset the room to default values.

Name Change A message is sent to indicate the changing of a guest name.

Message Lamp On A message is sent to the VM to activate the Message Waiting Indicator in the 
room.

Message Lamp Off A message is sent to the VM to deactivate the Message Waiting Indicator in the 
room.

Set Wakeup Call A message is sent to request a wakeup call at a defined time and date.

Clear Wakeup Call A message is sent to cancel any existing wakeup calls to the room.

Maid Status A message is sent to PM when the maid enters a code on the phone in the room.
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Maid Status

The Voicemail server will send a room status message to the Property Management server when a maid inputs a code on the 
phone in the room. The following Maid Status Codes are recognized by the PMI:

The PMS will update the room status for only the values listed above. All other values will be ignored. The hotel staff will need 
to be instructed on how to enter the maid status information from the telephone in the room.

 Note: The Property Management System service is the means by which a hotel’s third party PMS acts together 
with the Officelinx Voice Server.

 Note: The Property Management Interface is what the User interacts with when using the PMS, depending upon 
the protocol supported.

Code Description

CL, AV, 1 clean

DI, NA, 2 dirty

MI, 3 questionable

(start of text) (Ascii 2)

(end of text) (Ascii 3)

(inquiry) (Ascii 5)

(acknowledgement) (Ascii 6)

(non-acknowledgement) (Ascii 15)

(carriage return)

(line feed)

(denotes the separator) (Ascii 28)

(block check character)
This symbol will follow the ETX character and is unique for each string.

 Note: The following protocols support Maid Status: 
AVT, RAMESYS, MCORP, FIDELIOXPRESS, COMTROL, PMS1, PMS3.
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Message type examples
The following are examples of each message type.

From Property Management Interface:

Check-In John Smith into Room 123, password 1111, Language 1

<STX>CHKIN  123  SMITH, JOHN  1111  1  <STX><BCC>

Check-Out Room 123

<STX>CHKOUT  123  <STX><BCC>

Room Change John Smith from Room 123 to Room 456, password 1111, Language 1

<STX>ROOMCHG  123  456  SMITH, JOHN  1111  1  <ETX><BCC>

Room Merge room 123 and 456

<STX>ROOMMRG  123  456  <ETX><BCC>

Reset Room 123

<STX>ROOMRST  123  <ETX><BCC>

Change Name on Room 123 to Tom Jones, Language 2

<STX>NAMCHG  123  JONES, TOM  2  <ETX><BCC>

Set or Cancel MWI on Room 123

<STX>MSGON  123  <ETX><BCC>

<STX>MSGOFF  123  <ETX>BCC>

Set or Cancel a Wakeup Call for Room 123

<STX>WAKESET  123  0630  <ETX><BCC>

<STX>WAKECLR  123  <ETX><BCC>

From Voice Mail Server:

Maid Status for Room 123 to 1

<STX>MAID  123  1  999 < E T X > < B C C >
Additional CSTA Functionality*
*Available if your PBX CTI can support them.  Panasonic supports all additional functionality.

Display

 At Check-In, the guest name will be automatically shown on the telephone display in the appropriate room. 

 At Check-Out, the guest name will be cleared to show a blank screen on the telephone display in the appropriate room. 
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Class of Service

The Check-In and Check-Out services can be defined in the registry settings as follows:

 HKEY_LOCAL_MACHINE\System\CurrentControlSet\Tolee (UCP, MN6510UC)\General Settings\CheckIn ClassOfService 
Number (REG_SZ) 

 HKEY_LOCAL_MACHINE\System\CurrentControlSet\Tolee(UCP,MN6510UC)\General Settings\CheckOut ClassOfService 
Number (REG_SZ)

 Class of Service for Check-In = 2

 Class of Service for Check-Out = 7

Wake-Up Call

 When the guest has requested a wake-up call on the system, the switch will handle the action rather than the Officelinx 
software.
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Setting up PMS integration

There are 4 steps to a successful integration.

Step 1 - Verify connections
The Hospitality Server couples to the voicemail system via the PBX (incorporating a serial link through the serial port). The 
type of integration between the voicemail server and the PBX depends solely on the PBX. 

In the following example, the switch sends Inband digits:

 Warning: The Property Management System feature of Officelinx is not supported under a High Availability (HA) 
environment.

Create mailboxes 
and assign 

feature groups

Verify 
connections

Specify config 
settings

Record 
prompts

1 2 3 4

Hospitality
Server

PBX

Officelinx
Voicemail System

Check In/Out

RS-232 RS-232

Inband Integration

Receptionist

Admin Phones

Room
Ext.

Room
Ext.

Connecting the Hospitality Server and the Voicemail System
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Step 2 - Specify PMS configuration settings
Perform the following procedure to allow interaction with the PMS for hotel applications.

To specify PMS configuration settings:

1. Open the Officelinx Admin console.
2. In the Admin tree (left hand pane), expand Configuration, and right click on Device Management.
3. From the menu, select New > PMS Device. The following screen appears.
4. Specify the following:

 From the COM Port Number dropdown list, select the port where your 
PMS device is connected.

 In the TCP/IP Address text field, enter the TCP/IP address where 
your PMS device is connected.

 In the TCP/IP Port text field, enter the TCP/IP port number where 
your PMS device is connected.

5. Click Settings and the PMS Settings dialog box appears.

6. Specify the following:
 Select the PMS Installed checkbox if a Proprietary 

Management System is installed.
 Enable Welcome Message Active to activate a welcome 

message in a room voicemail every time a room is reset.
 In the PMS Mode text field, specify the mode to use.

 In the PMS Type text field, indicate the type of serial port 
protocol to use (i.e. Fidelio, Lanmark, or CAPA).

 In the Polling Interval text field, enter the time interval - 
measured in seconds - to poll the COM port for PMS events. The default value is 5.

 In the PMS Shared Directory text field, enter the directory path where the PMS stores its files so that Officelinx 
may access them.

 In the Local PMS Shared Directory text field, enter a local directory where these files are stored.
 In the Auto Action On Message text field, specify an automatic action the system will perform when a message is 

received.
 In the PMS Check Out Message Destination text field, specify the integer value that will be placed before the 

mailbox number of a departed client.

7. Click OK twice.

 Note: PMS settings allows you to control the 
information that the UC Server receives from the 
Property Management software. 
See Settings for your PMS package on page 250.

 Note: This field is content-sensitive. Make sure not to 
misspell the mode.

 Note: This feature applies solely to hotel applications. It will create a phantom mailbox where 
messages will be forwarded for a client to retrieve. For example, if the PMS Checkout Message 
Destination value is set at 7 and a customer checks out from room #197, messages can still be 
retrieved from phantom mailbox 7197 until the next checkout action from that room. The next person 
to check out of room #197 will overwrite the old mailbox with the new one.
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Settings for your PMS package

The settings for the Hospitality packages currently supported are almost identical. The settings that remain the same for all 
are:

PMS Installed = Enabled

PMS Mode = Serial

Settings that depend upon the connection type, and may differ between systems are:

 Com Port Number = 1 (may be any available Com Port number)

 Device serial communication settings = 9600 / None / 8 / 1

 PMS Check Out Message Destination = 7 (varies by customer preference)

 Auto Action On Message = Save

 Note: For Landmark, Capa, and Fidelio, the PMS Type is set to Alcatel, but for MSI the Type is AVT. See below.

 Note: This field tells the voicemail system to automatically perform the specified action after each message is 
played. The options are Save, Delete, and None.
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Step 3 - Create mailboxes and assign feature groups
Now setup mailboxes and associate them with feature groups. You will need to create 2 feature groups.

Feature Group 1 - for room mailboxes

1. In the Admin tree (left hand pane), expand Company and highlight Feature Group.
2. Right click on Feature Group and select New > Feature Group. The Feature Group screen appears.
3. Click on the Notification Options tab.

4. Enable Message Light Activation to employ the message waiting light feature. Enabling the checkbox activates:
 ON For All Msgs to indicate that the message light on code will be set for all messages.
 OFF For All Msgs to indicate that the message light off code will be set for all messages.
 OFF When No New Msg to indicate that the message light off code will be set only when there are no new 

messages in the user’s mailbox.
 No of ON Retries - enter the number of times the system will retry message light activation.
 No of OFF Retries - enter the number of times the system will retry message light deactivation.
 ON Between Retries - enter the time (in minutes) to wait between retry attempts to activate the message light.
 OFF Between Retries - enter the time (in minutes) between retries to deactivate the message light.
 ON Code - enter the code to turn on message waiting lights.
 OFF Code - enter the code to turn off message waiting lights.

 In the Channels text field, enter the channel number that will be used to send message light notification.

 Note: The ON Code and OFF Code fields should be used in situations where the code is too long to be 
input in the ON Code field in the PBX Message Light tab (usually MCI). In addition, for multi-PBX 
configurations different codes must be used for different PBXs. In this situation, certain feature groups 
can be assigned to a message waiting light code that reflects the different PBXs being used.
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5. In the Message Light Type feature box, select the checkbox that indicates which message type is to be associated with 
the message lights:
 Select the All checkbox for all messages.
 Select the E-mail checkbox for email messages only.
 Select the Fax checkbox for fax messages only.
 Select the Voice checkbox for phone calls only.

6. In the Outcalling Options feature box:
 Select the Beeper checkbox to allow the system to notify a user via beeper, voice pager, or alpha-numeric pager 

when a message is recorded to the user's mailbox. 
 Select Outcall checkbox to allow the system to notify a user at a specified telephone number when a message is 

received to the user's mailbox.

 Select the Long Distance checkbox to allow long distance telephone numbers to be dialed for notification.
 Select the E-mail checkbox to have the system send an email when a user receives a message, and the type of 

message.
7. In the LAP Options feature box:

  Select the LAP For Message checkbox to  ; In the Template text field, enter   OR
 Select the LAP For Call checkbox to ; In the Template text field, enter

8. Click on the Save Feature Group button.

You will now create a mailbox for each hotel room. It is important that you:
 make sure the Ask for Password checkbox (Feature Group > Mailbox Options) is deselected.
 link each mailbox to the feature group you have just created.

For in-depth information on setting up feature groups, refer to the Officelinx Server Configuration Guide.

 Warning: If the telephone number is long distance, the "Long Distance" checkbox must also be checked 
to allow long distance dialing. 

 Note: All other feature group options are set at the discretion of the system administrator.
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Feature Group 2 - for storage mailboxes

The second feature group you create will be associated with the mailboxes that store the messages that are not deleted when 
a user checks out of the hotel. These mailboxes will start with the digit you specified in the PMS Check Out Message 
Destination field, back in your configuration parameters (Device Management Settings > PMS Settings).

For example, if you set the value in that field at 7, messages from mailbox 237 (room 237) will be automatically moved to 
mailbox 7237 when a user checks out.

You would have a 3-digit mailbox assigned to each hotel room and a 4-digit "phantom mailbox" to complement it.

1. In the Admin tree (left hand pane), highlight Feature Group.
2. Right click on Feature Group and select New > Feature Group. The Feature Group screen appears.
3. Click on the Notification Options tab.
4. Deselect the Message Light Activation checkbox.
5. Click on the Mailbox Options tab:

6. Hit the Save Feature Group button.

You will now create a storage mailbox for each of your existing room mailboxes. Assume that you have mailboxes for 
rooms 100-119, 200-219 and 300-319. If, back in Device Management Settings > PMS Settings, you entered a 7 in 
the PMS Check Out Message Destination field, you will create new storage mailboxes starting with 7. Therefore, your 
first mailbox would be 7100, then 7101, following that 7102, and so on.

 Note: All other feature group options are set at the discretion of the system administrator.
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Step 4 - Record prompts
The C:\WINVM\MESS820.VOX prompt exists specifically for use with PMS integration.

For information on re-recording prompts, refer to the Officelinx Server Configuration Guide.

Prompt 820 is a welcome greeting that says:

"Welcome to your voice mail. Your mailbox is where your messages will be stored. It is simple to use. If you have any 
questions about using your mailbox, please contact the front desk."

 Warning: PMS is a feature that is purchased separately. Please contact your Sales Representative for further 
details.
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Mass Recall
Introduction
Officelinx has built in capability for broadcasting messages in case of emergency. For some markets, such as the prison 
system, health care system, etc., this is known as Mass Recall. The primary function of Mass Recall is to send emergency 
messages to a set of mailboxes, which in-turn activates the broadcast functions setup in the destination mailboxes.

This chapter outlines the steps to configure the Officelinx Server to use Mass Recall. For an actual implementation of Mass 
Recall, please refer to Mass Recall Example on page 262.

Visual Guide

When an emergency occurs within an organization, assigned personnel may initiate a Mass Recall by recording a message for 
broadcast. Once initiated, Mass Recall will start calling everyone on the list with the recorded message. Once the necessary 
people have responded and reported into the organization, the initiator of the Mass Recall cancels the action which prevents 
any further dialing.

By utilizing this tool, an organization can easily reach on-call or emergency staff members should the need arise.

Requirements

 Note: In the Admin, Advanced > Mass Recall Installed must be set to True.

 Note: In the Admin, LOG > Log Mass Recall must be set to True.

Requirements Details

License ---

Software Officelinx version 8.5 or higher
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Server Configuration
There are 2 ways to leave a message for Mass Recall:

 Message as an outside caller that is left to a mailbox predefined for Mass Recall.

 Message sent by a user while logged in to their mailbox. This method requires the TUI assigned to the user’s mailbox to 
have the ability to flag messages for Mass Recall.

Message as an outside caller
1. To create a Voice Menu, right-click on the Voice Menu icon, and select 

New > Voice Menu.

2. Name the Voice Menu Mass Recall. 

If an initial greeting should play before sending a Mass Recall 
message, select the greeting from the Sub Menu Phrase dropdown 
list. If not, then set the Phrase to Nothing.

3. From the list of Actions, select Send a Mass Recall Message and 
drag this to the DTMF key it is to be assigned to. 

In this example, by assigning this to Default, the Mass Recall action 
will be triggered at the end of the greeting.

4. Double-click on the action, and select the mailbox or destination for 
the Mass Recall Message.

Click OK.

5. Click Save. 

6. Right-click on Mailbox Structure, and select New > Mailbox.
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7. Assign a Mailbox Number.

Enter a First Name and Last Name.

Leave the user name and password fields blank.

8. Go to the Advanced Tab and enable Voice Menu. Use the dropdown 
list to find the Voice Menu for Mass Recall.


Click Save. 

9. In the destination mailboxes for the Mass Recall messages, as defined 
in the Voice Menu, you must define the notification rules to enable 
notification to each destination. Refer to the Server Administration 
Guide to configure notification. 

In this example, Mailbox 3000 must be properly configured for 
notification.

 Note: This mailbox will be the main mailbox for Mass 
Recall. To cancel Mass Recall messages sent via the Voice 
Menu, log into this mailbox to cancel.

I Warning: There must be at least 1 notification address 
listed in order for it to qualify for a Mass Recall.

Recall

ass

911

911: Mass Recall

911: Mass Recall

3000

Internal Extension  3000
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Message sent by a user from their Mailbox
1. The Customized TUI of the user must have a Send Message Menu 

which offers the option of setting the Mass Recall flag. 

Double-click the default for your Company to open the Properties 
window.

2. Click Customize TUI.

3. Find your default menu and verify that it is checked.

Highlight the menu and click OK.

4. Select the Send Message Option.

You can see the Next Sub Menu is number 6. 

Go to Sub Menu 6.
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5. Make sure there is an Action to Toggle Mass Recall. 

If not, select Toggle Mass Recall from the list of actions, and drag it 
to a DTMF Key.

6. To send a message from a mailbox, the user must first log into their 
mailbox on the phone. To login, dial the access number to reach the 
main company greeting. Press #, then enter your mailbox 
number and password. Send a message normally. To mark the 
message for Mass Recall delivery, choose the Mass Recall Toggle 
action at the end of the message.
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Activating Mass Recall Logs
The Mass Recall Logs allows you to keep track of events related to the Mass Recall function.

1. From the OL Admin program, go to Configuration > Advanced. 
Locate Mass Recall Installed item from the right pane and make sure that it is set to True. 
Double-click the item and change the value if it is shown as False.

2. Once set, click on Logs in the left-hand menu. 
In the right-hand window, set Log Mass Recall to True.

3. Once the logging becomes active, Mass Recall will create a log file named Mrecall.log in the UC\Logs folder. This log 
may be opened by any type of text editor.
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Mass Recall Example
The following is a sample of Mass Recall configuration and usage. 

Mass Recall Destination Mailbox
The following are the extensions/mailboxes that are the target of the Mass 
Recall. The extensions are organized into Distribution List (DL).

 DL 912 - All Staff:
EXT 200, 201, 202, 203

 DL 913 - Executive Staff:
EXT 200, 201, 202

 DL 914 - Daily Staff:
EXT 200, 201

 DL 915 - Managers:
EXT 200





The contact in the Mass Recall Distribution Lists must have external phone numbers available as a Notification Address as 
shown. You must also ensure that the Notification Schedule is setup so that it is always active. When configuring the 
Notification Schedule please configure as shown below.

200

External Extension  1 (905) 7079700
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Each Distribution List created must be connected to a mailbox in order for Mass Recall to access it. 
Create a mailbox with the same number as the DL (i.e. DL 912 will be connected to mailbox 912).

Each mailbox created for this purpose must be configured as follows:

 Destination Type: Target Distribution List

 Forward Type: Relay 

 Message Type: Voice

This process will be repeated for mailbox 913, 914 and 915. The only difference between the configurations will be the 
Distribution List selected.

With this setup, Mass Recall can target specific groups depending on the event requiring Mass Recall. Once the Mass Recall 
destinations have been defined, you must create a mailbox to utilize the Mass Recall function.

 Hint: The Distribution List number and the mailbox number do not have to match for this function to work. It is 
done here to make keeping track of things easier.

912: All Staff

Distribution List 912: All Staff      Relay                  Voice
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Mass Recall Activation/Cancellation Mailbox
Create and use mailbox number 911 as a point of access to the Mass Recall function.

1. Create mailbox 911.
2. The user initiates Mass Recall by accessing the voice menu of mailbox 911. The voice menu is configured to ask the user 

for a password. Once the password is accepted, the user is sent to the sub menu with access to the following:

 Press 1 to recall All Staff (DL/mailbox 912)
DTMF digit 1 is set to Send a Mass Recall Message mailbox=912 Mass Recall All Staff

 Press 2 to recall Executive Staff (DL/mailbox 913)
DTMF digit 2 is set to Send a Mass Recall Message mailbox=913 Mass Recall Executive Staff

 Press 3 to recall Daily Staff (DL/mailbox 914)
DTMF digit 3 is set to Send a Mass Recall Message mailbox=914 Mass Recall Daily Staff

 Press 4 to recall Managers (DL/mailbox 915)
DTMF digit 4 is set to Send a Mass Recall Message mailbox=915 Mass Recall Managers

3. Create a Custom TUI for mailbox 911 to have the option of cancelling the Mass Recall.

 Press 1 to Cancel Mass Recall
Upon the cancellation of Mass Recall we need to disconnect the user from the telephone. To do this we will add the 
following option as well.
 Press # to Send to Sub Menu 1.
The Default Action of Sub Menu 1 will be Disconnect, and the Number of Retries will be set to 1 to disconnect the user 
right after they enter the Sub Menu 1.
 Record a voice prompt for the Custom TUI that states “Press 1 then # to cancel the Mass Recall”. When the user 

follows the action, they will cancel the Mass Recall by pressing 1 then become disconnected from the system by 

 Note: You should also record a greeting/salutation to attach to the Voice Menu as well. Having this 
prompt will allow the Mass Recall system to be more user friendly.

 Note: You should also record a salutation to attach to the Custom TUI. Having this prompt will allow 
the Mass Recall system to be more user friendly.
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pressing #.

4. Attach the Voice Menu and Custom TUI to mailbox 911.

5. Set the mailbox to be Unavailable. This allows users to leave a message immediately after calling the mailbox, then send 
that message to the target Mass Recall list through the voice menu.
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Mass Recall Activation
In a typical scenario:

1. The user calls mailbox 911...
2. enters the access code defined in the Voice Menu configuration...
3. and records the message that is going to be sent out to the Mass Recall distribution list members.
4. Once the recording is complete, the user is given 4 options. The user presses the DTMF key according to the Distribution 

List that he/she wishes to initiate a Mass Recall for.
5. The user pushes 1 to send the message. The user hangs up the phone after the confirmation message is heard. The Mass 

Recall is now active.


Mass Recall Cancellation
1. The user logs into mailbox 911 to access the Custom TUI.
2. After listening to the prompt, the user pushes 1 then # to cancel the Mass Recall.

The user is disconnected from the mailbox and all remaining Mass Recall activity is cancelled.
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Outcall Task Manager (Absenteeism)
Introduction
The Outcall Task Manager in Officelinx can be used to make automated calls to any designated number, both internal and 
external. The Outcall Manager may also collect DTMF response from the receivers.

A typical scenario for Outcall Task Manager is a school verifying a list of absent students. A staff member can place a list of 
students that are absent into a database using a CSV (comma separated value) file, which can be automatically exported 
from a spreadsheet program. Alternatively, each of the student’s information can be entered manually into the Outcall Task 
Manager.

Once the list has been created, the staff member must also create the greetings, DTMF responses to be accepted, and 
schedule the outcall. When ready, the Outcall Task Manager will start calling everyone on the list, and will keep a log of all the 
responses received for each call.

Visual Guide

Requirements

Requirements Details

License License to enable Outcall Task Manager

Software Officelinx version 8.5 or higher
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Server Configuration
Outcall Task Manager is a stand alone program that resides on the server computer. For this reason, and due to the nature of 
automated outcalling, it is best to limit user access to Outcall Task Manager.

Creating an Outcall List
Launch the Outcall Task Manager. The following window will appear.

Import from File

Click on the Import from File button. The following window will appear.
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Select the CSV formatted text file to be imported then click OK. The outcall list will be populated from the file.

Open File

Click on the Open File button to check the contents of the text file before you import it. Clicking on the Open File button 
opens the file selection window.

Choose the CSV formatted file and click Open. The default text editor will open the target text file.

The CSV file may be exported from a spreadsheet program. The first entry is the phone number for the outcall. The 
second is the student’s name, and the third is the parent’s name. The last entry signifies the student’s gender.
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Add an Entry Manually

Enter the phone number to be called in the Phone textbox, then click Add.

Enter the student and the parent’s name. The default gender of the student is male. Enable the Female checkbox will 
designate the student as female. 

Click OK when finished.

Setting the Outcall Schedule

You may specify the outcall times so that the call task ends at the end of the day. To specify the start and end times, click on 
the ellipsis (...) beside the Start and End times. The calendar dialogue will open.

Select a specific date and time from the calendar to start/end outcalling. 

Click OK to add the selection to the schedule.
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Creating a Custom Outcall Message

You may create a custom outcall message through the 
absence.ini file. The contents of this file will be spoken to 
call recipients using TTS (text-to-speech). 

To create a custom outcall message, click on the View INI 
File button. The following window will appear.

Under the Absence Reason section, create a list of responses 
that the call receiver can enter. These entries must follow the 
format #=message. The list created here will be spoken to 
the call receiver in the format of Press 1 if he/she is Sick, 
Press 2 if he/she is On Vacation and so on. You may only use 
single digit numbers to receive a response. This limits the 
number of responses to 10 (0 - 9).

The greeting section holds the text of the greeting and the good bye messages. The text typed after Greeting Text= will be 
spoken to the call receiver. The string <NAME> may be inserted in the greetings to customize each message for the receiver. 
This string will be automatically replaced by the current student’s name. The string <DTMF> at the end will invoke the list of 
responses defined in the Absence Reason section.

Goodbye Text= is the response given to the call receiver once they have given a response.

 Hint: Having no <DTMF> string at the end will suppress the reading of the Absence Reason list. Use this option 
if you want to include the reasons within the greeting itself.
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Managing the Outcall Tasks

Once the list has been completed, click on the Create Outcall Task button. The outcall list will be generated using the 
database shown in the left-hand window. The outcalls will begin and end at the designated times. 

For additional outcall management and configuration, refer to the list below.

 Pause: This button will pause the outcall task.

 Refresh: This button will refresh the list of outcalls.

 Clean outcall Tasks: This button will delete all pending outcalls that are on the list. 

 Delete Duplicate tasks with same phone numbers and names: Enable this option to eliminate any duplicate entries 
among the pending outcalls.

 Channel Range: You may configure the range of channels that the Outcall Task Manager can use depending on your 
usage. For example, if you need to make as many calls as possible at once, you may allocate most of the channels to the 
task, but if you need to use your phone system you may allocate only a few channels to the Outcall Task Manager so that  
regular phone service is not interrupted.
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The Response Log


The Outcall Task Manager keeps a log of all the outcalls that are made. This log is especially useful if you are requesting a 
response from recipients since all reponses are included in the log. To view the logs, click on the View Log File button. 

The log file will be opened by the default text editor.

The information shown is in the following order:

 Call Time (13:50:35.367)

 Channel Used for Outcall (CH:001)

 State (State 3) *this information is for development purposes and may be discarded

 Phone Number Called (1235551234)

 Name of Student (Tom Doe)

 Type of Response (Responded:2 [On Vacation])
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Multiple Time Zone Support
Introduction
Esna’s Officelinx has built in mail capabilities, including Unified Messaging integrated to multiple mail environments. Since 
many of our customers have implemented the Esna’s Officelinx as a centralized messaging platform, it is desirable to offer 
users who access Esna’s mail components to be presented their messages in their time zone.

The following document outlines the steps to configure the UC Server to use this functionality.

Visual Guide

When you configure the multiple time zone support feature for your users, they will be able to access their messages 
anywhere around the world and see the messages in relation to local time rather than the server’s time. This will reduce any 
confusion over when the message was received and offer the users a care-free user experience.

Requirements

Requirements Details

License ---

Software Officelinx version 8.5 or higher
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Server Configuration
With Officelinx installed on the server, you will need to edit the EEAM.INI file, located in the WINDOWS folder of your system. 

General Settings

1. Go to Start > RUN, and type EEAM.INI in the space provided.
Click OK.
NotePad will open and display the contents of the file.

2. Add the following line to the EEAM.INI file:
 Honor Timezone for Message = 1

3. Save the file, and close the editor. RESTART the PC for the change to take effect.

Your system is now ready to manage multiple time zones.

The Time Zone feature supports:

 All Messages presented via any device will be in the user’s local time.

 Call History will be presented in the user’s local time.

 Calendar events made using Outlook will be retained in the user’s local time as defined by their Location Calendar. For 
example, if the user’s PC where Outlook is running is set for Eastern time, but the Location Calendar is defined as Pacific, 
then any appointment created by the client from Outlook will be offset from Eastern time to Pacific, as specified by the 
user’s Location Calendar.

The Time Zone feature does NOT support the following:

 Notification schedules – any schedule defined must be defined in the Server’s time. For this reason, the web access will 
now show the server’s time in a window to assist the user.

 Future message delivery – message delivery must be defined in the Server’s time.

 Wakeup Call – All events must be defined in the Server’s time.

 Any other function where time and date are entered by the user.

I Caution: In order to specify your time zone, you will need to edit your Location Calendar. Each time you access 
your mailbox, either through the phone, the web or any other component, your CURRENT time zone will be 
determined by your active location calendar. Make sure this is specified.

 Note: If the user does not have access to the Web Access to specify their location calendar, an Administrator 
will need to set this using OL Admin.
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Remote Administration
Introduction
Remote Admin allows system administrators or support personnel to remotely access Officelinx Admin from their own 
workstation, eliminating the need to be in front of the server in order to perform administrative functions.

Visual Guide

Requirements

Requirements Details

Software Microsoft Windows 2003, XP (SP3), 2008, 7 (must be 
32bit OS)

Network Workstations where remote admin is installed must be 
within the same network domain as Officelinx server

 Warning: Utilizing remote admin means that more than one person may be managing the database. If two or 
more people make changes the same entry, initial changes may be overwritten without notification.

 Note: Maximum number of people that can connect through remote admin is 5.
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Installing Remote Admin
Remote admin must be installed on each workstation where remote admin is to be used.

1. Insert the Officelinx installation DVD. Locate and run (double-click) the file \RemoteAdmin\RemoteAdmin.exe.
2. The Remote Administration Installation Wizard will start. 


Click Next to begin the installation.

3. The install wizard will examine the system for the necessary drive 
space, and it will install and missing programs.

4. When ready, the wizard will prompt to continue with the installation.

Click Next to continue.
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5. Remote Administrator will be installed on the system.

6. When finished, the wizard will report that the installation was 
successful.

Click Finish to complete the installation.

Remote admin is now ready to be used. A shortcut will be placed on top of your Windows desktop to access the program.
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Connecting to Remote Admin
To connect to OL Admin remotely, you will need the login credentials and the name of the Officelinx server.

1. Run the OL Admin shortcut from the desktop. The OL Admin login screen appears.
2. Enter the User Name and Password in the appropriate fields.
3. In the UM Server Name field, enter the name of the Officelinx server that you want to 

access. 
Click OK.

4. You will be remotely connected to the OL Admin of the remote server.

I Caution: The computer launching Remote Admin must be a member of the same domain as the Officelinx 
server in order to make the connection.
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Remote Printer
Introduction
The Officelinx Remote Printer feature allows system administrators to remove printing functions from the voice server and 
move them to another computer. This reduces the demand on the voice server CPU allowing for greater speed and efficiency 
in processing voice data.

Remote Printer also permits the use of existing licenses for software that is not installed on the voice server. For example, 
MSOffice and Adobe Acrobat must be installed on the voice server if faxes are to be sent in any of their supported formats 
(doc, docx, pdf). Using Remote Printer to redirect this traffic to a machine that already has the necessary software installed 
removes the need for additional licenses to be consumed by the voice server.

Remote Printer is included on the DVD with the standard release of Officelinx. It is installed by default as part of Officelinx 
Admin. The Remote Printer program must be installed on the host, and the settings on the voice server must be changed to 
point to the host machine.
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Remote Printer Host Installation and Setup

The following instructions must be performed on the computer that is to act as the remote printer host.

1. Run the UCPrint.msi program. This can be found on the Officelinx DVD at: 
D:\UC\UCPrint (change “D:\” to the correct location of your DVD drive).
Double-click this file to start the installation.

2. The installation wizard will start. 
Click Next to continue.

3. The wizard will install the program. 
When ready, click Finish.










 Note: Officelinx must be installed and properly configured on the voice server before proceeding with the 
Remote Printer host installation. Refer to the Server Installation Guide and Server Configuration Guide for more 
information.
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4. Go to Start>Administrative Tools>Services and verify that the UC Remote Printer service is installed and running. 
This service should be configured to start automatically.

5. Go to Start>Run and type regedit in the text entry box. Click OK.
6. On the left pane, navigate to either: 

HKEY_LOCAL_MACHINE>SOFTWARE>Generic>EFSP (for 32-bit operating systems), or 
HKEY_LOCAL_MACHINE>SOFTWARE>Wow6432Node>Generic>EFSP (for 64-bit operating systems).

 Note: The Log On As account should be the same as that used during the installation of MS Office or 
Adobe Acrobat Reader.

32-bit Operating System Path 64-bit Operating System Path
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7. In the right pane, double-click UMSTServer and enter the IP Address of 
the Officelinx server for the value data. Click OK and close the regedit 
screen.







The client side configuration is complete. Proceed with the setup of the Officelinx voice server.
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Officelinx Voice Server Remote Printer Setup
The following instructions are performed on the Officelinx voice server.

1. Go to Start>Administrative Tools>IIS Manager. Verify that FTP is installed and running. This should already be 
setup as part of the Officelinx installation.

2. Open Officelinx Admin and click Print 
Server.

3. Right-click on Print Server and choose Add.

4. Fill in the required fields.

Description: Enter a descriptive name for the remote print server.
Workstation Name: Enter the PC name or the IP Address of the remote printer 
host computer.
Available: Enable this checkbox.

Click OK when finished.

5. In the right pane, double-click the local print 
server and disable the Available checkbox. 

Click OK when finished.










6. Go to Start>Adnministrative 
Tools>Services and disable the UC Remote Printer service.

 Note: These instructions assume that Officelinx has already been installed and configured on the voice server. 
For details on the installation and setup of Officelinx, please refer to the Server Installation Guide and the Server 
Configuration Guide for details.
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7. Go to Start>Administrative Tools>Services. Stop then start the following services:
UC Unified Messaging System Tasks Service and 
UC VPIMServer.

8. On the computer acting as the remote printer host, stop then start the UC Remote Printer Service.

The setup of the Remote Printer feature is now complete.
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Officelinx Faxing
Introduction
While most business interactions occur digitally, faxing still remains a required feature for many people. This is especially true 
when thee are technical limitations or legal requirements involved. Rather than having to purchase a fax machine to handle 
this traffic, UC users can conveniently send faxes from their computer desktop digitally through the Officelinx server with the 
proper license and feature set enabled.

Requirements
The fax may be sent out from your computer through the below methods:

 Windows Fax Services: Send virtually any item as a fax as long as the software you are using to view the document or 
image supports printing. You can send any content as a fax by printing it through the fax services integrated with 
Officelinx. However, this method requires some advanced configuration.

Refer to Fax via Windows Fax Services (Windows 7) on page 295 or Fax via Windows Fax Services (Windows 
XP) on page 300 for more information.


 eMail Client: The advantage of this method is being able to send a fax from anywhere there is access to email client. No 
additional configuration is required. Whether it is a web-based or a dedicated client, you can send a fax through the 
Officelinx server as long as there is access to email. However, you can only send files types that are supported by the 
server. If the server does not recognize a certain type of file (i.e. docx, pdf), the fax request will fail.

Refer to eMail to Fax on page 306 for more information.


 Fax Gadget: This method is similar to the email client but has been streamlined for use with the Web Access interface, 
either accessed directly or through client applications such as UC Web Gadget.

Refer to Sending a Fax through Fax Gadget on page 308 for more information.
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Fax via Windows Fax Services (Windows 7)

Configuration
Please follow these steps to configure your client machine with the Windows Fax services.

1. Launch the Programs and Features 
application within Control Panel.

2. Click on the Turn Windows features on or off 
link on the left-hand pane.

 Warning: This configuration must take place before installing iLink Pro Desktop. If iPD has already been installed, 
remove it, enable fax services, then reinstall the application.

 Warning: Only TIFF and TXT formats are supported by default. To send a fax in any other format, the computer 
must have the necessary program installed to support that file type (i.e. MicroSoft Office for doc and docx files, 
Acrobat Reader 9 (available on the Officelinx DVD) or earlier for pdf, etc.). Ensure that this software is installed and 
working (run at least once) before attempting to send a fax using that format.

 Note: Change your viewing style to 
icons to view the list of applications 
instead of categories.
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3. From the feature window, enable the following features. 

Print and Document Services
 Internet Printing Client
 Windows Fax and Scan

Click OK when you’re done.

4. Windows will start to add the selected components. This process may take a 
while.

5. If you are asked to restart your computer, click Restart Now to reboot.
6. Once the computer has restarted, install iLink Pro Desktop. 

Refer to the Client Applications Guide for more information.

7. When iLink Pro Desktop has been installed, go to 
Start > Programs and launch 
Windows Fax and Scan.

8. Go to Tools > Fax Settings...

 Note: If these services are already installed on your computer, skip 
to step 6.
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9. From the General tab, confirm that the Device name is EEFSP. 
If it is not, click on Select fax device... and choose it from the list.

You must also make sure that Allow this device to send faxes is enabled. 
Allow the device to receive fax calls should be disabled since faxes are 
received through the Officelinx server. Only enable this checkbox if you have a 
specific reason to do so.

Click OK to save your changes.

10. Open Tools > Fax Accounts...

11. Click the Add... button.

12. Select the Connect to a fax modem option.
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13. Give the connection a name. You may leave it at the default 
value, or change it according to your preference. 

In most cases this item should be the only device configured on 
your computer. If not, please ensure that 
Use by default for sending faxes radio button is enabled 
before continuing. 

Click Next when ready.

14. Choose the Answer automatically (recommended) option.

15. If you are prompted regarding your Firewall, click to 
Allow access at the bottom of the window.


Your computer is now ready to send fax messages. 

 Note: Keep in mind that you must be logged into iLink Pro 
Desktop to send faxes.
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Sending Fax from Application
Once your computer is configured for faxing, you can send faxes from any 
application that can print using the Windows printing tool. To send a fax, select 
Print from the application of your choice (e.g. Microsoft Office Word, Adobe 
Acrobat). The Print windows appears.

Select Fax as the print device, then click Print.

A new window will open to define the destination and any 
other components required for the fax. 

The document being sent as a fax will appear as an 
attachment.

Ensure that you enter the correct fax number on the To: field.
Set the Dialing rule to UC Location.

All other fields, such as Cover Page, Subject and Body are 
optional fields which you can utilize to customize your fax 
message.

When you are ready to send the fax, click the Send button.

The Fax status window will appear to notify you of the fax’s 
status. Once transmission has completed successfully, you will be 
notified here.

If the fax fails for any reason, the details will be shown here. Consult 
with your system administrator if you are having trouble sending faxes.

 Note: You must be logged into iLink Pro Desktop in order to send a 
fax.

 Note: You can track of all your outgoing faxes from the 
Windows Fax and Scan application available on the 
Start menu.
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Fax via Windows Fax Services (Windows XP)

Configuration
Please follow the below steps to configure your client machine for use with Windows Fax services.

1. Go to Start > Settings > Control Panel. Double-click Add/Remove Programs. 
2. Select Add/Remove Windows Components. 

3. Enable Fax Services. Click Next. 

4. Once the process is complete, you will have the ability to send faxes from your desktop.

 Warning: This configuration must take place before installing iLink Pro Desktop. If iPD has already been installed, 
remove it, enable fax services, then reinstall the application.

 Warning: Only TIFF and TXT formats are supported by default. To send a fax in any other format, the computer 
must have the necessary program installed to support that file type (i.e. MicroSoft Office for doc and docx files, 
Acrobat Reader 9 (available on the Officelinx DVD) or earlier for pdf, etc.). Ensure that this software is installed and 
working (run at least once) before attempting to send a fax using that format.

 Note: You may be asked to provide a Windows installation disc depending on the computer settings. 
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Sending Fax from Application
1. Open the document or image that will be sent as a fax.
2. Print the item. This is normally under the File > Print menu.
3. When the print dialogue appears, select fax as the print device.


Click OK.

4. The Send Fax Wizard screen appears:

5. Click Next. The Recipient Information screen 
appears:

6. Specify the following:
 In the To field, enter the name of the intended 

recipient.

 From the Location dropdown list, select the 
location (country) of the intended 
recipient.

 In the Fax number fields, specify the fax area 
code and number for the intended 
recipient.

 Enable Use dialing rules if you want specific 
dialing rules to apply. Select the dialing rules 
from the accompanying dropdown list.

 Hint: Click the Address Book button to select 
a recipient from your personal address book.

 Note: To create a new set of dialing rules, click on the Dialing rules button.
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7. Click on the Add button to add the recipient whose information you have just specified.

8. Click Next when you have added all desired 
recipients. The Preparing the Cover Page screen 
appears:

9. From the Cover page template dropdown list, 
select the cover page template you want to use.

10. In the Subject line field, enter subject text for the 
fax cover page.

11. In the Note box, enter message text for the fax 
cover page.

12. Click Next. The Schedule screen appears:
13. Select one of the When do you want to send this 

fax? radio buttons:
 Now - send the fax immediately
 When discount rates apply - send the fax the 

next time discount phone rates apply
 Specific time in the next 24 hours - send the 

fax at a specific time in the next 24 hours. If 
you select this radio button, you must then 
specify a time of day from the accompanying 
spin-box

14. Select one of the following What is the fax 
priority? radio buttons:
 High - high priority for sending fax
 Normal - normal priority for sending fax
 Low - low priority for sending fax

 Note: You can add as many recipients as you wish.
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15. Click Next. The following screen appears:
16. If you want to preview your fax, click on the 

Preview Fax button. Otherwise, click Finish. To 
confirm that your fax was sent successfully, check 
the Sent Items folder of your Fax Console 
application.
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Viewing the Status of a Fax

1. Select Start > All Programs > Accessories > 

Communications > Fax > Fax Console.

2. In the left hand pane, click to expand Fax (if not already 
expanded). The following list describes the folders under 
Fax:
 The Incoming folder contains faxes that are 

currently being received.
 The Inbox folder contains faxes that have been received.
 The Outbox folder contains faxes that are scheduled to be sent.
 The Sent Items folder contains faxes that have been successfully sent.

3. In the left hand pane, highlight a folder.
4. In the right hand pane right click on the fax you want and select Properties.
5. On the General tab, check the status of the fax under ’Status’.

Receiving and Viewing a Fax
1. Select Start > All Programs > Accessories > Communications > Fax > Fax Console. The Fax Console detects 

incoming faxes and stores them in your inbox.
2. To view a fax click Inbox, then double click on the fax you want to view.

Canceling a Fax Job
You can cancel any fax you have set up to be sent at a future time.

1. If Fax is not open, select Start > All Programs > Accessories > Communications > Fax > Fax Console. The Fax 
Console appears.

2. To cancel a fax click Outbox, then right click on the fax you want to cancel.
3. Click Delete to cancel the fax.
4. Click Yes.

Automatically Send Retry
You can set up Fax so that it continues trying to send your fax if the receiving fax machine is busy.

1. Select Start > Control Panel. The Control Panel appears.
2. If your Control Panel is in Category View, click Printers and Other Hardware. Click View installed printers or fax 

printers. The Printers and Faxes screen appears.
OR
If your Control Panel is in Classic View, double-click the Printers and Faxes icon. The Printers and Faxes screen 
appears.

3. Right click Fax and select Properties. The Fax Properties dialogue box opens.
4. Click the Devices tab, then Properties. The Modem dialogue box opens.
5. Specify the number of retries and the amount of time between retries.
6. Click OK.

 Note: If an item is in the Outbox folder, then the fax attempt has failed. Until all retries have been 
exhausted, Status will read Pending. If all retries have been exhausted, Status will read Failed.

 Note: Fax is automatically set up to retry three (3) times at 10-minute intervals. 
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Automatically Canceling a Fax
If your PC tried to send a fax and failed to connect to a fax machine, you can automatically cancel a failed fax. 

1. Select Start > Control Panel. The Control Panel appears.
2. If your Control Panel is in Category View, click Printers and Other Hardware. Click View installed printers or fax 

printers. The Printers and Faxes screen appears. OR,
If your Control Panel is in Classic View, double-click the Printers and Faxes icon. The Printers and Faxes screen 
appears.

3. Right click Fax and select Properties. The Fax Properties dialogue box opens.
4. Click the Devices tab, then click Properties. The Modem dialogue box opens.
5. Click the Cleanup tab.
6. Click to check Automatically delete failed faxes after and specify the number of days.
7. Click OK.
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eMail to Fax
Sending a fax via email may be accomplished using virtually any email client. This feature requires no user-end 
configuration. The only requirement is that the fax email is sent to the correct domain using the correct format.

Administrator Setup

The Officelinx server must be properly configured before users can send fax messages through an email client. Send URL 
must be configured and activated on the voice server (see the Security Enhancements chapter in Esna’s Server Configuration 
Guide). Also, SMTP port 25 needs to be opened on any firewall or security services.

An active email account and client are also required.

Under Officelinx Admin>Configuration>VPIM/SMTP, set Use email verification for outbound faxing to True.

 Warning: Only TIFF and TXT formats are supported by default. To send a fax in any other format, the computer 
must have the necessary program installed to support that file type (i.e. MicroSoft Office for doc and docx files, 
Acrobat Reader 9 (available on the Officelinx DVD) or earlier for pdf, etc.). Ensure that this software is installed and 
working (run at least once) before attempting to send a fax using that format.
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Sending a Fax

Create a new email message. In the To... field, type 
fax= followed by the number of the destination fax 
machine at(@) your company’s server. For example, 
fax=1234567890@companydomain.com.

The Subject line and the email message body will be 
included with the fax as a cover page.

Include the main body of the fax as an attachment to 
the email. 

Send the email when you’re ready.

The message will be accepted by your server and processed into an outgoing fax job.

Fax Activation
To prevent spam, once you have clicked the Send button, the Officelinx Server will send you an email to confirm that the fax 
message is to be sent.

This email includes a link which you must click on to authorize the server to send the fax message. Click on the link.

The system will respond with a message verifying that the fax has been queued for sending. The message status can now be 
tracked in the fax status report folders.

 Note: This guide will use Gmail to send the fax email. However, this process can be repeated with virtually 
any email client including web based email.

 Note: Only TIFF and TXT formats are 
supported by default. However, if the server 
has the appropriate programs installed, other 
formats can be used (PDF requires Acrobat 9 
(available on the Officelinx DVD), DOC / 
DOCX need MS Office).
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Sending a Fax through Fax Gadget
The Fax Gadget appears. This can be accessed through the Web Access directly, or through a link from 
other web applications such as iLink Pro. 

To send a fax, click Send a Fax.

On the To field, enter the fax destination number. 

It is best to provide all numbers including both country and area 
code (e.g. 1-123-765-4321). 

When you enter the full fax number on this field, the Fax Gadget 
will automatically add the Fax: qualifier to indicate that this is a 
fax message. 

Click on the Attachments tab to add content to this fax 
message. Any attachments to the fax must be in the PDF or 
TIFF formats unless the UC server has been specifically setup 
to support other file types.

Click the Add button to open the menu shown here. 

Select File from the menu and click Choose File... to browse for the file to 
be sent as the fax content.

Once the file has been chosen, click Upload.

The selected file will now be added as fax content. 

Click Send to send the fax immediately.

 Note: Send a Fax will only available if you have a fax board installed on the server to 
handle fax routing. Otherwise, faxes can be sent by clicking Send a Message and setting 
the outgoing address to FAX: followed by the fax number (e.g. fax:9057079700).
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The fax message you’ve sent will now be listed under Fax Jobs. You will 
be able to easily check on the status of the fax to ensure that it has been 
sent out. 

If the status doesn’t change to Sent within a reasonable amount of time, 
or if the fax message fails repeatedly, please contact your system 
administrator for help regarding the matter.
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Fax Jobs
Whenever a fax message is sent or received by the UC server, an entry will appear in Admin > Fax Jobs so that the 
administrator can easily view and manage faxing. All fax jobs will appear in one of three folders and will be moved 
accordingly.

Outgoing: This folder contains the details of all faxes that are currently being sent that have neither finished nor failed.

Completed: This folder contains the details of all faxes that have been successfully sent.

Failed: This folder contains the details of all faxes that could not be sent. The system has stopped trying to send the fax. 

Each of these folders contains the following information for each fax message:

 Number: This field displays the job number assigned to the fax.

 Sender: This field displays the individual who sent the fax.

 Destination: This field displays the Mailbox number to which the fax is directed.

 Status: This field displays the current status of the fax (Initial / Pending / Sending / Sent / Canceled / Failed-Busy / 
Failed-No Answer / Failed-Other / Failed). 

 Created: This field displays date and time the fax was sent.

 Completed: This field displays date and time the transmission of the fax was completed.
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Softfax
Introduction
Soft fax eliminates the need and the cost of a dedicated fax boards by emulating all the necessary fax protocols through 
software. Fax messages that are received by Officelinx server will be stored in the TIFF format allowing the fax messages to 
be accessible to all users regardless of the device that they are using. While Softfax is not designed to replace a fax centric 
ecosystem, it offers a convenient alternative to organization which requires occasional fax usage by eliminating the need for 
dedicated fax hardware.

Visual Guide
In a typical organization, users are either assigned individual 
fax machines or share a common fax machine depending on 
faxing requirements and policies of the organization. But if the 
users are not a heavy fax user, being tied to the machine can 
be a nuisance. From maintenance cost to actual usage, fax 
machines can easily become a burden to the organization as 
well.

Since it is difficult to eliminate fax usage completely, Officelinx 
offers a software solution to faxing, allowing users to both 
send and receive fax machines through the Officelinx server. 
Incoming faxes are converted into a TIFF file and can be sent 
to each individual user’s mailbox. Users can also send out 
digital documents as faxes to actual fax machines or emulators 
such as Officelinx.

Requirements
The following are the minimum requirements for soft fax:

Specifications
Officelinx conforms to the following ITU-T specifications:

 V.17 -- 2-wire modem for fax applications with data rates of 14.4, 12.0, 9.6, 7.2 kbits/s

 V.29 -- Fax modem with data rates of 9.6 and 7.2 kbits/s

 V.27ter -- Fax modem with data rates of 4.8 and 2.4 kbits/s 

 V.21 channel 2 -- Used to transfer T.30 control frames

 T.30 - procedures for document fax transmission in general switched telephone network

 Note: Other document formats can be used to send faxes if the server has been configured to use them. 
The other supported formats are PDF, DOC, DOCX, and TXT.

Processor P4 2.4GHz or higher

Software Windows 2000 Server SP2 or higher
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PC usage:

 40 MHz of CPU is used for every fax channel for send/receive functions

 100 KB of RAM is used to load the fax application on the startup of the 6510 UM

 80 KB of RAM is used for every fax channel that is actively sending or receiving faxes.

 Note: Before configuring your system for softfax, it is necessary to determine that your fax board(s) are 
capable of exploiting this feature. The Dialogic JCT series of boards - JCT denoting the board as Full Duplex - can 
support softfax. IP configuration can support softfax.
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Server Configuration

Licensing Information
Before you begin configuring your soft fax you should make sure that you 
have the required licenses.

 Fax Mail: This is the core component to enable the fax services.

 SoftFaxPorts: The number of available ports for softfaxing. More 
can be purchased for sites with higher traffic volumes.

 Integrated Fax: Enable to turn on outbound faxing.

 EFax Users: Licenses only for outbound faxing.
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Admin Settings
1. Ensure that you have soft fax ports purchased and available on the license.
2. Log in to the Admin Console.
3. Open Voice Server for your PBX. Make sure that the following settings 

are correct.
 Number of Soft Fax Channels: The number of soft fax ports that 

you are licensed for (if using a soft fax board type).
 Fax Enabled: Must be set to True.
 Number of Fax Channels: The number of fax channels you are 

licensed for.
 Start Fax Channel Number: Must be set to 1.

4. In the Value Data text field, enter the number of ports available on your 
license. Click OK.

5. Return to the Admin Console. Navigate to Configuration > Fax 
Settings:
 In the right-hand pane, locate the Dialing Suffix parameter and 

double-click. An Edit String dialogue box appears. In the Value Data 
text field, enter 9. Click OK.

 In the right-hand pane, locate the Fax Board Type parameter and 
double-click. An Edit String dialogue box appears. In the Value Data 
text field, enter SoftFax. Click OK.

 In the right-hand pane, locate the Fax Mail Installed parameter 
and double-click. An Edit String dialogue box appears. In the Value 
Data text field, enter True. Click OK.

6. Return to the Admin Console. Navigate to 
Configuration > Advanced:
 In the right-hand pane, locate the Disable Fax Detection 

parameter and double-click. An Edit String dialogue box appears. In 
the Value Data text field, enter False. Click OK.

 In the right-hand pane, locate the Disable Fax Detection1 
parameter and double-click. An Edit String dialogue box appears. In 
the Value Data text field, enter False. Click OK.

 In the right-hand pane, locate the Disable Fax Detection2 
parameter and double-click. An Edit String dialogue box appears. In 
the Value Data text field, enter False. Click OK.

7. Reboot the server to load the soft fax ports.
8. Following the reboot, UM Monitor will display - if fax ports have 

been properly loaded - the portion of the screenshot highlighted 
in red.

9. Close the UM Monitor screen.



 Note: If the fields mentioned above are not visible in 
UM Monitor, then the fax ports have not loaded 
properly. UM Monitor may be accessed from the system 
tray.
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Confirmation of Service for IIS7

Due to the way in which IIS7 manages FTP services, you will have to perform extra 
configuration to ensure that your fax related services will be running. When you open 
Windows Services panel, you will see the FTP Publishing Service entry. Open the 
properties of this item as shown here. Set this service’s Startup Type to Automatic 
then restart your computer.

After the reboot, open your IIS panel and check for 
FTP services, you should see the Default FTP Site 
state set to Running. If this service is not running, 
fax feature will not function properly.




Setting up mailboxes for soft fax

There are two alternatives available, the first involving a separate DID number for phone and fax, and the second involving 
an identical DID number for phone and fax. The case of a separate DID (Direct Inward Dialing) number is as follows:

1. In the Admin Console, navigate to Company > Mailbox > Addresses. Click on Add and select Fax from the menu. The 
Address dialogue box appears.

2. From the Type dropdown list, select Fax - Internal Extension. 
3. In the Number text field, enter the four-digit DID number.

4. Select the Set As Default checkbox to designate that particular number as the default fax number.
5. Click OK.
6. Or, in the case of an identical DID number for phone and fax, the process is as follows:

 Either perform the fax detection at the greeting level. On receiving the call/fax, the mailbox will, on receiving the fax 
tone, deposit the fax message directly into that mailbox.

 Or the User may create a voice menu, giving the caller the option of delivering a fax. In this case, a voice menu 
must be attached to the mailbox, with the option Send To Fax Start Tone selected and Send to Voicemail 
Record Tone the default option. Consult the Server Configuration Guide chapter entitled "Maintaining A Voice 
Menu" for detailed instructions.

 Note: The Number field value cannot exist anywhere else in the system as a phone or fax extension.
316 Officelinx Feature Description Guide



Officelinx F
Dialogic SR140 Fax 
Software Integration
C
H

A
P

TER 3
0

In This Chapter:

318 Introduction

318 Pre-Requisites

319 Configuration

319 License Manager

323 Configuration Manager

326 Monitoring Channel Activity
eature Description Guide 317



Dialogic SR140 Fax Software Integration
Introduction
Officelinx permits high volume fax users to integrate their Dialogic SR140 fax software with the Unified Communications 
platform.

SR140 vs Softfax
This table provides a comparison between the SR140 and the Softfax applications.

1 - Varies depending upon license.

2 - Performance is sensitive to network configuration.

3 - Internal Fax Transmission to Softfax allows items to be sent from the desktop and received by another user on 
the same system.

Mixed environments are also supported. For example, inbound faxing can be handled by Softfax, while outbound faxing is 
sent through the SR140.

Pre-Requisites
Install the Officelinx program onto the computer that will act as the Voice Server. Ensure that the Hardware Fax Drivers 
option is installed at the Features Selection screen during program installation. This will ensure that the necessary program 
elements are included with Officelinx.

SR140 Softfax

Maximum Channels Supported up to 60/node 1 up to 16/node 1

Support for Inbound Faxing  

Support for Outbound Faxing   2

Can use T.38 protocol  

Internal Fax Transmission to Softfax 3  
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Configuration
Once both the Dialogic SR140 and the Officelinx voice server have been installed, the fax software must be configured to 
communicate with the UC platform.

The following procedures must be performed on each computer that is running the SR140 software.

License Manager
1. Open the Brooktrout License Manager program.

2. Enable the SR140 license by clicking on the Activate button.

3. Click Next.

 Note: The procedure shown here uses the Activation Wizard and an internet connection. 
If you have a license file, select Install and point the program to the file provided by your dealer.
319Officelinx Feature Description Guide



Dialogic SR140 Fax Software Integration
4. Make sure that Automatically is selected as the Activation Method, then click Next.

5. Currently, no License Keys are installed. Click Add.

6. Enter the SR140 license key number that came with the fax software package. Click OK when ready.

7. The new license key has been successfully added to the system. Click Next.
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8. Click Next to continue to the Product Registration pages.

9. Enter the details of the site administrator. All fields are required for registration. Click Next when ready.

10. Enter all of the required information into the fields provided. This is the location of the software installation. 
Click Next to continue.

11. The program will connect to the Dialogic servers to upload the registration details. This requires a working internet 
connection, and must be completed successfully before the license will be activated.
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When it has finished, click Next to continue.

12. The new license has been added to the Wizard. Click Next.

13. Click Next to complete the activation Wizard.

14. The added license appears in the Brooktrout License Manager.
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Configuration Manager
1. Open the Brooktrout Configuration Manager program.

2. At Configuration Tool - Preferences, change Boston Host Service Start Mode to Automatic and click OK.

3. When the Configuration Wizard starts, choose Advanced Mode.
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4.  Enable the option for SIP. Click OK to continue.

1. Select BTCall Parameters (All boards).

Enter the path to the appropriate file in the space beside Country Telephone Parameter File. By default, this will be:

C:\Program Files\Brooktrout\config\BT_CPARM.cfg
Modify the path according to the location where your administrator has installed the program

Select your Country from the dropdown list.

2. In the left-hand window, select SIP under IP Call Control Modules. Go to the T.38 Parameters tab.

For Fax Transporting Protocol, select the appropriate option from the list. This item will be determined by the network 
administrator based upon the needs and policies of the company.
324 Officelinx Feature Description Guide



Dialogic SR140 Fax Software Integration
3. Move to the IP Parameters tab.

For Primary Gateway, enter the IP address and port number to be used for all outbound fax traffic.

4. For Contact IPv4 Address, enter the IP address and port used for inbound faxing. This must be a different port than 
the one used for the Officelinx voice server (5060). 

5. Click Save to confirm the changes.
6. Click Apply to restart all affected services.

The configuration of the SR140 fax platform is complete.
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Monitoring Channel Activity

Setup

To monitor the traffic through the fax software, the configuration file on the Officelinx Voice Server must be setup to point to 
the correct file locations.

1. On the computer where Officelinx is installed, use a text editor (i.e. Windows NotePad) to open the configuration file. By 
default, this will be:

C:\UC\ETBTFax\Config\ETBTFaxService.ini
Modify the path according to the location where your administrator has installed the program.

2. Modify the Config entry to include the full path to the btcall.cfg file. By default, this will be:
“C:\Program Files\Brooktrout\config\btcall.cfg”

Be sure to enclose the path within double quotation marks “”. 
Modify the path according to the location where your administrator has installed the program.

Enter the HTTP Port number that will be used to monitor fax channel activity.

3. When all changes have been made, click File > Save.

Monitoring via Browser

To monitor activity on a fax server, open a browser and navigate to:

http:\\localhost:30070

Change localhost to the IP address of the fax server if you want to monitor from a different computer.

Change the port number (30070 in this example) to the value entered in step 2 above.
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Web Access
Introduction
Business today requires flexibility and mobility. Company personnel find it increasingly necessary to go where the customers 
are. Advances in technology allow people to work from home or other locations away from the office. The Officelinx Web 
Access is an internet browser based application that gives users on a UC system the ability to manage all aspects of their 
communication and schedule from any internet enabled computer. The Mobile Web Access works with mobile devices as well.

Email, fax and voice messages can be accessed and dealt with. Users can also update their current location. Personal 
calendars are also available for viewing and modification. Wherever you may need to travel, Web Access will be there to help 
keep you in touch.
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Getting Started
To launch Web Access, open a web browser and navigate to the corporate UC server site. Click the Web Access icon to start 
the program.

These links provide 3 authentication methods to access the Web Access: UC requires your UC Server credentials, Google 
needs a Google account setup, and Windows will use your computer or network login details.

Logging In
Refer to the Client Applications Guide, page 116, for complete details on the single sign-on requirements for Web Access.

 Note: This screen does not appear if you login without having logged out from a previous session.
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Navigation
Web Access consists of five major sections: Messaging, Location, People, Notification and Settings. 

Through these manus, you have access to all of your messages (voice, fax, and email), and can respond to, delete and 
mange them. You also have complete access to manage your UC presence, location, schedule and contacts.

For more details on Web Access, please refer to Web Access on page 113 of the Client Applications Guide.
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Mobile Web Access
The Mobile Web Access is available for mobile devices providing most of the same functionality as the Web Access.

Mobile Web Access can be accessed from your device by visiting your corporation’s Officelinx web site and selecting User 
Portal from the page provided. 

You will be prompted to login with your credentials (mailbox number and password) in the same manner as if you were using 
the full Web Access. Click Login when ready.

You are now at the main menu of the Mobile Web Access. 

The following features from the Web Access are available. For a description of the items found here, please refer to the 
appropriate section of this manual. 

         Main Settings                              General Settings                                    Other Features
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Web Admin
Introduction
Once Officelinx has been installed, OLAdmin is used to configure and maintain all aspects of the voice server. 

Web Admin is a utility which provides access to a portion of OLAdmin’s functions through a network. Web Admin can manage 
users, making additions and changes as required, through its web enabled interface. Any internet browser can connect to the 
voice server to provide user administration from any computer attached to the internet. 

Web Admin is automatically enabled on the voice server during the installation of Officelinx.

Accessing Web Admin
Access to the Web Admin program is done through any web browser on any computer attached to the internet.

1. From any computer with internet access, open a web browser. Enter the IP Address for the Officelinx voice server 
followed, after a slash, by ucadmin. For example:

http://192.168.0.1/ucadmin

2. At the login screen, enter the administrator User name and Password for the Officelinx voice server.

3. The Web Admin screen appears in the browser window.

 Note: The Officelinx server must be configured to allow access via the internet. Refer to Esna’s 
Server Install Guide for more information.

 Hint: Enable the Save password checkbox to have Web Admin remember your credentials when 
launching future sessions.
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Web Admin Languages
The Web Admin interface supports different languages. The language specified within the browser will be used to display the 
text items in Web Admin.

The languages currently supported are: 

 English
 French
 Spanish

Companies
Officelinx allows you to create a single or multiple companies on a single server with multiple configurations for better 
management and segregation. Company settings set the ground rules for security, message management, ASR features, etc. 
All Feature Groups and Mailboxes under a Company share the rules and settings established for that Company. 

All of the currently configured companies on the server are displayed here. Companies cannot be added or deleted 
through Web Admin: this requires OLAdmin. Refer to Esna’s Server Configuration Guide for a complete description of all of 
the displayed options.

Company Buttons

Button Description

Edit the selected company. Choose a company in the right-hand window and click to 
view the company settings. No settings can be changed from Web Admin.

Refresh the Company display.

Click to access the Help file.
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Editing a Company
To begin editing a company, double-click the Name of that company. Two options appear: Mailbox Structure and Feature 
Groups.

Double-click on an option to edit.
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Mailbox Structure

Mailbox Structure contains all of the users and organizational units configured for that company. Web Admin allows 
administrators to add, delete and modify the users and organizational units. Not all options are supported through Web 
Admin, and some options (e.g. user Messaging Options, Locations, Notification Options and Distribution Lists) 
provide links that open the Web Access program to make the changes.

Button Description

Add a new Mailboxes.

Add a range of new Mailboxes using a template. 
Copying is also supported.

Add a new Organizational Unit to the company.

Edit the selected item.

Delete the selected item.

Move up one level in the company.

Refresh the display.

Search through the company for a specified user.

Open the Help file.

Save any changes to the server.

Go to the Next / Previous mailbox. The list is sorted by mailbox 
number.

Go to the First / Last mailbox in the list.
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For complete control, use the Officelinx Admin program.

Double-click on a user to edit their settings.

General Tab

The General tab of a Mailbox allows you to configure its 
basic properties including the number, name, and password.

Mailbox Number: The UC system automatically fills in the 
Mailbox number based on the other Mailboxes in the system 
upon Mailbox creation. If you wish to change it, simply enter 
the new Mailbox number in the field.

Last Name: Enter the last name of the user.

First Name: Enter the first name of the user.

Gender: This will be used to select the TTS Voice (female/male) used when playing an email for the user, or generating a 
name greeting when name is recorded. The TTS Voice used for each gender is specified in the 
Feature Group: From the dropdown menu, select the Feature Group that will be associated with the Mailbox.

Organizational Unit: Enter the full name of the Organizational Unit of the Mailbox.

Account Code: Enter the account number. This is used to pass account number information for toll charge billing back to an 
individual user.

NUMERIC PASSWORD

Password: Enter the user’s password. This password must be numeric.

Confirm Password: Confirm the user’s password.

POP3/IMAP4

User Name: Enter the user name for the POP3/IMAP4 account if the user is using the UC server as an email server.

Password: Enter the user’s password for the email account.

Confirm Password: Confirm the user’s password for the email account.

 Note: If you want to change an existing user’s 
Mailbox number, enter the new number in the 
Mailbox Number field and click Save. As a 
precautionary step to ensure Mailbox data is not 
lost, a new Mailbox entry based on the new 
number is created. The old Mailbox number will 
still exist, and can be deleted once information 
regarding the newly assigned Mailbox is confirmed.

 Note: The IMAP password is for integrated messaging. If you are using IMAP, you must ensure that 
the IMAP settings are configured in VPIM Tools.
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Advanced Tab

The Advanced tab allows you to configure the features that 
may be attached to the Mailbox such as Customize TUI, 
Web Access, etc.

Personal Operator: Enter the mailbox number of another 
user within the Company, then click the check mark  to 
validate the address. A personal operator is used if you use 
a different person as your operator other than the company 
default.

D.I.D Trunk: Enter the trunk number that the system will use to access the voicemail of this Mailbox. This field is normally 
used for Norstar Systems.

PBX Node: From the dropdown menu, select the PBX node on which the Mailbox will reside. This option is only available if 
there are multiple PBX nodes defined on the system.

Voice Menu: Enable this checkbox to have the user’s calls answered with a customized Voice Menu offering callers a variety 
of choices. Select a Voice Menu to use for this Mailbox in the dropdown menu beside.

Customize TUI: Enable this checkbox to select a customized TUI from the accompanying dropdown menu.

Date Format: From the dropdown menu, select the date format which will determine the way in which the date is expressed 
in Web Access and/or the telephone.

Desktop Capabilities: From the dropdown menu, select the type of functionality that this user will have (i.e. Standard, 
Mobility, eFax, etc.).

Web Access User: Enable this checkbox to give the Mailbox Web Access capability.

Collect Geo Location Data: Enables the collection of location data from a GPS on a remote device.

Domain Account Name: Enter the Windows domain and account name for this mailbox user (e.g. DOMAIN\USER_NAME). If 
this is configured alongside Auto Discovery, users will be able to log into iLink Pro Desktop based on their domain credentials 
without having to configure or enter any information in iLink Pro Desktop. This single sign on feature is only available when 
the user is on the same network as the Officelinx server.

Mailbox Options Tab

The Mailbox Options tab allows you to configure additional 
features that may enhance the user's experience.

Security Locked Mailbox: This checkbox is enabled when 
a mailbox becomes locked after failing to log in X number of 
times. The X is defined on the Company properties under 
Password/Security tab. Disable this checkbox to allow users 
to log into their mailbox.

Show Hints: Enable this checkbox to have Hints help 
documentation displayed by default throughout the Web 
Access windows. The Hints help documentation, shown in 
yellow strips at the top of each screen, will display in Web 
Access for the user until the user turns it off.

Show Getting Started: Enable this checkbox to have the 
Getting Started page displayed by default in Web Access for 
the user. The Getting Started page will display until the user turns it off.

Tutorial: Select On to be prompted with a tutorial when accessing the Mailbox through a telephone.

Say Envelope Information: Select the Yes if you want to hear the date and time of a call when listening to a message. The 
information to be relayed is defined in the TUI action.

 Note: This field is optional, but if you select an 
operator, you must also specify a Mailbox. This 
Mailbox is recognized as the operator for this 
individual. When the caller is in a particular 
Mailbox and hits 0, if this field is set, this user will 
be redirected to the Mailbox specified in this field 
instead of going to the company’s active operator.

 Note: A Voice Menu must be created before it can be applied to a Mailbox. Creating menus is not supported 
through Web Admin.
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Send Business Card: Enable this checkbox to allow the user to send personal contact “signature” information with all 
messages.

Receive Business Card: Enable this checkbox to allow the user to receive personal contact “signature” information with all 
messages.

Record all Inbound Calls: Enable this checkbox to have all inbound calls to the current Mailbox recorded.

Message Playback Order: Select an item from the dropdown list. This allows the users to listen to their messages by either 
FIFO (plays the oldest message first, newest message last) or LIFO (plays the newest message first).

Message Light Status: Select On from the dropdown menu to enable the Message Light feature for this Mailbox. This item 
is Read Only and cannot be changed.

Addresses Tab

The Addresses tab allows you to add many types of 
addresses to be associated with the current Mailbox. These 
addresses may be utilized to further customize the way in 
which the user interacts with the UC system.

From this window, you can Add new addresses for the 
mailbox, Edit an existing associated address, and Delete 
an address linked to this mailbox.

The address types that can be added are: Internal and 
External extensions, Email, VPIM, Internal and External 
Fax, SMS Email, Beeper and SMS Phone. 

ADDRESS OPTIONS

The options listed on the address screen will change depending upon the selection made.

Description: Enter a user friendly name for this connection.

Phone Number Type: Choose one of the available options from the dropdown list.

Number/Address: Enter the extension number, telephone number or address.

Country: From the dropdown menu, select the Country code for the telephone number.

Area/City Code: Enter the area code for the telephone number.

Identification: This item is Read Only and displays the status of Phantom, Alternate ID, and Trusted.

PBX Node: From the dropdown menu, select the PBX node that the extension resides in.

Set as Default: Enable this checkbox to make this address the default for the current Mailbox.

Message Light Assignment: Enable this checkbox to turn on message lights on the phone system connected to this 
extension.

Phantom: Enable this checkbox to make the current extension a phantom extension. A phantom extension is not connected 
to an actual phone but can still be used to play greetings and accept messages.

Trusted: Enable this checkbox to set the current extension as a trusted connection.

Alternate ID: Enable this checkbox to make the current extension an alternate ID. The Mailbox user will be able to use this 
extension number to login and accept calls as if it were a Mailbox number.
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Synchronization Tab

The Synchronization tab allows you connect the current 
Mailbox with the IMAP TSE feature, allowing you to 
synchronize information between your UC server and the 
email server (e.g. Microsoft Exchange, Lotus Domino).

IMAP Locked: This checkbox is enabled if the user’s 
Mailbox becomes locked. The lock occurs when the account 
fails authentication numerous times during the IMAP TSE 
synchronization activity. Disable this box to unlock the 
Mailbox.

User Name: Enter the IMAP account user name which the 
UC server will use to synchronize the data. Follow the 
domainname/username/alias format for this field.

User Password: Enter the IMAP account password.

Confirm Password: Re-Enter the IMAP account password.

IMAP Server: From the dropdown menu, select the corresponding IMAP server.

Storage Mode: From the dropdown list, select IMAP to store messages in the IMAP store, or Database to store messages in 
the UC database.

Speech Options Tab

The Speech Options tab allows you to configure the 
enrollment of the current mailbox in the voice verification 
features and configure related security levels. You may also 
enable transcription options here.

Enable ASR for Public Contacts: Enable this checkbox to 
allow the user of the current mailbox to access their public 
contacts through ASR along with the traditional DTMF 
method.

Enable ASR for Private Contacts: Enable this checkbox 
to allow the user of the current mailbox to access their 
private contacts through ASR along with the traditional 
DTMF method.

Enable Speech Command: Enable this checkbox to allow 
the user of the current mailbox to navigate the TUI through 
speech commands along with the traditional DTMF method. Speech Command must be enabled in the Feature Group first.

Enable Voice Message Transcription: Enable this checkbox to activate speech-to-text transcription for voice messages. 
Once enabled, voice messages left in this mailbox will be rendered into text, and sent to the associated email address. A 
transcription add-on to the Officelinx license is required.

 Note: This field indicates whether or not the Mailbox is IMAP-synchronized. Setting storage to Database 
indicates no IMAP synchronization.
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Message Options, Locations, People, and Notification Options

All of these items contain buttons which launch the Web Access program to access their functions and settings.
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Feature Groups

Feature Group, similar to Company, determines the rules for the Mailboxes that are associated with it. By creating numerous 
Feature Groups for different purposes, you will be able to allocate users to custom settings with a single click, rather than 
having to individually assign multiple rules to each mailbox. The features that the FG is able to manage include recording 
limits, message expiration, notification, transfer supervision, transfer options, IMAP settings and other features that are 
related to the mailboxes. Feature Group will prove to be an invaluable tool, especially if you are managing large numbers of 
users.

Double-click a group to edit its settings.

General Tab

The General tab allows you to configure identification and 
localized settings.

Group Number: Enter the number that will be assigned to 
the Feature Group. By default, the next available number 
will be assigned to a new Feature Group. The range of 
possible Feature Group numbers is 1-999.

Group Name: Enter a name for the Feature Group.

Mailbox Language: From the dropdown menu, select the 
default language the users will hear when picking up 
messages.

Caller Language: From the dropdown menu, select the 
default language that the caller is greeted by if the caller 
does not choose a language when prompted by the automated attendant.

Message Format: From the dropdown menu, select the format the messages will be stored and played back in.

Button Description

Add a new Feature Group.

Edit the selected item.

Delete the selected item.

Move up one level in the company.

Refresh the display.

Open the Help file.

Go to the Next / Previous Feature Group. The list is sorted by group 
number.

Go to the First / Last Feature Group in the list.
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Storage Options Tab

The Storage Options tab allows you to configure the 
message storage settings that will be enforced on the 
Mailboxes associated with this Feature Group.

Maximum Number of Messages: Enter the maximum 
number of messages that are allowed for each Mailbox 
associated with the current Feature Group. The default is 
200, and the maximum value is 32,000.

Mailbox almost full pop up: From the dropdown menu, select a percentage value at which the users will be notified that 
their Mailbox is almost full in Web Access.

Maximum Message Length: Enter the maximum length of time (in seconds) that a recorded message can be for any 
Mailbox in the Feature Group.

Maximum Greeting Length: Enter the maximum length of time (in seconds) that a recorded greeting can be for any 
Mailbox within the Feature Group. The maximum greeting length is 600 seconds.

Days to Keep Unread Messages: Enter the number of days the system will store unread messages before moving them to 
the deleted items folder.

Days to Keep Read Messages: Enter the number of days the system is to store read messages before moving them to the 
deleted items folder.

Days to Keep Sent Messages: Enter the number of days the system will keep sent messages before moving them to the 
deleted items folder.

Days to Keep Deleted Messages: Enter the number of days to keep deleted messages in the deleted items folder. The 
messages are permanently deleted when they are removed from the deleted items folder.

Days to Keep Calls History: Enter the number of days to keep the call logs for inbound and outbound calls.

Maximum Conversation Length: Enter the maximum length of time (in minutes) that a conversation can be between two 
parties before the call is ended by the system. The default is 60 minutes.

 Note: If you are integrating Lotus Notes with Officelinx you must select the WAV format and must use the 
Dialogic JTC voice card.

 Note: The message format selections available are defined by the type of board drivers that are loaded on 
the system.

 Note: If set to the WAVMSGSM6106, 6108, 61011 or WAVETPGSM6106, 6018, 61011 formats, the user will 
not have full Control Key capabilities when using the Telephone User interface. Using the WAVGSM* formats 
will disable the fast-forward and rewind capabilities while listening to a message.

 Hint: The maximum messages value should be 
based on the needs of the user. You should allow 
more than enough message storage space for each 
user to make sure that no messages get lost when a 
Mailbox reaches capacity. Ten megabytes of hard 
drive space is equal to approximately one hour of 
voice message storage.

 Note: This number is specified in seconds. This value should be set higher than the anticipated message 
length to ensure that callers are not disconnected in the middle of a message.

 Note: The call needs to be supervised (e.g. trombone transfer) in order for the system to restrict the 
conversation length.
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Notification Options Tab

Notification Options allows you to configure Message 
Waiting Light indicators along with paging and other outside 
notification methods that are enabled for new messages. 
These settings will be enforced on the Mailboxes associated 
with the current Feature Group.

MESSAGE LIGHT OPTIONS

Message Light Activation: Enable this checkbox to allow 
the message waiting light to be turned on under the 
conditions specified.

ON For All Messages: Enable this checkbox to turn on the 
message waiting light (send ON code) when a new message 
arrives.

OFF For All Messages: Enable this checkbox to deactivate 
the message waiting light (send OFF code) when at least one new message is read.

OFF When No New Messages: Enable this checkbox to deactivate the message waiting light (send OFF code) when no new 
messages are in the user's Mailbox.

No of ON Retries: Enter the number of retries the system will attempt when activating message light fails.

No of OFF Retries: Enter the number of retries the system will attempt when deactivating message light fails.

ON Between Retries: Enter the duration (in minutes) that the system will wait in between attempts to activate the 
message light.

OFF Between Retries: Enter the duration (in minutes) the system will wait between attempts to deactivate the MWI.

ON Code: Enter the code required to turn on message waiting lights.

OFF Code: Enter the code required to turn off message waiting lights.

MESSAGE LIGHT CHANNELS

Message Light Channels Assignment: Enter the channel number that will be used to send message waiting light 
notifications.

MESSAGE LIGHT TYPE

All: Enable this checkbox to send MWL code for all types of messages.

E-mail: Enable this checkbox to turn on message lights only for new email messages.

Fax: Enable this checkbox to turn on message lights only for new fax messages.

Voice: Enable this checkbox to turn on message lights only for new voice messages.

OUTCALLING OPTIONS

Beeper: Enable this checkbox to send notification messages to a pager when a new message arrives.

Outcall: Enable this checkbox to send notification messages to a telephone when a new message arrives.

Long Distance: Enable to send notification messages to a telephone (long distance) when a new message arrives.

E-mail: Enable this checkbox to send notification messages to an email when a new message arrives.

 Note: The ON Code and OFF Code fields should be used in situations where the code is too long to be input 
in the ON Code field in the PBX Message Light tab (usually MCI). As well, for multi-PBX configurations, 
different codes must be used for different PBXs. In this situation, certain Feature Groups can be assigned to 
a message waiting light code that reflects the different PBXs being used.
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Transfer Options Tab

The Transfer Options tab allows you to configure the way in 
which calls are handled. Transfer Options include Call 
Screening, Call Forwarding, Busy Hold, Call Queuing, and 
Paging Capabilities, either before the call is transferred or 
after the caller has reached the Mailbox.

Call Screening: Enable this checkbox to allow Mailbox 
users in this Feature Group to use Call Screening. Before 
initiating a transfer, the system will ask the caller for their 
name. When the recipient picks up, they will hear the 
recorded name and can decide what to do with the call.

Call Forwarding: Enable this checkbox to allow Mailbox 
users in the Feature Group to use Call Forwarding. When 
someone calls a Mailbox user, instead of ringing the Mailbox 
user's location, the system will forward the call to the 
person s/he has defined in their Mailbox.

Play Record Conversation Warning: Enable this checkbox to notify the callers that the call is being recorded if the 
recipient has recording enabled.

Busy Hold: Enable this checkbox to give callers the option to either hold for the extension, leave a message for that 
extension, or try another extension if the called Mailbox is busy. While on hold, callers may leave a voice message by 
pressing *.

Call Queuing: Enable this checkbox to allow Mailbox users in the Feature Group to use Call Queuing. If someone calls a busy 
extension, they are given the option to be placed in a queue to hold or leave a message.

Camp On: Enable this checkbox to allow Mailbox users in the Feature Group to use Camp On. If someone calls a Mailbox 
user who is on the phone, they can press * to be notified when the Mailbox user has finished their current call.

Forced Messaging: Enable this checkbox to force the caller to press a key before they can leave a message. If this is 
disabled, the system will automatically starting to record a message after the mailbox greeting. This option can help to 
reduce the number of blank messages left on the system.

Pre Transfer Paging: Enable this checkbox to allow Mailbox users in the Feature Group to use Pre Transfer Paging. Before a 
call is transferred to a Mailbox user, the system will page the user first.

Post Transfer Paging: Enable this checkbox to allow Mailbox users in the Feature Group to use Post Transfer Paging. If the 
Mailbox user is not available, the caller can page the user again.

Get Caller ID: Enable this checkbox to send a pop up screen with the Caller ID information to the Mailbox user when they 
receive an incoming call.

Play Name During Transfer: Enable this checkbox to play the Mailbox user’s name when the caller is being transferred to 
the Mailbox.

Confirm Name during Transfer: Enable this checkbox to confirm the Mailbox user’s name when a caller is being 
transferred to the Mailbox.

ENHANCED CALL CONTROL

Internal Extension: Enable this checkbox to allow users to have access to Enhanced Call Control features from their 
internal phones.

External or External/Internal(Find Me) Extension: Enable this checkbox to allow Mailbox users to have access to 
Enhanced Call Control features from their external phones or phones that they are connected to through the Find Me/Follow 
Me feature. Users must be dialed through the auto attendant in order for them to have access to Enhanced Call Control.

AUTO ATTENDANT

Try Other Extension After: Enable this checkbox to give callers an option to try another extension after they leave a 
message in the Mailbox.

Notify User of Transfer: Enable this checkbox to notify the Mailbox user of an incoming call transfer.

PAGING ZONE

Transfer Code: Enter the transfer code required for paging.

 Note: This feature is only available on telephone systems that provide a busy tone. Most telephone sets 
with multiple extension appearances do not produce a busy tone.

 Note: Call queuing is available only on telephone systems that provide a busy tone. Most telephone sets with 
multiple extension appearances do not produce a busy tone.
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Account Code: Enter the account code required for paging.

Release Code: Enter the paging release code.

Delay Time: Enter the time (in seconds) that the server is to wait before it transfers the caller to the specified extension 
after the user is paged.

Transfer Types Tab

The Transfer Types tab allows administrators to configure 
the rules associated with transfers that occur between the 
server and any of the defined extensions.

EXTERNAL SUPERVISION

Transfer Type: Choose an option from the dropdown list.

None: Select this option to transfer calls to extensions without supervising the call (blind transfer). The caller being 
transferred to an extension is placed on hold while the system makes the connection. The caller is then released to the 
telephone system and is no longer in control of any of the actions. Calls may be transferred back to the system if the 
telephone system has the ability to return the callers if the extension is busy or unavailable.
Busy: Select this option to supervise the call while the caller is being transferred to the extension. The caller being 
transferred to an extension is placed on hold while the system makes the connection. If the extension is busy, the 
system instructs the caller to leave a message. However, if the extension is not busy and a ring signal is heard, the caller 
is released to the telephone system and is no longer in control of any of the actions. Calls may be transferred back to the 
system only if the switch has the capability to forward calls on a No-Answer condition.
Busy/NA: Select this option to supervise the call while the caller is being transferred to the extension. The caller being 
transferred to an extension is placed on hold while the system makes the connection. The system checks for both the 
busy and the no answer conditions and informs the caller of the options available to them when either situation arises.

Number of rings: Enter the number of rings that the server will detect before returning the caller to the system. In most 
scenarios this value is set to 0 which means that the value configured in the PBX is used. You may enter a different value 
here to override the PBX value but the value must be lower than what is currently configured in the PBX.

Centrex: Enable this checkbox to supervise a transferred Centrex line so that the system can send the call back to the 
server if there is no answer.

Transfer validation prompt: Enable this checkbox to have the system prompt the extension before transferring the caller.

Outdialing Validation prompt: Enable this checkbox to have the system prompt the extension before forwarding according 
to outdialing rules.

REPEAT PROMPT

Number of times to repeat prompt: Enter the number of times you want the system to repeat the validation prompts.

INTERNAL SUPERVISION

Transfer Type: Choose an option from the dropdown list.

None: Select this option to transfer calls to extensions without supervising the call (blind transfer). The caller being 
transferred to an extension is placed on hold while the system makes the connection. The caller is then released to the 
telephone system and is no longer in control of any of the actions. Calls may be transferred back to the system if the 
telephone system has the ability to return the callers if the extension is busy or unavailable.
Busy: Select this option to supervise the call while the caller is being transferred to the extension. The caller being 
transferred to an extension is placed on hold while the system makes the connection. If the extension is busy, the 
system instructs the caller to leave a message. However, if the extension is not busy and a ring signal is heard, the caller 
is released to the telephone system and is no longer in control of any of the actions. Calls may be transferred back to the 
system only if the switch has the capability to forward calls on a No-Answer condition.
Busy/NA: Select this option to supervise the call while the caller is being transferred to the extension. The caller being 
transferred to an extension is placed on hold while the system makes the connection. The system checks for both the 
busy and the no answer conditions and informs the caller of the options available to them when either situation arises.
Language: Select this option to supervise the call while the caller is being transferred to the extension, and keep a 
record of the language selection that the caller has made. When the caller returns to the system (failed transfer or return 
to system), they will hear the menu in the selected language.

 Warning: Only one transfer option (in each of 
Internal and External supervision groups) may 
be selected per Mailbox group.

 Note: Some items on this page are only 
enabled based upon other choices.
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Number of rings: Enter the number of rings that the server will detect before returning the caller to the system. In most 
scenarios this value is set to 0 which means that the value configured in the PBX is used. You may enter a different value 
here to override the PBX value but the value must be lower than what is currently configured in the PBX.

Transfer validation prompt: Enable this checkbox to have the system prompt the extension before transferring the caller.

SCREEN POP DURATION & PRE TRANSFER EVENT

Pre Transfer Event: Choose an option from the dropdown list.

Ring: Select this option to present the caller with a ring. 
Music: Select this option to present the caller with the system default music.
Custom File (15 to 60 sec): Select this option to present the caller with the a custom sound.

Duration: Enter the length of time that the event should last (in seconds).

Custom File Name: Enter the path to the custom file if one was selected above. Click on the search icon to locate the file.

Mailbox Options Tab

The Mailbox Options tab allows you to configure the level of 
features that the Mailboxes associated with the current 
Feature Group can utilize.

SETTINGS AVAILABLE FOR THE USER FOR MAILBOX 
CONFIGURATION

Change Location: Enable this checkbox to allow users in 
the Feature Group to change their location in iLink Pro 
Desktop and Web Access.

Distribution Lists: Enable this checkbox to allow users in the Feature Group to manage distribution lists.

Modify Public Distribution Lists: When enabled, the user will have access to change a public distribution list on the 
system using Web Access. If disabled, users can access the list but not make changes to it.

Multilingual: Enable this checkbox to allow users in the Feature Group to record greetings for multiple languages. The user 
will be prompted to select the language to record the greeting for.

Record All Incoming Calls: Enable this checkbox to allow users in the Feature Group to record all incoming calls.

Record Conversation: Enable this checkbox to allow users to record a telephone conversation, both incoming and outgoing 
calls. Recording function is managed through the iLink Pro Desktop.

Wakeup Call: Enable this checkbox to allow users in the Feature Group to manage wakeup calls.

View Geo Location Data: Enables the Show on a Map feature in iLink Pro. Users can click that item and see your location 
through Google Maps. When disabled, this menu item is not available.

SETTINGS ACTIVATED BY THE ADMINISTRATOR

Allow Live Reply-Call Back: Enable this checkbox to allow Mailbox users to use the Call Back to Sender TUI action after 
listening to a message.

Allow Multiple TUI Access: Enable this checkbox to allow two or more users to log into a single Mailbox account at the 
same time. This feature is intended for shared/public Mailboxes.

Directory: Enable this checkbox to allow users to be listed both in the dial-by-name directory and the complete directory. 
The dial by name directory is set up in ascending order with respect to Mailbox number. Callers may access the dial by name 
directory by pressing the * key when they reach the auto attendant, or they may listen to the complete company directory 
(arranged in ascending order according to Mailbox number) by pressing the * key a second time.

Do not check Passwords: Enable this checkbox to skip the password check. The user will be sent directly to the TUI.

Ask for Password (Inband Login): Enable this checkbox to prompt the users to enter their passwords every time they log 
in.

Forced Tutorial: Enable this checkbox to prohibit users from picking up messages until they have completed the tutorial.

Guest Mailbox: Enable this checkbox to utilize a simplified messaging menu.

Hide On Send List: Enable this checkbox to hide all Mailboxes associated with the current Feature Group from the directory 
which is used to search users in iLink Pro Desktop and Web Access.

LanTalk: Enable this checkbox to allow users to send and receive Chat messages.

 Note: For some functions, the Feature Group only 
gives the authority to enable the setting from the 
Mailbox properties. These functions must be 
manually added to the Mailbox after authorizing 
from the Feature Group.
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Press Star to Login to Another Mailbox: Enable this checkbox to allow users to log into another Mailbox at the Password 
Request prompt when they dial into the system by pressing *.

Shared Extension: Enable this checkbox if the users in this Feature Group are sharing extensions. If the system is dialed 
from a shared extension, the system will ask for the Mailbox number to log in to. If someone calls a shared extension, when 
the phone is answered, the system will say who the call is for.

Web Access: Enable this checkbox to give the users Web Access capability.

WebClient Messaging: Enable this checkbox to allow users to have messaging capabilities (email, voice mail, fax mail) 
while using Web Access. Users will have no access to their inbox from the Web Access if this feature is disabled.

Web Tutorial: Enable this checkbox to require the user to complete the tutorial the next time they connect to the system.

Message Options Tab

The Message Options allows you to configure comment 
attachments to messages, as well as message sending 
information.

Confirm Delete: Enable this checkbox to have the users 
prompted to confirm the deletion of a message. 

Confirmation Request (Certified Message): Enable this 
checkbox to instruct the server to prompt users to send a 
standard or certified message.

Future Delivery: Enable this checkbox to allow users to 
schedule a message delivery at a later date.

Show Message Count: Enable this checkbox to have the Web Access display how many unread messages are in the Mailbox 
user's Inbox. Also, when a new message notification appears in iLink Pro Desktop, it will display the number of unread 
messages in the Inbox.

Message Forwarding: Enable this checkbox to allow messages received by this Feature Group to be forwarded to other 
Mailboxes and extensions.

Allow Reply to all Recipients: Enable this checkbox to allow users to Reply All when replying to a message.

Attach Comment on Reply: Enable this checkbox to attach the original message body to the new message body when 
replying.

Send all Comments: Enable this checkbox to indicate whether or not to send all attachments of the original message when 
forwarding.

Verify Sending Destination: Enable this checkbox to verify the destination of outgoing messages.

Allow to attach Voice Menu: Enable this checkbox to allow users to attach a voice menu along with the messages. This 
feature can be activated in the Voice Menu or the TUI. At the end of message playback, the recipients will be sent to the 
attached Voice Menu instead of the typical end of message menu.

Cancel Auto Forwarding Only when Message Saved or Deleted: Enable this checkbox to instruct the server to cancel 
auto forwarding if the message has been saved or deleted.

Message Send Inter-Digit Delay: Enter the number of seconds that the server will wait while the user is entering a 
message before it decides that the caller has finished.

When Sending a Message, ask for Mailbox Number: From the dropdown menu, choose the option to select the 
destination Mailbox either before (first) or after (last) recording the message.

 NOTE: If Message Recovery is active any message 
that has been deleted may be reclaimed during the 
same day.
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Synchronization Options Tab

The Synchronization Options tab allows you configure the 
IMAP account for all Mailboxes associated with the Feature 
Group. If you are using a superuser account with an 
Exchange server, this is where you enter the credentials.

IMAP Account: Enter the superuser account name. This 
user was created on the Exchange server and has full 
control over all other accounts and has a permanent 
password.

Account Password: Enter the password for the superuser.

Confirm Password: Re-enter the superuser password for 
confirmation.

IMAP Server: Select the IMAP server from the dropdown 
menu. 

Calendar Mode: From the dropdown menu, select None to 
not sync any calendar entries, Sync with mail server to sync calendar entries between UC server and Exchange or Gmail 
servers, or Outlook client calendar to sync calendar entries between UC server the Outlook email client. Outlook client 
calendar requires the user to be logged into iLink Pro Desktop and that a version of Outlook compatible with iLink Pro 
Desktop forms is installed.

Send URL: From the dropdown menu, select the type of messages that you wish to use the Send URL feature with. Send 
URL will send a link of the attached files (rather than the actual file itself) for selected type of messages. This feature may be 
used as a security measure, in addition to reducing bandwidth usage.

Local Directory Images Over-ridden with: The local files will be replaced according to the option selected.

Remote directory images, except non-existing: Picture files that are already in the storage directory that have 
changed since the last update will be downloaded.
All remote directory images, including non-existing: All picture files for contacts will be downloaded to the image 
directory.
Only images that are not present in local directory: Picture files that are not already in the image directory will be 
downloaded.

SYNCHRONIZATION OPTIONS

Inbox folder: Enable this checkbox to synchronize the messages in the Inbox folder between the IMAP server and the UC 
server. This is enabled by default.

Call History: Enable this checkbox to synchronize call history from the UC server to the IMAP server.

System folders: Enable this checkbox to synchronize messages in default system folders (e.g. Inbox, Sent, Deleted) 
between the IMAP server and the UC server.

Custom folders: Enable this checkbox to synchronize messages in custom folders (i.e. user created folders) between the 
IMAP server and the UC server.

Contacts: Enable this checkbox to synchronize contacts if the email server is compatible with UC server.

ADVANCED SYNCHRONIZATION OPTIONS

Maximum Number of Connection Failures: Enter the maximum number of failed system connection attempts that can 
occur before the user is locked out.

Maximum No of Login Failures: Enter the maximum number of failed system logons to the IMAP server that can occur 
before the user is locked out.

 Note: Once IMAP synchronization is enabled and configured, the Inbox folder is synchronized at all times 
between the IMAP and the UC servers.

 Note: In order for actions such as Copy and Delete to be available, checkboxes such as Sync folders and 
Custom folders must be checked.

 Note: It is recommended that this number is kept fairly high (1000+). The user can get locked out when, 
for example, the IMAP or email server goes down and there is no possibility of establishing a connection. 
This can happen on a re-boot.

 Note: This number should be less than that specified in the user’s NT account for locking an account.
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Sync Priority: From the dropdown menu, select the level of priority for IMAP Feature Group synchronization. This field will 
work relative to other Feature Groups. For example, all FGs with Maximum priority will sync messages quicker than the FGs 
with Medium or Minimum setting.

Messages per Sync Cycle: Enter the number of messages that the server will attempt to synchronize during each 
synchronization cycle.

TSE Location: Enter or select the location of the UC TSE Cache Manager. This is only required if your TSE server is different 
from the UC server (e.g. using a stand alone TSE server).

DID Options Tab

The DID Properties tab of Feature Group allows you to select 
specific features for incoming DID calls.

WHEN RECEIVING DID CALLS, HONOUR THE 
FOLLOWING STEPS

Play Prompt: Transfer to...: Enable this checkbox to have 
the default transfer prompt played when a DID call comes 
in.

Play Pre Transfer Sound: Enable this checkbox to play the 
default pre-transfer sound for incoming DID calls.

Call Screening: Enable this checkbox to instruct DID 
callers who wish to transfer to an extension to state their 
name at the tone.

Camp On: Enable this checkbox to enable the Camp On 
feature. When this function is enabled and the extension is currently busy, the caller may choose to be alerted when the user 
hangs up and the extension becomes available.

Call Queuing: Enable this checkbox to place incoming DID calls in a queue when an extension is busy. Callers are informed 
of their position in the hold queue and are given opportunities to either continue to hold or leave a voice message.

Caller ID Popup: Enable this checkbox to have the Caller ID of the DID callers pop up when their call comes in.

Call Forwarding: Enable this checkbox to enable call forwarding on DID calls.

RE-ROUTE OPTIONS FOR DID AND INTERNAL CALLS USING CTI

Forward calls to: Choose an option from the dropdown list.

No re-routing: Select this radio button if DID/Internal calls are not to be forwarded on the UC system. Incoming calls 
will advance no further than the number originally dialed. This is the default option.
Forward calls location: Select this radio button to exploit the UC server’s Find Me/Follow Me abilities. Incoming calls 
will search for the intended recipient according to a previously specified path.
Forward calls to default address: Select this radio button to re-route the call to the default address defined in the 
Mailbox.

Hunt Group: Enter the number to be dialed to access DID messages.

 Note: The number you enter in this field depends on how evenly messages are distributed between all 
Mailboxes. The higher the number in this field, the longer it will take the server to start processing 
messages for the next Mailbox.
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Speech Options Tab

The Speech Options tab allows you to configure Automatic 
Speech Recognition (ASR) related features.

Allow Voice Verification Security Level: Enable this 
checkbox to give the Mailboxes associated with the current 
Feature Group the ability to change their Voice Verification 
security level through TUI. The Voice Verification feature 
needs to be enabled in Company properties first.

Enable Speech Command: Enable this checkbox to give 
the Mailboxes associated with the current Feature Group the 
ability to use voice as their navigation method along with 
DTMF input. This feature has to be allowed in Company 
properties first.

Enable Speech Numeric Password: Enable this checkbox to give the Mailboxes associated with the current Feature Group 
the ability to use voice to enter their password.

This means that the user will be able to say the numeric password (e.g. 1, 2, 3, 4) to log into their mailbox instead of 
entering the number through DTMF. This feature is different from voice verification and can be a security risk since the 
spoken password can be heard by a third party.

 Note: If there is an overlap of commands between a TUI action and an action key (e.g. 7 to save message 
and also 7 to fast forward during playback), the speech action will always activate the TUI action. Action 
keys can only be accessed through DTMF key input.
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Servers
The items found here are drawn from OLAdmin, under the headings for TSE IMAP Server and Voice Server.

Server Buttons

TSE Endpoints

Through the TSE IMAP Server, you will be able to add your mail servers so that they can be integrated with Officelinx. 
Officelinx supports most mail servers currently used by most organizations. These include, but are not limited to, Microsoft 
Exchange, Google Apps/Gmail, Lotus Domino, and Novell Groupwise. Depending on the type of mail server you will be 
integrating with, you may also gain additional features such as Contact and Calendar synchronization along with message 
synchronization.

Add / Modify a Server

IMAP Server Name: Enter the name of the IMAP server. This is for your reference and 
does not impact performance. This label will be seen when you are associating Feature 
Groups or Mailboxes with a specific IMAP server for integration/synchronization.

IMAP Server Address: Enter the IP or Domain address of the IMAP server.

IMAP Port: Enter the port which will be used to communicate with the IMAP server.

Voice Format: From the dropdown menu, select the voice format which will be used when sending voice messages to 
external voice servers.

IMAP Server Domain: Enter the Domain address of the IMAP server. Since it is possible to define IMAP Server Address 
fields using an IP address, the Domain address entered here will be used to verify the Reply To address of a mailbox using 
IMAP TSE synchronization to prevent typical message looping scenarios. 

Button Description

Add a new server of the current type (Gmail or IMAP).

Edit the selected server.

Delete the currently selected server.

Refresh the Company display.

Click to access the Help file.

Save any changes to the server.

Go to the Next / Previous server.

Go to the First / Last server in the list.
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Voice Servers

The Voice Server contains the primary information regarding the system. You will be able to configure and confirm the 
number of channels, ports and the path used by the UC server.

Add / Modify a Server

Voice Server Name: Enter a short name for the Voice Server.

Voice Server Description: Enter a short description for the 
Voice Server.

Voice Server Path: Enter the installation directory path of the 
Voice Server (C:\UC by default).

Master Voice Server: Enable this checkbox if this is the Master 
Voice Server.

Fax Enabled: Define whether this Voice Server has fax 
capabilities. This field is automatically enabled when the Voice 
Server detects that the fax services is enabled on startup.

CHANNEL SETTINGS

Voice Channels: Enter the number of voice channels available in the system.

Start Channel Number: Enter the channel at which this Voice Server begins to serve. For example, Voice Server 1 might be 
channels 1 to 20, so Voice Server 2, with a Start Channel Number of 21, would serve channels 21 to 40.

Voice Verification Channels: Enter the number of Voice Verification Channels available in the system.

ASR Channels: Enter the number of channels for auto-speech recognition available in the system.

TTS Channels: Enter the number of text-to-speech channels available in the system.

Fax Channels: Enter the number of channels for fax available in the system.

Soft Fax Channels: Enter the number of channels for soft fax available in the system.

Start Fax Channel Number: Enter the fax channel at which this Voice Server begins to serve.

Resiliency Channels: Enter the number of Resiliency (Redundancy) Channels available in the system.

TCP/IP SETTINGS

External IP Address: Enter the external IP address of the Voice Server. This IP address is used when connecting to the 
admin remotely from an external computer.

Internal IP Address: Enter the internal IP address of the Voice Server. This IP address is used when connecting to the 
admin remotely from another internal workstation.

TCP/IP Port: Enter the port which can be used by UM Monitor to check the status of the Officelinx server. A value of 0 
specifies the  default (which uses port 11000).
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Protocols
The items found here are drawn from OLAdmin under Configuration.

HTTP Settings

HTTP Settings allows you to configure settings to view members of your voice mail system, and the status of each Mailbox 
through any internet connection. Double-click on any item to edit.

POP3 Settings

POP3 Server settings allow you to configure settings for POP3 compliant email. Double-click on any item to open a window to 
change any field’s parameters.

Setting Function

Templates Directory Specify the path to the location on the hard drive where templates are stored. 
By default, this is the UC Installation directory on the local drive.

URL - Data Displays the internet accessible address of the UC Server where the necessary 
icons and image files are stored.

URL - Messages This is the path to the internet accessible voice and fax message store.

URL - UMST Contains the path to the internet accessible files needed for web based 
telephone control.

I Caution: These settings are managed through the Web Mail Utility and should not be changed from here.

Settings Function

Audio Format This is the default audio format for POP3 voice messages.

Connection delay This is the number of times a message send attempt will occur 
before the sender receives a “message delayed” notification.

Encapsulate messages Select True to allow the encapsulation of messages, False to 
disable the option.

HTML Content Set to True to allowing the sending of POP3 messages in HTML 
format.

IP Address This is the default IP address for POP3 messages.

POP3 enabled This indicates whether or not POP3 is enabled.

POP3 Port Indicates the port used for POP3 messaging.

Session timeout (ms) Indicates the length of time (in milliseconds) that can pass before 
the session times out.
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IMAP Settings

IMAP Server settings allow you to configure IMAP messaging behavior. Double-click on any item to open a window to change 
any field’s parameters.

The maximum number of sessions Indicates the maximum number of POP3 sessions allowed.

TNEF Extension This is the message class or ID.

Setting Function

Audio Format This is the audio format for messages sent through IMAP.

Composer pool timeout

The maximum length of time in milliseconds one must wait before a 
new composer is created (for message creation).
Note: Composer is the IMAP component that translates messages to 
mime format.

Connection delay This is the allowable length of time to wait to connect.

Encapsulate messages Select True to allow the encapsulation of messages, False to disable 
the option.

HTML Content Set to True to allowing the sending of messages in HTML format.

IDLE Enabled Set to True to enable Idle mode.

IMAP Enabled Set to True to enable IMAP.

IMAP Port This is the IMAP port.

IP Address This is the default IMAP gateway address.

Maximum number of Composers
The composer is the means by which information from the DB is 
converted to the MIME format.  A ratio of 1 composer to 3 users in 
suggested.  For a system of 300 users, enter a value of 100.

Session timeout (ms) This is the length of time (in milliseconds) to wait before timing out 
the session.

The maximum number of sessions This is the maximum allowable number of IMAP sessions.

TNEF Extension This is the message class or ID.

Settings Function
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LDAP Settings

LDAP settings allow the administrator to specify the network accessible directory information for the Internet Protocol (IP). 
Email clients and other programs and services use this information to reach needed files. 

Double-click on any item to open a window to change any field’s parameters.

Settings Function

Anonymous access Select True if an anonymous bind (connection) is to be used. This 
allows login by any client, without authentication.

Assign mailbox number or 
company name if not user defined

Set this to True to have the system route any undefined imports to 
the first available user of the first defined company. When set to 
False, undefined LDAP imports will fail.

Authorization Type
Allows you to select the synchronization authorization type. Select 
Simple if simple authentication is to be used, or GSS if GSS 
authentication is to be used.

Base DN This is for the unique base name.

Class schema for contact This is for the object’s class name to be synchronized with Public 
Contact.

Class schema for group This is for the object’s class name to be synchronized with Feature 
Group.

Class schema for mailbox This is for the object’s class name to be synchronized with mailbox.

Directory application server
Allows you to select the LDAP directory server. Your choices are 
Microsoft Active Directory, Novell eDirectory, iPlanet, or 
Others.

Domain This is for the User’s domain name.

Feature Group Filter DN This is a data string describing what you are looking for on the 
directory server.

Feature Group Search DN This is a data string describing the directory server location. This is 
the feature group search location.

Feature Group search scope Select One level for a one-level search, or Sub-tree level for a 
multiple-level search.

FG Last check date This value is read-only.

FG Last check USN or Date This value is read-only.

Host name This is for the directory server name.

Language Allows you to select the language of the active system. 

Last check date This value is read-only.

LDAP Port number Specify the LDAP port number.

LDAP Version Specify the LDAP protocol version. 

Mailbox Template Number Apply the selected template number to imported accounts. The 
number is found in the Mailbox Template section of UC Admin.

Page size Indicates the number of entries to show per page when retrieving 
results from the server

Paging allowed Select True to enable paging specifications.

Password This is for the administrator password.

PC Last check date This value is read-only.
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PC Last check USN or Date This value is read-only.

Pop up the query window Set to True to enable query window popup, set to False to disable.

Public contact Filter DN This is a data string describing what you are looking for on the 
directory server

Public contact Search DN This is a data string describing the directory server location. This is 
the public contact search location.

Public contact search scope Select One level for a one-level search, or Sub-tree level for a 
multiple-level search

SSL connection Select True if Secure Socket Layers are being used

Synchronization direction
Usually this will be Only Directory to Database. For synchronization 
with an IMAP source, selecting Both ways will synch updated 
information only.

Synchronization Time (the last 
time) This value is read-only

Synchronization timeout Allows you to specify the maximum number of seconds before a 
connection and/or operation times out

Synchronization Type

Allows you to select the type of synchronization to occur. Select 
DateTime only when you want synchronization between the 
messaging and directory servers to occur on a time basis. In most 
cases, you will select USN.

Synchronization USN (The last 
value) This value is read-only.

Synchronize deletions This item is no longer supported.

Synchronize nested 
organizational units

For companies that have a hierarchical organization (i.e. Sales on top, 
with regions below), setting this option to True will force LDAP to 
maintain the structure. Set to False to flatten the structure into the 
highest layer (i.e. all contacts into Sales).

Timeout Allows you to specify the maximum number of seconds before a 
connection and/or operation times out.

Tombstone object DN This item is no longer supported.

Update phone number Select True to allow a phone number(s) to be updated, or False to 
deny that option.

User DN This is the unique name for the User (admin).

User Filter DN This is a data string describing what you are looking for on the 
directory server.

User Search DN This is a data string describing the directory server location. This is 
the user search location.

User search scope Select One level for a one-level search, or Sub-tree level for a 
multiple-level search

UUID
Specify the LDAP attribute to use as a Universally Unique 
Identifier in case the usual ID (i.e FirstName+LastName) may 
change.

Settings Function
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VPIM Settings

VPIM/SMTP settings allow you to configure VPIM server behavior. Double-click on any item to open a window to change any 
field’s parameters.

Setting Function

Admin Email Indicates the administrator’s email address.

Always use administrator’s email

Replaces the sender’s email with that of the admin account. The 
display will still show the original sender. This is used when 
receiving messages from outside sources (i.e. Gmail) that may 
lack vital routing information.

Audio format for SMTP This is the audio format for SMTP voice messages.

Audio format for VPIM This is the audio format for VPIM voice messages.

Binary Mode Set to False to allow binary encoded messages.

Check the sender domain Enable to have the system check the domain of message 
senders, for purposes of confirming the legitimacy of message 
source.

DNS PTR record checking for sender’s IP 
address

Select True to enable DNS PTR record checking for a sender’s IP 
address.

Encapsulate messages Select True to enable  message encapsulation, False to disable.

ePage domain Not generally implemented. Used in a proprietary installation.

ePage email Not generally implemented. Used in a proprietary installation.

ePage format string Not generally implemented. Used in a proprietary installation.

Fax format for SMTP forwarding
Select either PDF or TIFF for fax handling. Typically used for 
IMAP systems. The Message Options in each user’s mailbox will 
override this setting.

Fax gateway authorization Enable to authenticate fax gateway before sending a fax 
message.

Fax gateway default company Indicates the default company number for sending of faxes.

Fax gateway domain Indicates the domain of the fax gateway.

Forwarding allowed Set to True to enable the forwarding of messages from remote 
machines.

HTML - Allow Delete With Send URL, this enables or disables Deletion.

HTML - Allow Dial With Send URL, this enables or disables Dialing.

HTML - Allow Mark as Read With Send URL, this enables or disables marking a message as 
Read.

HTML - Allow Phone Playback With Send URL, this enables or disables message playback.

HTML Content Set to True to allowing the sending of messages in HTML format.

HTML Filter Allows for the filtering of HTML in messages to text.

IP Address This is the default IP address for SMTP messages.

Maximum of the SMTP tasks Indicates how many SMTP messages can be processed at one 
time.

Maximum of the VPIM tasks Indicates how many VPIM messages can be processed at one 
time.

Notification Email
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Smarthost In case of a non-connected PC, all messages will be sent after 
being forwarded to this connected host.

SMS Length limit Determines the length of a SMS text message.

SMTP Enabled Indicates whether or not SMTP is enabled.

SMTP Port Indicates the port used for SMTP messaging.

The maximum number of incoming 
connections

This is for the maximum number of VPIM/SMTP connections 
allowed.

The number of attempts before delay 
notification

Indicates the number of times a message send attempt will occur 
before the sender is sent a “message delayed” notification.

The number of delivery attempts
Indicates the number of times a message delivery attempt will 
occur before the sender is sent a “message delivery failure” 
notification.

TNEF Extension This is the message class or ID

Use email verification for outbound faxing

Enable this option to require outbound faxes originating outside 
the company to be verified through email before sending. An off-
site sender, after requesting to send a fax, will receive an email 
with a link which must be clicked before the fax will be sent.

Use email verification for SMS

Enable this option to require outbound SMS messages originating 
outside the company to be verified through email before sending. 
An off-site sender, after requesting to send an SMS message, will 
receive an email with a link which must be clicked before the 
message will be sent.
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Settings
The items found here are drawn from OLAdmin under Configuration.

Custom Interface

Custom Interface allow you to specify the configurations that deal with integrating a third party database into the UC system. 
Double-click on any item to open a window to change any field’s parameters.

Dealer Information

The Dealer Information settings allow you to specify the information of the dealer who has installed the UC system. Double-
click on any item to open a window to change any field’s parameters.

Setting Function

Database Object Method Type
Enter a value of 1 to support PIN-to-mailbox translations only.  Enter a value of 
2 (recommended) to provide a richer set of Interactive Voice Response (IVR) 
functionality.

Database Object Name Set the value to Object name.Get Destination, where Object name is the 
calling program name.

Forced Popup from Database 
Object

Select True to enable the forcing of pop ups from the database. Select False 
to disable this parameter.

Get Destination from Database Select True to enable the retrieving of the folder destination from the 
database. Select False to disable this parameter. Pertains to the IVR object.

On Max Errors
Select Hang Up to instruct the system to disconnect from the third party 
database in situations where too many errors occur. Select Operator to switch 
to the operator in situations where too many errors occur. 

Setting Function

Contact Name Shows the dealer representative contact name.

Dealer Email Shows the dealer contact email address.

Dealer Fax Shows the dealer contact fax number.

Dealer Name Shows the dealer company name.

Dealer WebSite Shows the dealer company website.

Technical Support Number Shows the dealer technical support phone number.
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Reorg settings

Reorg settings allow you to specify the rules to activate and run the function that cleans and compacts the database. Double-
click on any item to open a window to change any field’s parameters.

Reports

Reports allows you to enable or disable specific component activity reports. Double-click on any item to open a window to 
change any field’s parameters.

Setting Function

Backup Files Before Reorg Indicates whether or not to back up the database files before 
initiating the reorg.

Batch Files to run at Reorg Time Defines a batch file to initiate before the reorg is performed. (i.e. 
network or tape drive backup)

Reorg Time Sets the time of day (24-hour format) to initiate the reorg function.

Setting Function

Administration Activity Report Select True to allow for the creation of administration activity reports.

ASR Activity Report Select True to allow for the creation of ASR activity reports.

Call Activity Report Select True to allow for the creation of call activity reports.

Mailbox Activity Report Select True to allow for the creation of mailbox activity reports.

Message Activity Report Select True to allow for the creation of message activity reports.

Notification Activity Report Select True to allow for the creation of notification activity reports.

Remote Sites Activity Report Select True to allow for the creation of remote sites activity reports.

Telephony Activity Report Select True to allow for the creation of telephony activity reports.

Transfer Activity Report Select True to allow for the creation of transfer activity reports.

UC Client Manager Activity Report Select True to allow for the creation of Client Manager activity 
reports.

Voice Menu Activity Report Select True to allow for the creation of voice menu activity reports.

Web Access Activity Report Select True to allow for the creation of Web Access activity reports.
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User Manager

User Manager settings allow you to specify one or more Administrators and the system properties that they control. The 
Administrators can have limited control over the UC systems (i.e. Edit PBX), up to Full Access. Double-click on any item to 
open a window to change any field’s parameters.

Edit / Add User  

User Name: Enter the name of the administrator.

Password: Create the administrator’s password.

Confirm Password: Re-enter the password.

Account Disabled: Select to disable this account.

Full Name: Enter the administrator’s full name.

Description: Enter the title or purpose of this administrator.

Language: Select the language preference for this administrator.

Related Company: Select the companies this administrator has administrative rights over.

Enable the following tasks by selecting the corresponding checkboxes:

 Note: If multiple language support is needed for your administrators, a new administrator must be created 
for each language. When accessing the Supervisor Menu in the TUI, the password entered for the 
configured Administrator account will define the language to play.

Task Function

Full Access Allows a user full access to the system.

Manage System Configuration Allows the administrator to edit system configuration files.

Manage PBX Allows the administrator to edit the PBX.

Manage Mailboxes Allows the administrator to create, edit, and delete a mailbox.

Manage Mailbox Ranges Allows the administrator to add a range of mailboxes.

Manage Company
Allows the administrator to add, edit, and delete a company, feature 
group, remote site, routing table, voice menu, and to customize a 
TUI.

Manage Log Configuration Allows the administrator to set and define logs.

Manage Report Configuration Allows the administrator to define and create reports and run the Web 
Reporter utility.

Manage Backups Allows the administrator to perform and define backup management.

 Note: You must be logged into the server as an administrator to be able to edit and delete User Manager 
settings.
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System Health

The items found here are drawn from OLAdmin under Logs.

System Health settings allow you to specify report logging on all system components. Double-click on any item to open a 
window to change any field’s parameters.

Settings Function

Admin Log Level This will create a log file for all Admin activity.

Business Object Log Level This will create a log file for all EE Application Manager activity.

Days to Keep Report Logs
Defines the number of days that data is stored in log files. These are 
the logs that contain the data used for generating Web Reports, not 
system performance/maintenance monitoring data.

Debug Level
This sets the level of information sent to a log file when Debug mode 
is activated. Enter a number between 0 (less) and 5 (most), 
depending on the level of detail required.

Debug Mode Debug mode for all main voice server activities.

Log Fax Activity Logs all fax activity.

Log Lan Activity This will create a log file for all LAN activity.

Log Mailbox Activity This will create a log file for all Mailbox activity.

Log Mass Recall Logs all Mass Recall activity.

Log Message Lights Logs all Message Light activity.

Log PMS Activity Logs all Property Management System activity.

Log Queue Activity Creates a log file for all Queue activity.

Log Record Termination Creates a log file for all Record termination activity

Log SMDI Logs all SMDI activity.

Log Speech Engine Creates a log file for all Log Speech Engine activity.

Log System Statistics Creates a log file for all system statistics.

Log Wakeup Calls Creates a log file for all Wakeup Call activity.

Status Log Level Select a value that indicates the level at which status logs should be 
created. Set to 0 = Least detailed. Set to 5 = Most detailed.

Trace Log Level Select a value that indicates the level at which trace logs should be 
created. Set to 0 = Least detailed. Set to 5 = Most detailed.

UMST Log Level This will create a log file for all UMST activity.

VPIM/SMTP Debug This allows for VPIM/SMTP debug.

VPIM/SMTP Log Level This indicates the level of information sent to a log file for all VPIM/
SMTP activity, provided debug is activated.
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Logoff

Selecting this option will prompt you to log out of the Web Admin program.
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Accessing an account requires a password. The voicemail and application passwords can be reset through any web browser 
from the UC Server web page.

1. Using any web browser, enter the URL for the voice server (i.e. user.yourcompany.com). Select Reset Password. 
2. Enter an email address and select the password to reset: reset Voicemail Password or Application Password.

3. Enter the security code in the space provided, Click Send a Request when ready.

4. The specified email address will receive a message with a link. Click on the link to enter the details of the new password.

5. Enter a new password in the spaces provided, then click Reset Password.
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6. The account password will be changed to the new value.
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Introduction
Logging in to an iLink client using Esna credentials provides a web-based authentication solution (OnEsna) for sites where 
Gmail and Salesforce are not available. Creating a user account with OnEsna allows access to a range of programs using 
secure access protocols.
Officelinx Feature Description Guide 369



OnEsna Authentication
Creating an Account with OnEsna
Before attempting to login using Esna credentials for the first time, it is necessary to create an account at OnEsna.

1. Open a browser and go to https://www.OnEsna.com.
2. At the login screen, click Create an account.

3. On the Sign Up screen, enter your corporate email address, your first and last names, 
and the password you want to use with OnEsna. Re-enter the password to confirm.

When finished, click Sign Up.

4. A confirmation email will be sent to the address provided. 

Open the message and click Verify Email.

5. OnEsna account setup is complete. Click Login.
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Logging In Through OnEsna
For all Esna iLink applications, the login procedure is the same when you select Use Esna 
Credentials to start the program.

1. At the login page, choose Use Esna credentials  from the drop down list.

2. When prompted, enter your OnEsna username and password. Click Login.

3. If prompted to grant iLink permissions, click Accept.

4. The iLink client will start.

















 Hint: From the Connection page, click the Utility Menu and select Clear 
credentials to delete all login details and restart the login procedure.

 Note: Enable Keep me logged in to have OnEsna automatically use the 
same credentials on all subsequent login attempts. You will be seamlessly 
logged in to all client extension each time the browser is launched.

 Note: This only needs to be done the first time you login to the client. 

 Note: In order for the program to save your settings, you must allow your web browser to accept 
3rd party cookies. Some browsers may reject 3rd party cookies either as a default setting or 
through an organizational policy.
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